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Contents 
0. Laboratory - Introduction (Basics of OPNET IT Guru Academic Edition) 2 

0.1. Objective 

This lab teaches you the basics of using OPNET IT Guru Academic Edition. OPNET IT Guru Academic 
Edition enables students to better understand the core concepts of networking and equips them to 
effectively troubleshoot and manage real-world network infrastructures. 

In this lab, you will learn the basics of the OPNET IT Guru Academic EditionOPNET IT Guru Academic EditionOPNET IT Guru Academic EditionOPNET IT Guru Academic Edition 
software. You will learn how to setup and run OPNET IT Guru Academic EditionOPNET IT Guru Academic EditionOPNET IT Guru Academic EditionOPNET IT Guru Academic Edition. 
You will become familiar with some of its capabilities by running some tutorials. 

0.3. Prelab Activities 

Read Chapter 1 from "Computer Networks: A Systems Approach""Computer Networks: A Systems Approach""Computer Networks: A Systems Approach""Computer Networks: A Systems Approach", , , , 4th EditioEditioEditioEditionnnn.... 

Go to www.netwww.netwww.netwww.net----seal.net/animations.phpseal.net/animations.phpseal.net/animations.phpseal.net/animations.php    and play the following animation: 

• No Network. 

1. Laboratory - EthernetEthernetEthernetEthernet (A Direct Link NetworkDirect Link NetworkDirect Link NetworkDirect Link Network with Media Access Control) 6 

1.1. Objective 

This lab is designed to demonstrate the operation of the Ethernet network. The simulation in this lab 
will help you examine the performance of the Ethernet network under different scenarios. 

In this lab you will set up an Ethernet with thirty nodes connected via a coaxial link in 
a bus topology. The coaxial link is operating at a data rate of 10 Mbps. You will study 
how the throughput of the network is affected by the network load as well as the size 
of the packets. 

1.3. Prelab Activities 

Read section 2.6 from "Computer Networks: A Systems Approach""Computer Networks: A Systems Approach""Computer Networks: A Systems Approach""Computer Networks: A Systems Approach", 4" Edition.    

Go to www.netwww.netwww.netwww.net----seal.net/animations.phpseal.net/animations.phpseal.net/animations.phpseal.net/animations.php    and play the following animation: 
• Hub. 

2. Laboratory - Token RingToken RingToken RingToken Ring (A SharedSharedSharedShared----Media NetworkMedia NetworkMedia NetworkMedia Network with Media Access 
Control) 17 

2.1. Objective 

This lab is designed to demonstrate the implementation of a token ring network. The simulation in this 
lab will help you examine the performance of the token ring network under different scenarios. 

2.3. Prelab Activities 

In this lab, you will set up a token ring network with 14 nodes connected in a star 
topology. The links you will use operate at a data rate of 4 Mbps. You will study how 
the utilization and delay of the network are affected by the network load as well as 
the token holding timetoken holding timetoken holding timetoken holding time THTTHTTHTTHT. 

Read section 2.7 from "Computer Networks: A Systems Approach""Computer Networks: A Systems Approach""Computer Networks: A Systems Approach""Computer Networks: A Systems Approach",,,,    4th EditionEditionEditionEdition.... 

3. Laboratory - Switched LANsSwitched LANsSwitched LANsSwitched LANs (A Set of Local Area Networks Interconnected 
by Switches) 32 

3.1. Objective 

This lab is designed to demonstrate the implementation of switched local area networks. The 
simulation in this lab will help you examine the performance of different implementations of local 
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area networks connected by switches and hubs. 

In this lab you will set up switched LANs using two different switching devices: hubs 
and switches. A hub forwards the packet that arrives on any of its inputs on all the 
outputs regardless of the destination of the packet. On the other hand, a switch 
forwards incoming packets to one or more outputs depending on the destination(s) 
of the packets. You will study how the throughput and collision of packets in a 
switched network are affected by the configuration of the network and the types of 
switching devices that are used. 

3.3. Prelab Activities 

• Read section 3.1 from "Computer Networks: A Systems Approach""Computer Networks: A Systems Approach""Computer Networks: A Systems Approach""Computer Networks: A Systems Approach",,,,    4th EditionEditionEditionEdition....    

Go to wwwwww.netww.netww.netww.net----seal.net/animations.phpseal.net/animations.phpseal.net/animations.phpseal.net/animations.php    and play the following animations: 
• Hub. 

• Switch. 

• Switched Network With No Server. 

• Switched Network With Server. 

4. Laboratory - Network DesignNetwork DesignNetwork DesignNetwork Design (Planning a Network with Different Users, 
Hosts, and Services) 42 

4.1. Objective 

The objective of this lab is to demonstrate the basics of designing a network, taking into 
consideration the users, services, and locations of the hosts. 

In this lab you will design a network for a company that has four departments: 
Research, Engineering, E-Commerce, and Sales. You will utilize a LAN model that 
allows you to simulate multiple clients and servers in one simulation object. This 
model dramatically reduces both the amount of configuration work you need to 
perform and the amount of memory needed to execute the simulation. You will be 
able to define a profile that specifies the pattern of applications employed by the 
users of each department in the company. By the end of this lab, you will be able to 
study how different design decisions can affect the performance of the network. 

4.3. Prelab Activities 

• Read section 3.2 from "Computer Networks: A Systems Approach""Computer Networks: A Systems Approach""Computer Networks: A Systems Approach""Computer Networks: A Systems Approach",,,,    4th EditionEditionEditionEdition....    

Go to www.netwww.netwww.netwww.net----seal.net/animations.phpseal.net/animations.phpseal.net/animations.phpseal.net/animations.php    and play the following animations: 

• Adding Switches. 

5. Laboratory – ATM: Asynchronous Transfer ModeAsynchronous Transfer ModeAsynchronous Transfer ModeAsynchronous Transfer Mode (A Connection-Oriented, 
Cell-Switching Technology) 51 

5.1. Objective 

The objective of this lab is to examine the effect of ATM adaptation layers and service classes on the 
performance of the network. 

In this lab you will set up an ATM network that carries three applications: Voice, 
Email, and FTP. You will study how the choice of the adaptation layer as well as the 
service classes can affect the performance of the applications. 

5.3. Prelab Activities 

• Read section 3.3 from "Computer Networks: A Systems Approach""Computer Networks: A Systems Approach""Computer Networks: A Systems Approach""Computer Networks: A Systems Approach",,,,    4th EditionEditionEditionEdition.... 
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6. Laboratory - RIP: Routing Information ProtocolRouting Information ProtocolRouting Information ProtocolRouting Information Protocol (A Routing Protocol Based 
on the Distance-Vector Algorithm) 65 

6.1. Objective 

The objective of this lab is to configure and analyze the performance of the Routing Information 

Protocol (RIP) model. 

In this lab you will set up a network that utilizes RIP as its routing protocol. You will 
analyze the routing tables generated in the routers, and you will observe how RIP is 
affected by link failures. You will also utilize the ICMP (Internet Control Message 
Protocol) to create echo reply messages (i.e., ping) to analyze the created routes. 

6.3. Prelab Activities 

• Read sections 4.1.5, 4.1.7, and 4.2.2 from "Computer Networks: A Systems "Computer Networks: A Systems "Computer Networks: A Systems "Computer Networks: A Systems 
Approach"Approach"Approach"Approach",,,,    4th EditionEditionEditionEdition....    

Go to www.net-seal.net/animations.php    and play the following animations: 
• The Address Resolution Protocol (ARP). Example1, Example2, Example3. 

• ARP with Multiple Networks. 

• Routing and Forwarding. 

7. Laboratory - OSPF: Open Shortest Path FirstOpen Shortest Path FirstOpen Shortest Path FirstOpen Shortest Path First (A Routing Protocol Based on 
the Link-State Algorithm) 76 

7.1. Objective 

The objective of this lab is to configure and analyze the performance of the Open Shortest Path First 
(OSPF) routing protocol. 

In this lab, you will set up a network that utilizes OSPF as its routing protocol. You 
will analyze the routing tables generated in the routers and will observe how the 
resulting routes are affected by assigning areas and enabling load balancing. 

7.3. Prelab Activities 

• Read sections 4.2.3 and 4.2.4 from "Computer Networks: A System"Computer Networks: A System"Computer Networks: A System"Computer Networks: A Systems Approach"s Approach"s Approach"s Approach". . . . 4th 
EditionEditionEditionEdition....    

Go to www.netwww.netwww.netwww.net----seal.net/animations.phpseal.net/animations.phpseal.net/animations.phpseal.net/animations.php    and play the following animation: 
• Routing and forwarding. 

8. Laboratory – BGP: Border Gateway ProtocolBorder Gateway ProtocolBorder Gateway ProtocolBorder Gateway Protocol (An Interdomain Routing 
Protocol) 86 

8.1. Objective 

The objective of this lab is to simulate and study the basic features of an interdomain routing protocol 
called Border Gateway Protocol (BGP). 

In this lab you will set up a network with three different ASs (Autonomous Systems). 
RIP will be used as the intradomain routing protocol and BGP as the interdomain 
one. You will analyze the routing tables generated in the routers as well as the effect 
of applying a simple policy. 

8.3. Prelab Activities 

• Read section 4.3 from "Computer Networks: A Systems Approach""Computer Networks: A Systems Approach""Computer Networks: A Systems Approach""Computer Networks: A Systems Approach",,,,    4th EditionEditionEditionEdition....    

Go to www.netwww.netwww.netwww.net----seal.net/animations.phpseal.net/animations.phpseal.net/animations.phpseal.net/animations.php    and play the following animation: 
• IP Subnets. 
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9. Laboratory - TCP: Transmission Control ProtocolTransmission Control ProtocolTransmission Control ProtocolTransmission Control Protocol (A Reliable, 
Connection-Oriented, Byte-Stream Service) 98 

9.1. Objective 

This lab is designed to demonstrate the congestion control algorithms implemented by the 
Transmission Control Protocol (TCP). The lab provides a number of scenarios to simulate 
these algorithms. You will compare the performance of the algorithms through the analysis of the 
simulation results. 

In this lab you will set up a network that utilizes TCP as its end-to-end transmission 
protocol and analyze the size of the congestion window with different mechanisms. 

9.3. Prelab Activities 

• Read sections 5.1 and 5.2 from "Computer Networks: A Systems Approach""Computer Networks: A Systems Approach""Computer Networks: A Systems Approach""Computer Networks: A Systems Approach",,,,    4th 
EdiEdiEdiEditiontiontiontion. 

Go to www.netwww.netwww.netwww.net----seal.net/animations.phpseal.net/animations.phpseal.net/animations.phpseal.net/animations.php    and play the following animations: 
• TCP Connections. 

• TCP Multiplexing. 

• TCP Buffering and Sequencing. 

• User Datagram Protocol (UDP). 

10. Laboratory - Queuing DisciplinesQueuing DisciplinesQueuing DisciplinesQueuing Disciplines (Order of Packet Transmission and 
Dropping) 109 

10.1. Objective 

The objective of this lab is to examine the effect of different queuing disciplines on packet delivery 
and delay for different services. 

In this lab you will set up a network that carries three applications: FTP, Video, and 
VoIP. You will study how the choice of the queuing discipline in the routers can 
affect the performance of the applications and the utilization of the network 
resources. 

10.3. Prelab Activities 

• Read section 6.2 from "Computer Networks: A Systems App"Computer Networks: A Systems App"Computer Networks: A Systems App"Computer Networks: A Systems Approach"roach"roach"roach",,,,    4th EditionEditionEditionEdition....    

Go to www.netwww.netwww.netwww.net----seal.net/animations.phpseal.net/animations.phpseal.net/animations.phpseal.net/animations.php    and play the following animations: 
• Switch Congestion. 

• IP Fragmentation. 

11. Laboratory - RSVP: Resource Reservation ProtocolResource Reservation ProtocolResource Reservation ProtocolResource Reservation Protocol (Providing QoS by 
Reserving Resources in the Network) 121 

11.1. Objective 

The objective of this lab is to study the Resource Reservation Protocol (RSVP) as a part of the 
Integrated Services approach to providing Quality of Service (QoS) to individual applications or 
flows. 

In this tab you will set up a network that carries real-time applications and that 
utilizes RSVP to provide QoS to one of these applications. You will study how RSVP 
contributes to the performance of the application that makes use of it. 

11.3. Prelab Activities 

Read section 6.5 from "Computer Networks: A Systems Approach""Computer Networks: A Systems Approach""Computer Networks: A Systems Approach""Computer Networks: A Systems Approach",,,,    4th EditionEditionEditionEdition....    

Go to www.netwww.netwww.netwww.net----seal.net/animations.phpseal.net/animations.phpseal.net/animations.phpseal.net/animations.php    and play the following animation: 
• TCP Flow Control. 
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12. Laboratory - FirewallsFirewallsFirewallsFirewalls and Virtual Private NetworksVirtual Private NetworksVirtual Private NetworksVirtual Private Networks (VPN and Network 
Security) 137 

12.1. Objective 

The objective of this lab is to study the role of firewalls and Virtual Private Networks VPNs) in 
providing security to shared public networks such as the Internet. 

In this lab you will set up a network where servers are accessed over the Internet by 
customers who have different privileges. You will study how firewalls and VPNs can 
provide security to the information in the servers while maintaining access for 
customers with the appropriate privilege. 

12.3. Prelab Activities 

• Read section 4.5.3 from "Computer Networks: A Systems Approach""Computer Networks: A Systems Approach""Computer Networks: A Systems Approach""Computer Networks: A Systems Approach",,,,    4th EditionEditionEditionEdition.... 
• Firewalls 

13. Laboratory - ApplicationsApplicationsApplicationsApplications (Network Application Performance Analysis) 147 

13.1. Objective 

The objective of this lab is to analyze the performance of an Internet application protocol and its relation 
to the underlying network protocols. In addition, this lab reviews some of the topics covered in 
previous labs. 

In this lab you will analyze the performance of an FTP application. You will analyze 
the probable bottlenecks for the application scenario under investigation. You will 
also study the sensitivity of the application to different network conditions such as 
bandwidth and packet loss. The trace was captured on a real network, which is 
shown in the figure below, and already imported into ACE. The FTP application runs 
on that network; the client connects to the server over a 768 Kbps Frame Relay 
circuit with 36 ms of latency. The FTP application downloads a 1 MB file in 37 
seconds. Normally the download time for a file this size should be about 11 
seconds. 

13.3. Prelab Activities 

• Read sections 9.1.1 and 9.1.3 from "Computer Networks: A Systems Approach""Computer Networks: A Systems Approach""Computer Networks: A Systems Approach""Computer Networks: A Systems Approach"    4th 
EditionEditionEditionEdition....    

Go to www.netwww.netwww.netwww.net----seal.net/animations.phpseal.net/animations.phpseal.net/animations.phpseal.net/animations.php    and play the following animations: 
• Internet Access. 

• Email Protocols 

14. Laboratory - Wireless Local AreaWireless Local AreaWireless Local AreaWireless Local Area Network (Medium Access Control for 
Wirelessly Connected Stations) 161 

14.1. Objective 

This lab addresses the Medium Access Control (MAC) sublayer of the IEEE 802.11 standard for 
WLAN (wireless local area network). Different options of this standard are studied in this lab. The 
performance of these options is analyzed under different scenarios. 

14.3. Prelab Activities 

• Read section 2.8.2 from "Computer Networks: A Systems Approach", , , , 4th Edition....    

15. Laboratory - Mobile Wireless NetworkMobile Wireless NetworkMobile Wireless NetworkMobile Wireless Network (A Wireless Local Area Network with 
Mobile Stations) 173 

15.1. Objective 

This lab simulates mobility in wireless local area network. The effect of mobility on the TCP 
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performance is studied. In addition, the lab studies how the request to send (RTS) and clear to send 
(CTS) frames are utilized in avoiding the hidden node problem usually induced by mobility in 
WLAN. 

In this lab we will simulate a wireless LAN with mobile workstations and server. The 
workstations will run an FTP application to upload files to the server. We will study 
the effect of node mobility on the performance of the TCP connection for the FTP 
session. We will study also the role of the request to send (RTS) and clear to send 
(CTS) frames in avoiding the hidden node problem usually induced by mobility in 
wireless LAN. 

15.3. Prelab Activities 

• Read sections 2.8.2 and 4.2.5 from "Computer Networks: A Systems Approach""Computer Networks: A Systems Approach""Computer Networks: A Systems Approach""Computer Networks: A Systems Approach"    4th 
EditionEditionEditionEdition....    

• Wireless Network and Multiple Access with Collision Avoidance 
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Preface 
Welcome to the Network Simulation Experiments Manual, 2

nd
 Edition. As networking systems have 

become more complex and expensive, hands-on experiments based on networking simulation have 
become essential for teaching the key computer networking topics to students and professionals. The 
simulation approach is highly useful because it provides a virtual environment for a variety of desirable 
features such as modeling a network based on specified criteria and analyzing its performance under 
different scenarios. 

This manual has 15 laboratory experiments that cover a variety of networking designs and protocols. 
The experiments in this manual do not require programming skills as a prerequisite. They are generic 
and can be easily expanded to utilize new technologies and networking standards. With the free 
easy-to-install software, the OPNET IT Guru Academic EditionOPNET IT Guru Academic EditionOPNET IT Guru Academic EditionOPNET IT Guru Academic Edition, networking students and 
professionals can implement the experiments from the convenience of their homes or workplaces. The 
manual is suitable for a single-semester course on computer networking at the undergraduate or 
beginning graduate level. Professors can pick the experiments that arc appropriate to their class. 

The new materials in the 2nd edition of the manual are: 
• A new Prelab Activities section in every laboratory assignment. This section includes 

recommended readings from the textbook as well as references to animations from the 
Net-SEAL project (www.net-seal.net)1. These activities are intended to reinforce the 
student’s understanding of the concepts related to the topics covered in the laboratory. 

• Two new laboratory experiments to cover wireless networking protocols. 
• One new laboratory experiment to cover the Border Gateway Protocol (BGP). 
• A new component to address the ICMP protocol has been added to the RIP lab. 
• A new component to address the effect of encryption has been added to the VPN lab. 

OPNET IT Guru Academic EditionOPNET IT Guru Academic EditionOPNET IT Guru Academic EditionOPNET IT Guru Academic Edition provides a virtual environment for modeling, analyzing, and 
predicting the performance of IT infrastructures, including applications, servers, and networking 
technologies. Based on OPNET’s award-winning IT Guru product, Academic Edition is designed to 
complement specific lab exercises that teach fundamental networking concepts. The commercial version 
of IT Guru has broader capabilities designed for the enterprise II environment, documentation, and 
professional support. OPNET software is used by thousands of commercial and government 
organizations worldwide, and by over 500 universities. For more information, visit www.opnet.com. 
OPNET and IT Guru are trademarks of OPNET Technologies, Inc. 

I would like to extend my appreciation to Professor Larry Peterson and Dr. Bruce Davie for giving me 
the opportunity to associate the laboratory experiments of this manual with their valuable book. I want to 
thank the folks at Morgan Kaufmann who have helped to bring this project to life. Many thank to the 
reviewers from academia and OPNET, who read through the various drafts of the experiments and 
provided me with extremely valuable feedback. My gratitude to the Net-SEAL project team, with 
special appreciation to Neal Charbonneau for the superb job he did in the project. I want to thank my 
family for their consideration and enthusiastic assurance throughout the development of this project. 
Last, but not least, I want to thank you for choosing the manual. I welcome your emails to report bug or 
to suggest improvements. 

Emad Aboclela, Ph.D. 
eaboclela@umassd.edu 
University of Massachusetts Dartmouth 
July 2007. 

                                              
1
 The materials in the www.ncl-scal.net website are based upon work supported by the National Science Foundation under 

Grant No. DUF-0536388. Any opinions, findings and conclusions or recommendations expressed in this website are those of 
the Net-SEAL project team and do not necessarily reflect the views of the National Science Foundation (NSF). 
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0. Laboratory - Introduction (Basics of OPNET IT Guru Academic Edition) 

0.1. Objective 

This lab teaches you the basics of using OPNET IT Guru Academic Edition. OPNET 
IT Guru Academic Edition enables students to better understand the core concepts 
of networking and equips them to effectively troubleshoot and manage real-world 
network infrastructures. 

0.2. Overview 

OPNET’s IT Guru provides a Virtual Network Environment that models the behavior 
of your entire network, including its routers, switches, protocols, servers, and 
individual applications. By working in the Virtual Network Environment, IT managers, 
network and system planners, and operations, staff are empowered to diagnose 
difficult problems more effectively, validate changes before they are implemented, 
and plan for future scenarios including growth and failure. 

OPNET’s Application CharacterizationApplication CharacterizationApplication CharacterizationApplication Characterization Environment (ACE) module for IT Guru 
enables enterprises to identify the root cause of end-to-end application performance 
problems and to solve them cost-effectively by understanding the impact of 
changes. 

In this lab, you will learn the basics of the OPNET IT Guru Academic EditionOPNET IT Guru Academic EditionOPNET IT Guru Academic EditionOPNET IT Guru Academic Edition 
software. You will learn how to setup and run OPNET IT Guru Academic EditionOPNET IT Guru Academic EditionOPNET IT Guru Academic EditionOPNET IT Guru Academic Edition. 
You will become familiar with some of its capabilities by running some tutorials. 

The labs in this manual are implemented with OPNET IT Guru Academic EditionOPNET IT Guru Academic EditionOPNET IT Guru Academic EditionOPNET IT Guru Academic Edition 
release 9.1.A (Build 1997). If you want to download the software, please visit the 
following site to register with OPNET technology: 

www.opnet.com/university_program/itguru_academic_edition/ 

http://www.opnet.com/itguru-academic/registration.html 

Recommended System Configuration, Platforms, and Software: 

• 1.5 GHz processor or better 

• 512 MB - 2 GB RAM 

• 1 GB disk space 

• Display: 1024 x 768 or higher resolution, 256 or more colors 

• Adobe Acrobat reader. 

• The English language version of the following operating systems are 
supported: 
o Microsoft Windows NT (Service Pack 3.5, or 6a) 
o Windows 2000 Professional (Service Pack 1, 2, and 4 are supported 
but not required) 

Windows XP (Service Pack 1 is required; Service Pack 2 is supported but not required.) 

0.3. Prelab Activities 

• Read Chapter 1 from "Computer Networks: A Systems Ap"Computer Networks: A Systems Ap"Computer Networks: A Systems Ap"Computer Networks: A Systems Approach"proach"proach"proach", 4th EditionEditionEditionEdition. 

Go to www.netwww.netwww.netwww.net----seal.net/animations.phpseal.net/animations.phpseal.net/animations.phpseal.net/animations.php    and play the following animation: 
• No Network. 
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0.4. Procedure 

0.4.1. Start OPNET IT Guru Academic Edition 

To start OPNET IT Guru Academic EditionOPNET IT Guru Academic EditionOPNET IT Guru Academic EditionOPNET IT Guru Academic Edition: 

1. Click on Start ⇒ Programs ⇒ OPNET IT Guru Academic EditionOPNET IT Guru Academic EditionOPNET IT Guru Academic EditionOPNET IT Guru Academic Edition x.x ⇒ OPNET OPNET OPNET OPNET 
IT Guru Academic EditionIT Guru Academic EditionIT Guru Academic EditionIT Guru Academic Edition, where x.x is the software version (e.g., 9.1) 

2. Read the Restricted Use Agreement and if you agree, click I have read this 
SOFTWARE AGREEMENT and I understand and accept the terms and 
conditions described herein. 

Now you should see the starting window of OPNET IT Guru Academic EditionOPNET IT Guru Academic EditionOPNET IT Guru Academic EditionOPNET IT Guru Academic Edition as 
shown: 

 

0.4.2. Check the OPNET Preferences 

The OPNET Preferences let you display and edit environment attributes, which 
control program operations. In this lab you will check three of these attributes. 

1. After starting OPNET, from the EditEditEditEdit menu, choose PreferencesPreferencesPreferencesPreferences.... 

2. The list of environment attributes is sorted alphabetically according to name. 
You can locate attributes faster by typing any part of the attribute's name in the 
Find Find Find Find field. 

3. Check the value of the license_server license_server license_server license_server attribute. It has the name of the License 
Server's host. If IT Guru is getting its license from the local host (i.e., the 
computer on which the software was installed), the value of license_server license_server license_server license_server 
should be localhost localhost localhost localhost as shown in the following figure. 
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4. Set the license_server_standalonelicense_server_standalonelicense_server_standalonelicense_server_standalone attribute to TRUE. This attribute specifies 
whether the program acts as its own license server. 

5. A model directory is a directory that contains OPNET model files. If the directory 
is listed in the mod_dirsmod_dirsmod_dirsmod_dirs environment attribute, then OPNET programs will use 
the models in that directory. Check the value of the mod_dirsmod_dirsmod_dirsmod_dirs attribute. The first 
directory in the list is where your own models will be saved. In the future you 
might need to access that directory to back up, copy, or move your models. IT 
Guru saves numerous files for every single project you create. 

6. Click OKOKOKOK to close the dialog box. 

0.4.3. Run the Introduction Tutorial 

Now you will run the introductory tutorial that teaches you the basics of using OPNET IT 
Guru. 

1. From the Help Help Help Help menu, select TutorialTutorialTutorialTutorial. 

2. Go over the Introduction    lesson from the list of Basic Lessons. 

0.4.4. Run the Small Internetworks Tutorial 

In this tutorial you will learn how to use OPNET IT Guru features to build and 
analyze network models. 

1. From the Help Help Help Help menu, select Tutorial.Tutorial.Tutorial.Tutorial. 

2. Carry out the Small Internetworks    tutorial from the list of Basic Lessons.... 

0.5. Further readings 

• OPNET Standard Network Applications: From the ProtocolsProtocolsProtocolsProtocols menu, select 

Applications Applications Applications Applications ⇒    Model Usage GuideModel Usage GuideModel Usage GuideModel Usage Guide    ⇒ Standard Network Applications.... 

• From the Help Help Help Help menu, select Tutorial. Tutorial. Tutorial. Tutorial. ⇒ Carry out the Troubleshooting Tutorial 
Simulations    tutorial from the list of Basic Lessons.... 
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0.6. Exercises 
1) In the project you created for the Small Internetworks Small Internetworks Small Internetworks Small Internetworks tutorial, add a new 

scenario as a duplicate of the first_ffirst_ffirst_ffirst_flooloolooloor r r r scenario. Name the new scenario 
expansion2expansion2expansion2expansion2. In the expansion2 expansion2 expansion2 expansion2 scenario expand the network the same way as 
in the expansion expansion expansion expansion scenario but with 30 nodes in the second floor instead of 15 
nodes. Run the simulation and compare the load and delay graphs of this new 
scenario with the corresponding graphs of the ffffiiiirst_floor rst_floor rst_floor rst_floor and expansion expansion expansion expansion 
scenarios. 

0.7. Lab Report 
The laboratory report of this lab (and also all the following labs in this manual) 
should include the following items/sections: 

2) A cover page with your name, course information, lab number and title, and 
date of submission. 

3) A summary of the addressed topic and objectives of the lab. 

4) Implementation: a brief description of the process you followed in conducting 
the implementation of the lab scenarios. 

5) Results obtained throughout the lab implementation, the analysis of these 
results, and a comparison of these results with your expectations. 

6) Answers to the given exercises at the end of the lab. If an answer incorporates 
new graphs, analysis of these graphs should be included here. 

7) A conclusion that includes what you learned, difficulties you faced, and any 
suggested extensions/improvements to the lab. 
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1. Laboratory - Ethernet (A Direct Link Network with Media Access 
Control) 

1.1. Objective 

This lab is designed to demonstrate the operation of the Ethernet network. The 
simulation in this lab will help you examine the performance of the Ethernet network 
under different scenarios. 

1.2. Overview 

The Ethernet is a working example of the more general Carrier Sense, Multiple 
Access with Collision Detect (CSMA/CD) local area network technology. The 
Ethernet is a multiple-access network, meaning that a set of nodes sends and 
receives frames over a shared link. The "carrier sense" in CSMA/CD means that all 
the nodes can distinguish between an idle and a busy link. The "collision detect" 
means that a node listens as it transmits and can therefore detect when a frame it is 
transmitting has interfered (collided) with a frame transmitted by another node. The 
Ethernet is said to be a 1-persistent protocol because an adaptor with a frame to 
send transmits with probability 1 whenever a busy line goes idle. 

In this lab you will set up an Ethernet with thirty nodes connected via a coaxial link in 
a bus topology. The coaxial link is operating at a data rate of 10 Mbps. You will study 
how the throughput of the network is affected by the network load as well as the size 
of the packets. 

1.3. Prelab Activities 

• Read section 2.6 from "Computer Networks: A Systems Approach""Computer Networks: A Systems Approach""Computer Networks: A Systems Approach""Computer Networks: A Systems Approach", 4" Edition.    

Go to www.netwww.netwww.netwww.net----sssseal.net/animations.phpeal.net/animations.phpeal.net/animations.phpeal.net/animations.php    and play the following animation: 
• Hub. 

1.4. Procedure 

1.4.1. Create a New Project 

To create a new project for the Ethernet network: 

1. Start OPNET IT Guru Academic EditionOPNET IT Guru Academic EditionOPNET IT Guru Academic EditionOPNET IT Guru Academic Edition    ⇒ Choose NewNewNewNew    from the FileFileFileFile menu. 

2. Select PrPrPrProjojojoject ect ect ect ⇒    Click OKOKOKOK    ⇒ Name the project <your initials><your initials><your initials><your initials>_Ethernet_Ethernet_Ethernet_Ethernet, and the 

scenario Coax Coax Coax Coax ⇒ Click OKOKOKOK.... 

3. In the Startup Wizard: Initial Topology    dialog box, make sure that Create Empty Create Empty Create Empty Create Empty 

ScenarioScenarioScenarioScenario    is selected ⇒ Click NextNextNextNext    ⇒    Choose OfficeOfficeOfficeOffice    from the Network Scale list 
⇒ Click NextNextNextNext ⇒ Assign 200 200 200 200 to X SpanX SpanX SpanX Span    and keep Y SpanY SpanY SpanY Span    as 100 100 100 100 ⇒    Click NextNextNextNext    

twice ⇒ Click OKOKOKOK.... 

4. Close the Object Palette    dialog box. 
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Local area networks (LANs) are designed to span distances of up to a few thousand meters. 

1.4.2. Create the Network 

To create our coaxial Ethernet network: 

1. To create the network configuration, select TopologyTopologyTopologyTopology ⇒ Rapid ConfigurationRapid ConfigurationRapid ConfigurationRapid Configuration. 
From the drop-down menu choose Bus Bus Bus Bus and Click OKOKOKOK.... 

2. Click the SelectSelectSelectSelect Models  Models  Models  Models button in the Rapid Configuration dialog box. From the 
ModelModelModelModel    ListListListList drop-down    menu choose ethcoax ethcoax ethcoax ethcoax and Click OKOKOKOK.... 

3. In the Rapid Configuration dialog box, set the following eight values. 

 

4. Click OKOKOKOK.... 

The eth_tap is an Ethernet bus tap that connects a node with the bus. 

The eth_coax is an Ethernet bus that can connects nodes with bus receivers and transmitters via taps. 

 

5. To configure the coaxial bus, right-click on the horizontal link ⇒ Select 
Advanced Advanced Advanced Advanced Edit Edit Edit Edit AttributesAttributesAttributesAttributes    from the menu: 
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a. Click on the valuevaluevaluevalue of the modelmodelmodelmodel attribute ⇒ Select EditEditEditEdit    from the drop-down 

menu ⇒ Choose the eth_coax_adv eth_coax_adv eth_coax_adv eth_coax_adv model. 
b. Assign the value 0.05 0.05 0.05 0.05 to the delay delay delay delay attribute (propagation delay in sec/m). 
c. Assign 5 5 5 5 to the thickness thickness thickness thickness attribute. 

d. Click OKOKOKOK.... 

A higher delay is used here as an alternative to generating higher traffic which would require much longer 
simulation time. 

Thickness specifies the thickness of the line used to “draw” the bus link. 

 

6. Now you have created the network. It should look like the illustration below. 

7. Make sure to save your project. 
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1.4.3. Configure the Network Nodes 

To configure the traffic generated by the nodes: 

1. Right-click on any of the 30 nodes ⇒ Select Similar NodesSelect Similar NodesSelect Similar NodesSelect Similar Nodes. Now all nodes in 
the network are selected. 

2. Right-click on any of the 30 nodes ⇒ Edit Edit Edit Edit AttribuAttribuAttribuAttributestestestes. 

3. Check the Apply Changes to Selected ObjectsApply Changes to Selected ObjectsApply Changes to Selected ObjectsApply Changes to Selected Objects check box. This is important to 
avoid reconfiguring each node individually. 

4. Expand the Traffic Generation ParametersTraffic Generation ParametersTraffic Generation ParametersTraffic Generation Parameters hierarchy: 

a. Change the value of the ON State TimeON State TimeON State TimeON State Time to exponential(100)exponential(100)exponential(100)exponential(100) ⇒ Change the 
value of the OFF State TimeOFF State TimeOFF State TimeOFF State Time to exponentiexponentiexponentiexponential(0)al(0)al(0)al(0). (Note: Packets are 
generated only in the ON state.) 

5. Expand the Packet Generation ArgumentsPacket Generation ArgumentsPacket Generation ArgumentsPacket Generation Arguments hierarchy: 

a. Change the value of the Packet Size Packet Size Packet Size Packet Size attribute to constant(1024)constant(1024)constant(1024)constant(1024). 

b. Right-click on the Interarrival TimeInterarrival TimeInterarrival TimeInterarrival Time    attribute and choose Promote Attribute Promote Attribute Promote Attribute Promote Attribute 
to Higher Level. to Higher Level. to Higher Level. to Higher Level. This allows us to assign multiple values to the Interarrival Interarrival Interarrival Interarrival 
TimeTimeTimeTime    attribute and hence to test the network performance under different 
loads. 
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6. Click OKOKOKOK to return back to the Project Editor. 

7. Make sure to save your project. 

The argument of the exponentialexponentialexponentialexponential distribution is the mean of the interval between successive events. In the 
exponential distribution the probability of occurrence of the next event by a given name is not at all dependent 
upon the time of occurrence of the last event of the elapsed time since that event. 

The interinterinterinterarriarriarriarrival timeval timeval timeval time is the time between successive packet generations in the “ON” state. 

1.4.4. Configure the Simulation 

To examine the network performance under different loads, you need to run the 
simulation several times by changing the load load load load into the networknetworknetworknetwork. There is an easy 
way to do that. Recall that we promoted the Interarrival TimeInterarrival TimeInterarrival TimeInterarrival Time    attribute for package 
generation. Here we will assign different values to that attribute: 

1. Click on the Configure/Run SimulationConfigure/Run SimulationConfigure/Run SimulationConfigure/Run Simulation    button:  ⇒ Make sure that the 
CommonCommonCommonCommon tab is chosen ⇒ Assign 15151515 seconds to the DurationDurationDurationDuration. 

 

2. Click on the Object AttributesObject AttributesObject AttributesObject Attributes tab. 
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3. Click on the Add button. The Add Attribute dialog box should appear filled with 
the promoted attributes of all nodes in the network (if you do not see the 
attributes in the list, close the whole project and reopen it). You need to add the 
Interarrival TimeInterarrival TimeInterarrival TimeInterarrival Time attribute for all nodes. To do that: 

a. Click on the first attribute in the list ((((OfficeOfficeOfficeOffice Network. Network. Network. Network.node_0node_0node_0node_0.Traffic.Traffic.Traffic.Traffic    

GenerationGenerationGenerationGeneration.) ⇒ Click the Wildcard Wildcard Wildcard Wildcard button ⇒ Click on node_0node_0node_0node_0    and choose 

the asterisk (****) from the drop-down menu ⇒ Click OKOKOKOK.... 

 

b. A new attribute is now generated containing the asterisk (the second one in 
the list), and you need to add it by clicking on the corresponding cell under 
the Add?Add?Add?Add? column. 

 

c. The Add Attribute dialog box should look like the shown one ⇒ Click OKOKOKOK. 

4. Now you should see the Office Network.*.Traffic GeneratOffice Network.*.Traffic GeneratOffice Network.*.Traffic GeneratOffice Network.*.Traffic Generation Parameterion Parameterion Parameterion Parameter … in the 

list of simulation object attributes. Click on that attribute to select it. ⇒ Click the 
ValuesValuesValuesValues button of the dialog box. 

5. Add the following nine values. (Note: To add the first value, double-click on the 

first cell in the ValueValueValueValue column ⇒ Type "exponential (2)" into the textbox and hit 

Enter ⇒ Repeat this for all nine values.) 
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6. Click OKOKOKOK. Now look at the upper-right comer of the Simulation Configuration 
dialog box and make sure that the Number of runs in set is 9. 

 

7. For each simulation of the nine runs, we need the simulator to save a "scalar" 
value that represents the "average" load in the network and to save another 
scalar value that represents the average throughput of the network. To save 
these scalars we need to configure the simulator to save them in a file. Click on 
the AdvancedAdvancedAdvancedAdvanced tab in the Configure Simulation dialog box. 

8. Assign <your initials><your initials><your initials><your initials>_Ethernet_Coax_Ethernet_Coax_Ethernet_Coax_Ethernet_Coax to the Scalar file text field. 
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9. Click OKOKOKOK and then save your project. 

1.4.5. Choose the Statistics 

To choose the statistics to be collected during the simulation: 

1. Right-click anywhere in the project workspace (but not on one of the nodes or 

links) and select Choose individual Statistics Choose individual Statistics Choose individual Statistics Choose individual Statistics from the pop-up menu ⇒ Expand 
the Global Statistics Global Statistics Global Statistics Global Statistics hierarchy. 

a. Expand the TrafTrafTrafTraffic Sink fic Sink fic Sink fic Sink hierarchy ⇒ Click the check box next to Traffic 
Received (packets/sec) (packets/sec) (packets/sec) (packets/sec) (make sure you select the statistic with units of 
packets/sec), 

b. Expand the Traffic Source Traffic Source Traffic Source Traffic Source hierarchy ⇒ Click the check box next to Traffic 
Sent (packets/sec)(packets/sec)(packets/sec)(packets/sec). 

c. Click OK. 

 

A probeprobeprobeprobe represents a request by the user to collect a particular piece of data about a simulation. 

2. Now to collect the average of the above statistics as a scalar value by the end of 
each simulation run: 

a. Select Choose Statistics (AdvancedChoose Statistics (AdvancedChoose Statistics (AdvancedChoose Statistics (Advanced))))    from the Simulation menu. 

b. The Traffic SentTraffic SentTraffic SentTraffic Sent    and Traffic ReceivedTraffic ReceivedTraffic ReceivedTraffic Received    probes should appear under the 
Global Statistic ProbesGlobal Statistic ProbesGlobal Statistic ProbesGlobal Statistic Probes. 

c.c.c.c. Right-click on Traffic ReceivedTraffic ReceivedTraffic ReceivedTraffic Received    probe ⇒ Edit Edit Edit Edit AttributesAttributesAttributesAttributes. . . . Set the scalarscalarscalarscalar    data data data data 

attribute to enabledenabledenabledenabled    ⇒ Set the scalar typescalar typescalar typescalar type attribute to ttttime averageime averageime averageime average    ⇒ 
Compare to the following figure and Click OKOKOKOK.    
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d. Repeat the previous step with the Traffic SentTraffic SentTraffic SentTraffic Sent    probe. 

e. Select savesavesavesave from the FileFileFileFile menu in the Probe Model window and then close 
that window. 

f. Now you are back to the Project Editor. . . . Make sure to save your project. 

1.4.6. Run the Simulation 

To run the simulation: 

1. Click on the Configure/Run SimulationConfigure/Run SimulationConfigure/Run SimulationConfigure/Run Simulation button:  . ⇒ Make sure that 15 

second(s) second(s) second(s) second(s) (not hours) is assigned to the DurationDurationDurationDuration    ⇒    Click Run. Run. Run. Run. Depending on 
the speed of your processor, this may take several minutes to complete. 

2. Now the simulator is completing nine runs, one for each traffic generation 
inter-arrival time (representing the load into the network). Notice that each 
successive run takes longer to complete because the traffic intensity is 
increasing. 

 

3. After the nine simulation runs, complete, click CloseCloseCloseClose. 
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4. Save your project. 

 

When you rerun the simulation, OPNET IT Guru will "append" the new results to the 
results already in the scalar file. To avoid that, delete the scalar file beforebeforebeforebefore    you start a 
new run. (Note::::    Deleting the scalar file after a run will result in losing the collected 
results from that run.) 

• Go to the FileFileFileFile menu ⇒ Select Model Files Model Files Model Files Model Files ⇒ Delete M Delete M Delete M Delete Model Filodel Filodel Filodel Files es es es ⇒    Select ( .os): .os): .os): .os): 

Output Scalars Output Scalars Output Scalars Output Scalars ⇒ Select the scalar file to be deleted; in this lab it is <your <your <your <your 

initials>initials>initials>initials>_Ethernet_Coax_Ethernet_Coax_Ethernet_Coax_Ethernet_Coax    ⇒ Confirm the deletion by clicking OK OK OK OK ⇒    Click CCCClolololose.se.se.se.    

1.4.7. View the Results 

To view and analyze the results: 

1. Select ViewViewViewView Results (Advanced)  Results (Advanced)  Results (Advanced)  Results (Advanced) from the ResultsResultsResultsResults menu. Now the Analysis Analysis Analysis Analysis 
CCCConfiguration onfiguration onfiguration onfiguration tool is open. 

2. Recall that we saved the average results in a scalar file. To load this file, select 

Load Output Scalar FileLoad Output Scalar FileLoad Output Scalar FileLoad Output Scalar File    from the FileFileFileFile menu ⇒ Select <your initials><your initials><your initials><your initials>____    
EthernetEthernetEthernetEthernet----CoCoCoCoax ax ax ax from the pop-up menu. 

3. Select Create Scalar PanelCreate Scalar PanelCreate Scalar PanelCreate Scalar Panel    from the PanPanPanPanelselselsels menu ⇒ Assign Traffic Traffic Traffic Traffic 

Source.Source.Source.Source.Traffic SentTraffic SentTraffic SentTraffic Sent(packets/sec).average (packets/sec).average (packets/sec).average (packets/sec).average to Horizontal Horizontal Horizontal Horizontal ⇒ Assign Traffic Traffic Traffic Traffic 

Sink.Sink.Sink.Sink.Traffic ReceivedTraffic ReceivedTraffic ReceivedTraffic Received(packets/sec).average (packets/sec).average (packets/sec).average (packets/sec).average to Vertical Vertical Vertical Vertical ⇒ Click OKOKOKOK.... 

 

4. The resulting graph should resemble the one below: 
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Note: Check ordinate scale! 

1.5. Further readings 

• OPNET Ethernet Model Description: From the ProtocolsProtocolsProtocolsProtocols menu, select EthernetEthernetEthernetEthernet ⇒ 
Model Usage Guide. 

1.6. Exercises 

1) Explain the graph we received in the simulation that shows the relationship 
between the received (throughput) and sent (load) packets. Why does the 
throughput drop when the load is either very low or very high? 

2) Create three duplicates of the simulation scenario implemented in this tab. 
Name these scenarios Coax_Q2a, Coax_Q2b, Coax_Q2a, Coax_Q2b, Coax_Q2a, Coax_Q2b, Coax_Q2a, Coax_Q2b, and Coax_Q2cCoax_Q2cCoax_Q2cCoax_Q2c. Set the 
Interarrival TimeInterarrival TimeInterarrival TimeInterarrival Time    attribute of the Packet Generation Arguments    for all nodes 
(make sure to check Apply Changes to Selected ObjectsApply Changes to Selected ObjectsApply Changes to Selected ObjectsApply Changes to Selected Objects    while editing the 
attribute) in the new scenarios as follows: 

• Coax_Q2a Coax_Q2a Coax_Q2a Coax_Q2a scenario: exponential(0.1)exponential(0.1)exponential(0.1)exponential(0.1) 

• Coax_Q2b Coax_Q2b Coax_Q2b Coax_Q2b scenario: exponential(0.05)exponential(0.05)exponential(0.05)exponential(0.05) 

• Coax_Q2c Coax_Q2c Coax_Q2c Coax_Q2c scenario: exponential(0.025)exponential(0.025)exponential(0.025)exponential(0.025) 

3) In all the above new scenarios, open the Configure Simulation dialog box and 
from the Object Attributes delete the multiple-value attribute (the only attribute 
shown in the list). 

4) Choose the following statistic for node 0: Ethcoax Ethcoax Ethcoax Ethcoax �    Collision Count. Collision Count. Collision Count. Collision Count. Make sure 
that the following global statistic is chosen: Global StatisticsGlobal StatisticsGlobal StatisticsGlobal Statistics    �    TrafficTrafficTrafficTraffic    SinkSinkSinkSink    �    
Traffic ReceivedTraffic ReceivedTraffic ReceivedTraffic Received (packet/sec).  (packet/sec).  (packet/sec).  (packet/sec). (Refer to the Choose the Statistics    section in the 
lab.) 

5) Run the simulation for all three new scenarios. Get two graphs: one to compare 
node 0's collision counts in these three scenarios and the other graph to 
compare the received traffic from the three scenarios. Explain the graphs and 
comment on the results. (Note: To compare results you need to select Compare Compare Compare Compare 
ResultsResultsResultsResults    from the ResultsResultsResultsResults menu after the simulation run is done.) 

6) To study the effect of the number of stations on Ethernet segment performance, 
create a duplicate of the Coax_Q2c Coax_Q2c Coax_Q2c Coax_Q2c scenario, which you created in Exercise 2. 
Name the new scenario Coax_Q3Coax_Q3Coax_Q3Coax_Q3. In the new scenario, remove the 



 

 network simulation experiments manual.doc utorak, 28. rujan 2010 17 

odd-numbered nodes, a total of 15 nodes (node 1, node 3, …, and node 29). Run 
the simulation for the new scenario. Create a graph that compares node 0's 
collision counts in scenarios Coax_Q2c Coax_Q2c Coax_Q2c Coax_Q2c and Coax_Q3Coax_Q3Coax_Q3Coax_Q3. Explain the graph and 
comment on the results. 

7) In the simulation a packet size of 1024 bytes is used (Note: : : : Each Ethernet 
packet can contain up to 1500 bytes of data). To study the effect of the packet 
size on the throughput of the created Ethernet network, create a duplicate of the 
Coax_Q2c Coax_Q2c Coax_Q2c Coax_Q2c scenario, which you created in Exercise 2. Name the new scenario 
Coax_Q4. Coax_Q4. Coax_Q4. Coax_Q4. In the new scenario use a packet size of 512 bytes (for all nodes). For 
both Coax_Q2c Coax_Q2c Coax_Q2c Coax_Q2c and Coax_Q4 Coax_Q4 Coax_Q4 Coax_Q4 scenarios, choose the following global statistic: 
GloGloGloGlobal Statisticsbal Statisticsbal Statisticsbal Statistics � Traffic SinkTraffic SinkTraffic SinkTraffic Sink � Traffic ReceivedTraffic ReceivedTraffic ReceivedTraffic Received (bits/sec)  (bits/sec)  (bits/sec)  (bits/sec) Rerun the 
simulation of Coax_Q2c Coax_Q2c Coax_Q2c Coax_Q2c and Coax_Q4 Coax_Q4 Coax_Q4 Coax_Q4 scenarios. Create a graph that 
compares the throughput as packets/sec and another graph that compares the 
throughput as bits/sec in Coax_Q2c Coax_Q2c Coax_Q2c Coax_Q2c and Coax_Q4 Coax_Q4 Coax_Q4 Coax_Q4 scenarios. Explain the 
graphs and comment on the results. 

1.7. Lab Report 

Prepare a report that follows the guidelines explained in Lab 0. The report should 
include the answers to the above exercises as well as the graphs you generated 
from the simulation scenarios. Discuss the results you obtained and compare these 
results with your expectations. Mention any anomalies or unexplained behaviors. 
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2. Laboratory - Token Ring (A Shared-Media Network with Media Access 
Control) 

2.1. Objective 

This lab is designed to demonstrate the implementation of a token ring network. The 
simulation in this lab will help you examine the performance of the token ring 
network under different scenarios. 

2.2. Overview 

A token ring network consists of a set of nodes connected in a ring. The ring is a 
single shared medium. The token ring technology involves a distributed algorithm 
that controls when each node is allowed to transmit. All nodes see all frames. The 
destination node, which is identified in the frame header, saves a copy of the frame 
as the frame flows past the node. With a ring topology, any link or node failure would 
render the whole network useless. This problem can be solved by using a star 
topology where nodes are connected to a token ring hub. The hub acts as a relay, 
known as a multi-station access unit (MSAU). MSAUs are almost always used 
because of the need for robustness and ease of node addition and removal. 

The "token," which is just a special sequence of bits, circulates around the ring; 
each node receives and then forwards the token. When a node that has a frame to 
transmit sees the token, it takes the token off the ring and instead inserts its frame 
into the ring. When the frame makes its way back around to the sender, this node 
strips its frame off the ring and reinserts the token. The token holding timetoken holding timetoken holding timetoken holding time (THTTHTTHTTHT) is 
the time a given node is allowed to hold the token. From its definition, the THTTHTTHTTHT has 
an effect on the utilization and fairness of the network, where utilization is the 
measure of the bandwidth used versus that available on the given ring. 

In this lab, you will set up a token ring network with 14 nodes connected in a star 
topology. The links you will use operate at a data rate of 4 Mbps. You will study how 
the utilization and delay of the network are affected by the network load as well as 
the token holding timetoken holding timetoken holding timetoken holding time THTTHTTHTTHT. 

2.3. Prelab Activities 

• Read section 2.7 from "Computer Networks: A Systems Approach""Computer Networks: A Systems Approach""Computer Networks: A Systems Approach""Computer Networks: A Systems Approach", , , , 4th EditionEditionEditionEdition.... 

2.4. Procedure 

2.4.1. Create a New Project 

To create a new project for the token ring network: 

1. Start OPNET IT Guru Academic EditionOPNET IT Guru Academic EditionOPNET IT Guru Academic EditionOPNET IT Guru Academic Edition    ⇒ Choose NewNewNewNew    from the FileFileFileFile menu. 

2. Select ProjectProjectProjectProject and Click OKOKOKOK    ⇒    Name the project <your initials><your initials><your initials><your initials>_Token, _Token, _Token, _Token, and the 

scenario BalancedBalancedBalancedBalanced    ⇒    Click OKOKOKOK.... 

3. In the Startup Wizard: Initial Topology    dialog box, make sure that Create Empty Create Empty Create Empty Create Empty 

ScenarioScenarioScenarioScenario    is selected ⇒ Click NextNextNextNext    ⇒ Choose OfficeOfficeOfficeOffice    for the Network scale ⇒ 

Click NextNextNextNext    three times ⇒ Click OKOKOKOK.... 

4. Close the Object PaletteObject PaletteObject PaletteObject Palette    and then save your project. 
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2.4.2. Create the Network 

To create our token ring network: 

1. Select Topology Topology Topology Topology ⇒ Rapid Configuration Rapid Configuration Rapid Configuration Rapid Configuration. From the drop-down menu choose 
Star Star Star Star and Click OKOKOKOK.... 

2. Click the Select Models Select Models Select Models Select Models button in the Rapid Configuration dialog box. From the 
ModelModelModelModel    ListListListList    drop-down menu choose token_ring token_ring token_ring token_ring and Click OKOKOKOK.... 

3. In the Rapid Configuration dialog box, set the following six values and Click OKOKOKOK.... 

 

The tr.32_hubtr.32_hubtr.32_hubtr.32_hub node model is a token ring hub supporting up to 32 connections at 4 or 16 Mbps. The hub forwards 
an arriving packet to the next output port. There is no queuing of packets in the hub itself as the processing time is 
considered to be zero. 

The TR4 linkTR4 linkTR4 linkTR4 link connects two token ring devices to form a ring at 4 Mbps. 

4. You have now created the network, and it should look like the following: 

 

5. Make sure to save your project. 
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2.4.3. Configure the Network Nodes 

Here you will configure the THTTHTTHTTHT of the nodes as well as the traffic generated by 
them. To configure the THTTHTTHTTHT of the nodes, you need to use the tr_station_advtr_station_advtr_station_advtr_station_adv    model 
for the nodes instead of the current one, tr_stationtr_stationtr_stationtr_station....    

1. Right-click on any of the 14 nodes. ⇒ Select Similar NodesSelect Similar NodesSelect Similar NodesSelect Similar Nodes. . . . Now all nodes in 
the network are selected. 

2. RighRighRighRightttt----cliclicliclick ck ck ck on any of the 14 nodes ⇒    Edit Edit Edit Edit AttributesAttributesAttributesAttributes. 

a. Check the Apply Changes to Selected ObjectsApply Changes to Selected ObjectsApply Changes to Selected ObjectsApply Changes to Selected Objects    check box. This is important 
to avoid reconfiguring each node individually. 

The following figure shows the attributes we will change in steps 3 to 6: 

 

The THTTHTTHTTHT (Token Holding Time) specifies the maximum amount of time a token ring MAC (Media Access Control) 
may use the token before releasing it. 

The interarrival timeinterarrival timeinterarrival timeinterarrival time is the time between successive packet generations in the “ON” state. 

3. Click on the model value: tr_stationtr_stationtr_stationtr_station and select Edit Edit Edit Edit from the drop-down menu. 
Now select tr_station_advtr_station_advtr_station_advtr_station_adv from the extended drop-down menu. 

4. To test the network under different THT values, you need to "promote" the THT 
parameter. This allows us to assign multiple values to the THT attribute. 

a. Expand the Token Ring Parameters Token Ring Parameters Token Ring Parameters Token Ring Parameters hierarchy. 
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b. Right-click on the THTTHTTHTTHT    DurationDurationDurationDuration attribute. ⇒ Choose Promote AttributePromote AttributePromote AttributePromote Attribute    to to to to 
Higher LevelHigher LevelHigher LevelHigher Level. 

5. Expand the Traffic GeneratioTraffic GeneratioTraffic GeneratioTraffic Generation Parametersn Parametersn Parametersn Parameters hierarchy. ⇒ Assign 

exponential(100)exponential(100)exponential(100)exponential(100) to the ON State Time attribute ⇒ Assign exponential(0)exponential(0)exponential(0)exponential(0) to the 
OFF State Time attribute. (Note: Packets are generated only in the "ON" state.) 

6. Expand the Packet Generation ArgumentsPacket Generation ArgumentsPacket Generation ArgumentsPacket Generation Arguments hierarchy. ⇒ Assign 
exponexponexponexponential(0.025)ential(0.025)ential(0.025)ential(0.025) to the Interarrival TimeInterarrival TimeInterarrival TimeInterarrival Time attribute. 

7. Click OKOKOKOK to return back to the Project Editor. 

8. Make sure to save your project. 

2.4.4. Configure the Simulation 

To examine the network performance under different THTs, you need to run the 
simulation several times by changing THTTHTTHTTHT with every run of the simulation. There is 
an easy way to do that. Recall that we promoted the THT THT THT THT DurationDurationDurationDuration attribute. Here 
we will assign different values to that attribute: 

1. Click on the Configure/Run SimulationConfigure/Run SimulationConfigure/Run SimulationConfigure/Run Simulation button: . 

2. Make sure that the CommonCommonCommonCommon tab is chosen. ⇒ Assign 5555 minutes to the DurationDurationDurationDuration. 

 

3. Click on the Object AttributesObject AttributesObject AttributesObject Attributes tab. ⇒ Click the AddAddAddAdd button. 

4. As shown in the following Add Attribute dialog box, you need to add the THT THT THT THT 
DurationDurationDurationDuration attribute for all nodes. To do that: 

a. Add the unresolved attribute: OfficeOfficeOfficeOffice Network.*.Token Ring  Network.*.Token Ring  Network.*.Token Ring  Network.*.Token Ring 
ParametersParametersParametersParameters[0[0[0[0].].].].THTTHTTHTTHT Duration Duration Duration Duration by clicking on the corresponding cell under the 

Add?Add?Add?Add? column ⇒ Click OKOKOKOK.... 
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5. Now you should see the OfficeOfficeOfficeOffice Network.*.Token Ring Parameters[0].THT.  Network.*.Token Ring Parameters[0].THT.  Network.*.Token Ring Parameters[0].THT.  Network.*.Token Ring Parameters[0].THT. 
DurationDurationDurationDuration in the list of simulation object attributes (widen the "Attribute" column to 

see the full name of the attribute). Click on that attribute ⇒ Click the ValuesValuesValuesValues 
button, as shown below. 

 

6. Add the following six values. (Note: To add the first value, double-click on the 

first cell in the ValueValueValueValue column ⇒ Type "0.01" into the textbox and hit enter. 
Repeat this for all six values.) 

 

7. Click OKOKOKOK. Now look at the upper-right comer of the Simulation Configuration 
dialog box and make sure that the Number of runs in set is 6. 
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8. For each of the six simulation runs we need the simulator to save "scalar" values 
that represent the "average" values of the collected statistics. To save these 
scalars we need to configure the simulator to save them in a file. Click on the 
AdvancedAdvancedAdvancedAdvanced tab in the Configure Simulation dialog box. 

9. Assign <your initials>_Token_<your initials>_Token_<your initials>_Token_<your initials>_Token_BalancedBalancedBalancedBalanced to the Scalar file text field. 

 

10. Click OKOKOKOK and then save your project. 

2.4.5. Choose the Statistics 

To choose the statistics to be collected during the simulation: 

1. Right-click anywhere in the project workspace (but not on a node or link) and 
select Choose Individual StatisticsChoose Individual StatisticsChoose Individual StatisticsChoose Individual Statistics    from the pop-up menu. 

a. Expand the Global Statistics Global Statistics Global Statistics Global Statistics hierarchy: 

- Expand the Traffic Sink Traffic Sink Traffic Sink Traffic Sink hierarchy. ⇒ Click the check box next to Traffic Traffic Traffic Traffic 
ReceivedReceivedReceivedReceived (packets/sec). (packets/sec). (packets/sec). (packets/sec).    

- Expand the TrTrTrTraffic Source affic Source affic Source affic Source hierarchy. ⇒ Click the check box next to 
Traffic SentTraffic SentTraffic SentTraffic Sent (packets/sec). (packets/sec). (packets/sec). (packets/sec).    

b. Expand the Node Statistics Node Statistics Node Statistics Node Statistics hierarchy: 
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- Expand the Token Ring Token Ring Token Ring Token Ring hierarchy. ⇒ Click the check box next to 
Utilization.Utilization.Utilization.Utilization.    

c. Click OKOKOKOK. 

The utilizationutilizationutilizationutilization is a measure of the bandwidth used versus that available on the given ring. 

2. Now we want to collect the average of the above statistics as a scalar value by 
the end of each simulation run. 

a. Select Choose Statistics (Advanced)Choose Statistics (Advanced)Choose Statistics (Advanced)Choose Statistics (Advanced) from the Simulation menu. 

b. The Traffic SentTraffic SentTraffic SentTraffic Sent and Traffic ReceivedTraffic ReceivedTraffic ReceivedTraffic Received probes should appear under the 
Global Statistic ProbesGlobal Statistic ProbesGlobal Statistic ProbesGlobal Statistic Probes. The UtilizationUtilizationUtilizationUtilization probe should appear under the 
Node Statistics ProbesNode Statistics ProbesNode Statistics ProbesNode Statistics Probes. 

c. Right-click on Traffic ReceivedTraffic ReceivedTraffic ReceivedTraffic Received probe. ⇒ Edit Edit Edit Edit AttributesAttributesAttributesAttributes. Set the scalar data 

attribute to enabledenabledenabledenabled. ⇒ Set the scalar typescalar typescalar typescalar type attribute to time averagetime averagetime averagetime average. ⇒ 
Compare to the following figure and Click OKOKOKOK. 

 

d. Repeat the previous step with the Traffic SentTraffic SentTraffic SentTraffic Sent and UtilizationUtilizationUtilizationUtilization probes. 

A probeprobeprobeprobe represents a request by the user to collect a particular piece of data about a simulation. 

3. Since we need to analyze the effect of THT on the network performance, THT 
must be added as an "input" statistic to be recorded by the simulation. To do 
that: 

a. Select Create Attribute Probe Create Attribute Probe Create Attribute Probe Create Attribute Probe from the Objects Objects Objects Objects menu. Now a new attribute 
is created under the Attribute Probes Attribute Probes Attribute Probes Attribute Probes hierarchy as shown. 

b. Right-click on the new attribute probe and select Choose Attributed ObjectChoose Attributed ObjectChoose Attributed ObjectChoose Attributed Object 

from the pop-up menu. ⇒ Expand the OfficeOfficeOfficeOffice Network Network Network Network hierarchy. ⇒ Click on 

node_0node_0node_0node_0 (actually you can pick any other node) ⇒ Click OKOKOKOK. 



 

 network simulation experiments manual.doc utorak, 28. rujan 2010 25 

 

c. Right-click again on the new attribute probe and select    Edit Edit Edit Edit AttributesAttributesAttributesAttributes from 

the pop-up menu. ⇒ Assign the Token Ring Parameter[0].THT DurationToken Ring Parameter[0].THT DurationToken Ring Parameter[0].THT DurationToken Ring Parameter[0].THT Duration 

value to the "attributeattributeattributeattribute" Attribute, as shown in the figure. ⇒ Click OKOKOKOK. 

 

4. Select save from the FileFileFileFile menu in the Probe Model window and then CCCClllloseoseoseose the 
window. 

5. Now you are back to the Project Editor. Make sure to save your project. 

2.4.6. Duplicate the Scenario 

The token ring network scenario we just implemented is balanced:balanced:balanced:balanced:    the distribution of 
the generated traffic in all nodes is the same. To compare performance, you will 
create an "unbalanced" scenario as follows: 

1. Select Duplicate ScenarioDuplicate ScenarioDuplicate ScenarioDuplicate Scenario    from the ScenariosScenariosScenariosScenarios menu and give it the name 

UnbalancedUnbalancedUnbalancedUnbalanced    ⇒ Click OKOKOKOK. 

2. Select node_0node_0node_0node_0    and node_7 node_7 node_7 node_7 by shift-clicking on both nodes. ⇒ Right-click on one 

of these two selected nodes and select    Edit Edit Edit Edit AttributesAttributesAttributesAttributes    ⇒ Expand the Traffic Traffic Traffic Traffic 

Generation ParametersGeneration ParametersGeneration ParametersGeneration Parameters    hierarchy ⇒ Expand the Packet Generation ArgumentsPacket Generation ArgumentsPacket Generation ArgumentsPacket Generation Arguments    

hierarchy ⇒ Change the value of the Interarrival TimeInterarrival TimeInterarrival TimeInterarrival Time    attribute to 
exponential(0.005) exponential(0.005) exponential(0.005) exponential(0.005) as shown. Make sure to check the Apply Apply Apply Apply Changes to Changes to Changes to Changes to 
Selected ObjectsSelected ObjectsSelected ObjectsSelected Objects    box before you Click OKOKOKOK.... 
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3. Select all nodes except node_0except node_0except node_0except node_0    and node_7 node_7 node_7 node_7 ⇒ Right-click on one of the 

selected nodes and select    Edit Edit Edit Edit AttributesAttributesAttributesAttributes.    ⇒ Change the value of the 
Interarrival TimeInterarrival TimeInterarrival TimeInterarrival Time    attribute to exponential(0.075) exponential(0.075) exponential(0.075) exponential(0.075) as in the previous step. Make 
sure to check the Apply Changes to Selected ObjectsApply Changes to Selected ObjectsApply Changes to Selected ObjectsApply Changes to Selected Objects    box before you Click OKOKOKOK 

4. Click anywhere in the workspace to unselect objects. 

5. Click on the Configure/Run SimulationConfigure/Run SimulationConfigure/Run SimulationConfigure/Run Simulation    button:  ⇒ Click on the AdvancedAdvancedAdvancedAdvanced 

tab in the Configure Simulation dialog box ⇒ Assign <your initials><your initials><your initials><your initials>_Token__Token__Token__Token_    
UnbalancedUnbalancedUnbalancedUnbalanced    to the Scalar file text field. 

6. Click OKOKOKOK and then save your project. 

2.4.7. Run the Simulation 

To run the simulation for both scenarios simultaneously: 

1. Go to the ScenariosScenariosScenariosScenarios menu. ⇒ Select Manage ScManage ScManage ScManage Scenariosenariosenariosenarios.... 

2. Change the values under the ResultsResultsResultsResults column to <collectcollectcollectcollect>    (or <recollectrecollectrecollectrecollect>) ) ) ) for 
both scenarios. Compare to the following figure. 

 

3. Click OKOKOKOK    to run the simulations. Depending on the speed of your processor, this 
may take several minutes to complete. 

4. After the simulation completes the 12 runs, 6 for each scenario, click CloseCloseCloseClose.... 
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5. Save your project. 

When you rerun the simulation, OPNET IT Guru will "appendappendappendappend" the new results to the 
results already in the scalar file. To avoid that, delete the scalar file before you start 
a new run. 

• Go to the FileFileFileFile menu ⇒ Select Model Files Model Files Model Files Model Files ⇒ De De De Dellllete Model Fiete Model Fiete Model Fiete Model Filllles es es es ⇒ From the list, 

choose other model types other model types other model types other model types ⇒ Select ( .os): Output Scalars .os): Output Scalars .os): Output Scalars .os): Output Scalars ⇒ Select the scalar 
file to be deleted; in this tab they are:    

o <your initials>_Token_<your initials>_Token_<your initials>_Token_<your initials>_Token_BalancedBalancedBalancedBalanced    and    

o <your initials><your initials><your initials><your initials>_Token_Unbalanced_Token_Unbalanced_Token_Unbalanced_Token_Unbalanced.    ⇒ Click CloseCloseCloseClose.    

2.4.8. View the Results 

To view and analyze the results. 

1. Select ViewViewViewView Resu Resu Resu Resultltltlts (Advanced) s (Advanced) s (Advanced) s (Advanced) from the ResultsResultsResultsResults menu. Now the Analysis Analysis Analysis Analysis 
Configuration Configuration Configuration Configuration tool is open. 

2. Recall that we saved the average results in two scalar files, one for each 
scenario. To load the scalar file for the BalancedBalancedBalancedBalanced    scenario, select Load Output Load Output Load Output Load Output 

Scalar FileScalar FileScalar FileScalar File    from the FileFileFileFile menu ⇒ Select <your initials>_Token_<your initials>_Token_<your initials>_Token_<your initials>_Token_BalancedBalancedBalancedBalanced    from 
the pop-up menu. 

3. Select Create Scalar PanelCreate Scalar PanelCreate Scalar PanelCreate Scalar Panel from the PanelsPanelsPanelsPanels menu ⇒ Select the scalar panel 
data as shown in the following dialog box: THTTHTTHTTHT for HorizontalHorizontalHorizontalHorizontal and UtilizationUtilizationUtilizationUtilization for 
VerticalVerticalVerticalVertical (Note: If any of the data is missing, make sure that you carried out steps 
2.c and 2.d in the Choose the Statistics section.) 

 

4. Click OKOKOKOK. 

5. To change the title of the graph, right-click on the graph area and choose Edit Edit Edit Edit 

Graph PropertiesGraph PropertiesGraph PropertiesGraph Properties. ⇒ Change the Custom TitleCustom TitleCustom TitleCustom Title to BalancedBalancedBalancedBalanced Utilization Utilization Utilization Utilization as 
shown. 
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6. Click OKOKOKOK. The resulting graph should resemble the one shown below. Do not 
close the graph and continue with the following step. 

 

7. To compare with the UnbalancedUnbalancedUnbalancedUnbalanced scenario, load its scalar file, select Load Load Load Load 

Output Scalar FileOutput Scalar FileOutput Scalar FileOutput Scalar File from the FileFileFileFile menu ⇒ Select <your initials><your initials><your initials><your initials>_Token_ _Token_ _Token_ _Token_ 
UnbalancedUnbalancedUnbalancedUnbalanced from the pop-up menu. 

8. Select CreCreCreCreate Scalar Panelate Scalar Panelate Scalar Panelate Scalar Panel from the PanelsPanelsPanelsPanels menu Select the scalar panel data 
as in step 3. 

9. Click OKOKOKOK ⇒ Change the graph title to UnbalancedUnbalancedUnbalancedUnbalanced as in step 5 ⇒ Click OKOKOKOK. The 
resulting graph should resemble the one shown below. Do not close this graph 
or the previous one and continue with the following step. 
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10. To combine the above two graphs on a single graph, select Create Vector PanelCreate Vector PanelCreate Vector PanelCreate Vector Panel 

from the PanelsPanelsPanelsPanels menu. ⇒ Click on the Display Panel GraphsDisplay Panel GraphsDisplay Panel GraphsDisplay Panel Graphs tab. ⇒ Select both 

BalancedBalancedBalancedBalanced and UnbalancedUnbalancedUnbalancedUnbalanced statistics. ⇒ Choose Overlaid StatisticsOverlaid StatisticsOverlaid StatisticsOverlaid Statistics from the 
drop-down menu in the right-bottom area of the dialog box as shown. 

 

11. Click ShowShowShowShow and the resulting graph should resemble the one shown below. 
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12. Repeat the same process to check the effect of the THTTHTTHTTHT on Traffic ReceivedTraffic ReceivedTraffic ReceivedTraffic Received for 
both scenarios. Assign the appropriate titles to the graphs. 

13. The resulting graph, which combines the Traffic ReceivedTraffic ReceivedTraffic ReceivedTraffic Received statistic for both the 
BalancedBalancedBalancedBalanced and UnbalancedUnbalancedUnbalancedUnbalanced scenarios, should resemble the following one: 

 

2.5. Further readings 

• OPNET Token Ring Model Description From the ProtocolsProtocolsProtocolsProtocols menu, select Token Token Token Token 

RingRingRingRing ⇒ Model Usage Guide. 
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2.6. Exercises 

1) Why does the utilization increase with higher THTTHTTHTTHT values? 

2) Create a duplicate scenario of the BalancedBalancedBalancedBalanced    scenario. Name the new scenario 
Q2_HalfLoadQ2_HalfLoadQ2_HalfLoadQ2_HalfLoad.    In the Q2_HalfLoad Q2_HalfLoad Q2_HalfLoad Q2_HalfLoad scenario, decrease the load into the network 
(i.e., load from all nodes in the network) by half and repeat the simulation. 
Compare the utilization and traffic received in the Q2_HaQ2_HaQ2_HaQ2_HalflflflfLoad Load Load Load scenario with 
those of the BalancedBalancedBalancedBalanced    scenario. 

Hints: 

• Decreasing the load from a node by half can be done by doubling the 
"Interarrival TimeInterarrival TimeInterarrival TimeInterarrival Time" of the node's Packet Generation ArgumentsPacket Generation ArgumentsPacket Generation ArgumentsPacket Generation Arguments....    

• Do not forget to assign a separate "scalar file" for the new scenario. 

3) Create a duplicate scenario of the BalancedBalancedBalancedBalanced scenario. Name the new scenario 
Q3_OneNodeQ3_OneNodeQ3_OneNodeQ3_OneNode. In the Q3_OneNodeQ3_OneNodeQ3_OneNodeQ3_OneNode scenario, reconfigure the network so that 
node_0node_0node_0node_0 generates a traffic load that is equivalent to the traffic load generated by 
all nodes in the BalancedBalancedBalancedBalanced scenario combined. The rest of the nodes, node_1node_1node_1node_1 to 
node_13node_13node_13node_13, generate no traffic. Compare the utilization and traffic received in 
Q3_OneNodeQ3_OneNodeQ3_OneNodeQ3_OneNode scenario with those of the BalancedBalancedBalancedBalanced scenario. 

Hints: 

• One way to configure a node so that it does not generate traffic is to set its 
Start TimeStart TimeStart TimeStart Time (it is one of the Traffic Generation ParametersTraffic Generation ParametersTraffic Generation ParametersTraffic Generation Parameters) to the special 
value NeverNeverNeverNever. 

• Do not forget to assign a separate "scalar file" for the new scenario. 

2.7. Lab Report 

Prepare a report that follows the guidelines explained in Lab 0. The report should 
include the answers to the above exercises as well as the graphs you generated 
from the simulation scenarios. Discuss the results you obtained and compare these 
results with your expectations. Mention any anomalies or unexplained behaviors. 
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3. Laboratory - Switched LANs (A Set of Local Area Networks 
Interconnected by Switches) 

3.1. Objective 

This lab is designed to demonstrate the implementation of switched local area 
networks. The simulation in this lab will help you examine the performance of 
different implementations of local area networks connected by switches and hubs. 

3.2. Overview 

There is a limit to how many hosts can be attached to a single network and to the 
size of a geographic area that a single network can serve. Computer networks use 
switches to enable the communication between one host and another, even when no 
direct connection exists between those hosts. A switch is a device with several 
inputs and outputs leading to and from the hosts that the switch interconnects. The 
core job of a switch is to take packets that arrive on an input and forward (or switch) 
them to the right output so that they will reach their appropriate destination. 

A key problem that a switch must deal with is the finite bandwidth of its outputs. If 
packets destined for a certain output arrive at a switch and their arrival rate exceeds 
the capacity of that output, then we have a problem of contention. In this case, the 
switch will queue, or buffer packets until the contention subsides. If the contention 
lasts too long, however, the switch will run out of buffer space and be forced to 
discard packets. When packets are discarded too frequently, the switch is said to be 
congested. 

In this lab you will set up switched LANs using two different switching devices: hubs 
and switches. A hub forwards the packet that arrives on any of its inputs on all the 
outputs regardless of the destination of the packet. On the other hand, a switch 
forwards incoming packets to one or more outputs depending on the destination(s) 
of the packets. You will study how the throughput and collision of packets in a 
switched network are affected by the configuration of the network and the types of 
switching devices that are used. 

3.3. Prelab Activities 

• Read section 3.1 from "Computer Networks: A Systems Approach""Computer Networks: A Systems Approach""Computer Networks: A Systems Approach""Computer Networks: A Systems Approach", , , , 4th EditionEditionEditionEdition....    

Go to www.netwww.netwww.netwww.net----seal.net/animations.phpseal.net/animations.phpseal.net/animations.phpseal.net/animations.php    and play the following animations: 
• Switch. 

• Switched Network With No Server. 

• Switched Network With Server. 

3.4. Procedure 

3.4.1. Create a New Project 

1. Start the OPNET IT Guru Academic Edition ⇒ Choose New from the File menu. 

2. Select Project and Click OK ⇒ Name the project <your initials><your initials><your initials><your initials>SwitchedLAN, 

and the scenario OnlyHub ⇒ Click OK. 

3. In the Startup Wizard: Initial Topology dialog box, make sure that Create Empty 

Scenario is selected. ⇒ Click Next ⇒ Choose Office from the Network Scale list 

⇒ Click Next three times ⇒ Click OK. 
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4. Close the Object Palette    dialog box. 

3.4.2. Create the Network 

To create our switched LAN: 

1. Select Topology ⇒ Rapid Configuration. From the drop-down menu choose 
Star and Click OK. 

2. Click the Select Models button in the Rapid Configuration dialog box. From the 
Model List drop-down menu choose ethernet and Click OK. 

3. In the Rapid Configuration dialog box, set the following five values: Center Node 
Model = ethernet16_hub, Periphery Node Model = ethernet_station, Link Model 

= 10BaseT, Number = 16, Y = 50, and Radius = 42 ⇒ Click OK. 

The prefix Ethernet16Ethernet16Ethernet16Ethernet16 indicates that the device support up to 16 Ethernet connections. 

 

The 10BaseT10BaseT10BaseT10BaseT link represents an Ethernet connection operating at 10 Mbps. 

1. Right-click on node_16, which is the hub ⇒ Edit Edit Edit Edit Attributes ⇒ Change the name 
attribute to Hub1 and Click OK. 

2. Now that you have created the network, it should look like the following one. 

3. Make sure to save your project. 
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3.4.3. Configure the Network Nodes 

Here you will configure the traffic generated by the stations. 

1. Right-click on any of the 16 stations (node_0 to node_15) ⇒ Select Similar 
Nodes. Now all stations in the network are selected. 

2. Right-click on any of the 16 stations ⇒ Edit Edit Edit Edit Attributes. 

a. Check the Apply Changes to Selected ObjectsApply Changes to Selected ObjectsApply Changes to Selected ObjectsApply Changes to Selected Objects check box. This is important 
to avoid reconfiguring each node individually. 

3. Expand the hierarchies of the Traffic Generation Parameters attribute and the 

Packet Generation Arguments attribute ⇒ Set the following four values: 

4. Click OK to close the attribute editing window(s). 

5. Save your project. 
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3.4.4. Choose Statistics 

To choose the statistics to be collected during the simulation: 

1. Right-click anywhere in the project workspace and select Choose Individual 
Statistics from the pop-up menu. 

2. In the Choose Results dialog box, choose the following four statistics: 

The Ethernet DelayEthernet DelayEthernet DelayEthernet Delay represents the end to end delay of all packets received by all the stations. 

Traffic ReceivedTraffic ReceivedTraffic ReceivedTraffic Received (in packets/sec) by the traffic sinks across all nodes.    

Traffic SentTraffic SentTraffic SentTraffic Sent (in packets/sec) by the traffic sources across all nodes. 

Collision CountCollision CountCollision CountCollision Count is the total number of collisions encountered by the hub during packet transmissions. 
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3. Click OK. 

3.4.5. Configure the Simulation 

Here we need to configure the duration of the simulation: 

1. Click on the Configure/Run Simulation    button:  

2. Set the duration to be 2.0 minutes. 

3. Click OK. 

3.4.6. Duplicate the Scenario 

The network we just created utilizes only one hub to connect the 16 stations. We 
need to create another network that utilizes a switch and see how this will affect the 
performance of the network. To do that we will create a duplicate of the current 
network: 

1. Select Duplicate ScenarioDuplicate ScenarioDuplicate ScenarioDuplicate Scenario from the ScenariosScenariosScenariosScenarios menu and give it the name 

HubAndSwitchHubAndSwitchHubAndSwitchHubAndSwitch ⇒ Click OKOKOKOK. 

2. Open the Object PaletteObject PaletteObject PaletteObject Palette by clicking on  Make sure that EthernetEthernetEthernetEthernet is selected 
in the pull-down menu on the object palette. 

3. We need to place the shown hub and switch in the new scenario. 
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4. To add the Hub, Hub, Hub, Hub, click its icon in the object palette ⇒ Move your mouse to the 

workspace ⇒ Click to drop the hub at a location you select. Right-click to 
indicate you are done deploying hub objects. 

5. Similarly, add the Switch Switch Switch Switch and then close the Object Palette.Object Palette.Object Palette.Object Palette. 

6. Right-click on the new hub ⇒ Edit Edit Edit Edit AttributesAttributesAttributesAttributes    ⇒ Change the namenamenamename attribute to 
Hub2Hub2Hub2Hub2 and Click OKOKOKOK. 

7. Right-click on the switch Edit Edit Edit Edit AttributesAttributesAttributesAttributes    ⇒ Change the namenamenamename attribute to Switch Switch Switch Switch 
and Click OKOKOKOK. 

8. Reconfigure the network of the HubAndSwitchHubAndSwitchHubAndSwitchHubAndSwitch    scenario so that it looks like the 
following one. 
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Hints: 

b. To remove a link, select it and choose Cut Cut Cut Cut from the EditEditEditEdit menu (or simply hit 
the Delete Delete Delete Delete key). You can select multiple links and delete all of them at once. 

c. To add a new link, use the 10BaseT10BaseT10BaseT10BaseT link available in the Object PaletteObject PaletteObject PaletteObject Palette. 

9. Save your project. 

3.4.7. Run the Simulation 

To run the simulation for both scenarios simultaneously: 

1. Select Manage ScenariosManage ScenariosManage ScenariosManage Scenarios from the ScenariosScenariosScenariosScenarios menu. 

2. Change the values under the ResultsResultsResultsResults column to <collectcollectcollectcollect> (or <recollectrecollectrecollectrecollect>) for 

both scenarios. Compare to the following figure. 

 

3. Click OKOKOKOK to run the two simulations. Depending on the speed of your processor, 
this may take several minutes to complete. 

4. After the two simulation runs complete, one for each scenario, click CloseCloseCloseClose. 

5. Save your project. 

3.4.8. View the Results 

To view and analyze the results: 

1. Select Compare ResultsCompare ResultsCompare ResultsCompare Results from the ResultsResultsResultsResults menu. 

2. Change the ddddrrrroooopppp----ddddown own own own menu in the lower-right part of the Compare Results 
dialog box from As IsAs IsAs IsAs Is to time_averagetime_averagetime_averagetime_average, as shown. 
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time_averagetime_averagetime_averagetime_average is the average value over time of the values generated during the collection windows. This average 
is performed assuming a “sample-and-hold” behavior of the data set (i.e., each value is weighted by the amount of 
time following update and the sum of all the weighted values is divided by the width of the collection window). For 
example, suppose you have a 1-second bucket in which 10 values have been generated. The first 7 values were 
generated between 0 and 0.3 seconds, the 8

th
 value at 0.4 seconds, the 9

th
 value at 0.6 seconds, and the 10

th
 at 

0.99 seconds. Because the last 3 values have higher durations, they are weighted more heavily in calculating the 
time averagetime averagetime averagetime average. 

3. Select the Traffic SentTraffic SentTraffic SentTraffic Sent (packets/sec) (packets/sec) (packets/sec) (packets/sec) statistic and click ShowShowShowShow. . . . The resulting 
graph should resemble the one below. As you can see, the traffic sent in both 
scenarios is almost identical. 

 

Select the Traffic ReceivedTraffic ReceivedTraffic ReceivedTraffic Received (packets/sec)  (packets/sec)  (packets/sec)  (packets/sec) statistic and click ShowShowShowShow. . . . The resulting 
graph should resemble the one below. As you see, the traffic received with the 
second scenario, HubAndSwitchHubAndSwitchHubAndSwitchHubAndSwitch, is higher than that of the OnlyHubOnlyHubOnlyHubOnlyHub    scenario. 
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4. Select the Delay (sec)Delay (sec)Delay (sec)Delay (sec) statistic and click ShowShowShowShow. The resulting graph should 
resemble the one below. (Note: Result may vary slightly due to different node 
placement.) 

 

5. Select the Collision CountCollision CountCollision CountCollision Count statistic for Hub1Hub1Hub1Hub1 and click ShowShowShowShow. 

6. On the resulting graph right-click anywhere on the graph area ⇒ Choose Add Add Add Add 

StatisticStatisticStatisticStatistic ⇒ Expand the hierarchies as shown below ⇒ Select the Collision Collision Collision Collision 

CountCountCountCount statistic for Hub2Hub2Hub2Hub2⇒ Change As As As As IsIsIsIs to time_averagetime_averagetime_averagetime_average ⇒ Click AddAddAddAdd. 
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7. The resulting graph should resemble the one below. 

 

8. Save your project. 

3.5. Further readings 

• OPNET Building Network Topologies: From the ProtocolsProtocolsProtocolsProtocols menu, select 

MethodologiesMethodologiesMethodologiesMethodologies ⇒⇒⇒⇒    Building Network Topologies....    

3.6. Exercises 

1) Explain why adding a switch makes the network perform better in terms of 
throughput and delay. 
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2) We analyzed the collision counts of the hubs. Can you analyze the collision 
count of the "Switch"? Explain your answer. 

3) Create two new scenarios. The first one is the same as the OnlyHubOnlyHubOnlyHubOnlyHub scenario 
but replace the hub with a switch. The second new scenario is the same as the 
HubAndSwitchHubAndSwitchHubAndSwitchHubAndSwitch scenario but replace both hubs with two switches, remove the 
old switch, and connect the two switches you just added together with a 
10BaseT10BaseT10BaseT10BaseT link. Compare the performance of the four scenarios in terms of delay, 
throughput, and collision count. Analyze the results. Note: To replace a hub with 
a switch, right-click on the hub and assign ethernet16_switchethernet16_switchethernet16_switchethernet16_switch to its modelmodelmodelmodel 
attribute. 

3.7. Lab Report 

Prepare a report that follows the guidelines explained in Lab 0. The report should 
include the answers to the above exercises as well as the graphs you generated 
from the simulation scenarios. Discuss the results you obtained and compare these 
results with your expectations. Mention any anomalies or unexplained behaviors. 
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4. Laboratory - Network Design (Planning a Network with Different Users, 
Hosts, and Services) 

4.1. Objective 

The objective of this lab is to demonstrate the basics of designing a network, taking 
into consideration the users, services, and locations of the hosts. 

4.2. Overview 

Optimizing the design of a network is a major issue. Simulations are usually used to 
analyze the conceptual design of the network. The initial conceptual design is 
usually refined several times until a final decision is made to implement the design. 
The objective is to have a design that maximizes the network performance, taking 
into consideration the cost constraints and the required services to be offered to 
different types of users. After the network has been implemented, network 
optimization should be performed periodically throughout the lifetime of the network 
to ensure maximum performance of the network and to monitor the utilization of the 
network resources. 

In this lab you will design a network for a company that has four departments: 
Research, Engineering, E-Commerce, and Sales. You will utilize a LAN model that 
allows you to simulate multiple clients and servers in one simulation object. This 
model dramatically reduces both the amount of configuration work you need to 
perform and the amount of memory needed to execute the simulation. You will be 
able to define a profile that specifies the pattern of applications employed by the 
users of each department in the company. By the end of this lab, you will be able to 
study how different design decisions can affect the performance of the network. 

4.3. Prelab Activities 

• Read section 3.2 from "Computer Networks: A Systems Approach""Computer Networks: A Systems Approach""Computer Networks: A Systems Approach""Computer Networks: A Systems Approach", , , , 4th EditionEditionEditionEdition....    

Go to www.netwww.netwww.netwww.net----seal.net/animations.phpseal.net/animations.phpseal.net/animations.phpseal.net/animations.php    and play the following animations: 
• Adding Switches. 

4.4. Procedure 

4.4.1. Create a New Project 

1. Start OPNET IT Guru Academic EditionOPNET IT Guru Academic EditionOPNET IT Guru Academic EditionOPNET IT Guru Academic Edition ⇒ Choose NewNewNewNew from the FileFileFileFile menu. 

2. Select ProjectProjectProjectProject and Click OKOKOKOK ⇒ Name the project <your initiaIs>_NetDesig<your initiaIs>_NetDesig<your initiaIs>_NetDesig<your initiaIs>_NetDesig, and 

the scenario SimpleNetworkSimpleNetworkSimpleNetworkSimpleNetwork ⇒ Click OKOKOKOK. 

3. In the Startup Wizard Initial Topology dialog box, make sure that Create Empty Create Empty Create Empty Create Empty 

ScenarioScenarioScenarioScenario is selected ⇒ Click NextNextNextNext ⇒ Choose CampusCampusCampusCampus from the Network Scale 
list ⇒ Click NextNextNextNext ⇒ Choose MilesMilesMilesMiles from the SizeSizeSizeSize drop-down menu and assign 1111 

for both X SpanX SpanX SpanX Span and Y SpanY SpanY SpanY Span ⇒ Click NextNextNextNext twice ⇒ Click OKOKOKOK. 
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4.4.2. Create and Configure the Network 

4.4.2.1. Initialize the Network: 

1. The Object Palette    dialog box should be now on the top of your project space. If 

it is not there, open it by clicking . Make sure that the internet_toolboxinternet_toolboxinternet_toolboxinternet_toolbox is 
selected from the pull-down menu on the object palette. 

2. Add to the project workspace the following objects from the palette: Application Application Application Application 
ConfigConfigConfigConfig,,,,    Profile ConfigProfile ConfigProfile ConfigProfile Config, , , , and a subnetsubnetsubnetsubnet. 

a. To add an object from palette, click its icon on the object palette. ⇒ Move 

your mouse to the workspace. ⇒ Left click to place the object. Right-click 
when finished. The workplace should contain the following three objects: 

 

3. Close the Object Palette    dialog box and save your project. 

Application ConfigApplication ConfigApplication ConfigApplication Config is used to specify application that will be used to configure user’s profiles. 

Profile ConfigProfile ConfigProfile ConfigProfile Config describes the activity    patterns of a user or group of users in terms of the applications used over a 
period of time. You must define the applications using the Application ConfigApplication ConfigApplication ConfigApplication Config    object between using this object    

4.4.2.2. Configure the Services: 

1. Right-click on the Application ConfigApplication ConfigApplication ConfigApplication Config    node ⇒ Edit Edit Edit Edit AttributesAttributesAttributesAttributes    Change the namenamenamename 

attribute to Applications Applications Applications Applications ⇒ Change the Application DefinitionsApplication DefinitionsApplication DefinitionsApplication Definitions    attribute to 

DefaultDefaultDefaultDefault    ⇒ Click OKOKOKOK. 

2. Right-click on the Profile ConfigProfile ConfigProfile ConfigProfile Config node node node node ⇒ Edit Edit Edit Edit AttributesAttributesAttributesAttributes ⇒ Change the namenamenamename 

attribute to ProfilesProfilesProfilesProfiles ⇒ Change the Profile ConfigurationProfile ConfigurationProfile ConfigurationProfile Configuration attribute to Sample Sample Sample Sample 

ProfilesProfilesProfilesProfiles ⇒ Click OKOKOKOK. 

3. Sample ProfilesSample ProfilesSample ProfilesSample Profiles provides patterns of applications employed by users such as 
engineers, researchers, salespeople, and multimedia users. 

4.4.2.3. Configure a Subnet: 

1. Right-click on the subnet subnet subnet subnet node ⇒ Edit Edit Edit Edit AttributesAttributesAttributesAttributes    ⇒ Change the namenamenamename attribute 
to Engineering Engineering Engineering Engineering and Click OKOKOKOK. 

2. Double-click on the Engineering Engineering Engineering Engineering node. You get an empty workspace, indicating 
that the subnet contains no objects. 

3. Open the object palette  and make sure it is still set to internet_toolboxinternet_toolboxinternet_toolboxinternet_toolbox. 

4. Add the following items to the subnet workspace: 10BaseT LAN10BaseT LAN10BaseT LAN10BaseT LAN, 

ethernet16ethernet16ethernet16ethernet16____SwitchSwitchSwitchSwitch, and a 10BaseT10BaseT10BaseT10BaseT link to connect the LAN with the Switch ⇒ 
Close the palette. 
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5. Right-click on the 10BaseT LAN10BaseT LAN10BaseT LAN10BaseT LAN node ⇒ Edit Edit Edit Edit AttributesAttributesAttributesAttributes ⇒ Change the namenamenamename 
attribute to LAN Observe that the Number of WorkstationsNumber of WorkstationsNumber of WorkstationsNumber of Workstations attribute has a value 
of 10 Click in the ValueValueValueValue column for the Application: Supported ProfilesApplication: Supported ProfilesApplication: Supported ProfilesApplication: Supported Profiles attribute, 
and select Edit Edit Edit Edit. You should get a table in which you should do the following: 

a. Set the number of rows rows rows rows to 1.1.1.1.    

b. Set the Profile NameProfile NameProfile NameProfile Name    to Engineer. Engineer. Engineer. Engineer. Note: Engineer Engineer Engineer Engineer is one of the "sample" 
profiles provided within the Profile ConfigProfile ConfigProfile ConfigProfile Config    object. 

c. Click OKOKOKOK    twice. 

The object we just created is equivalent to a 10-workstation star topology LAN. 
The traffic generated from the users of this LAN resembles that generated by 
"engineers." 

6. Rename the ethernet16_ethernet16_ethernet16_ethernet16_SwitchSwitchSwitchSwitch to SwitchSwitchSwitchSwitch. 

7. The subnet should look like the shown one. 

8. Save your project. 

 

4.4.2.4. Configure All Departments: 

1. Now you have completed the configuration of the Engineering department 
subnet. To go back to the main project space, click the Go to the higher levelGo to the higher levelGo to the higher levelGo to the higher level    

 button. 

The subnets of the other departments in the company should be similar to the 
engineering one except for the supported profiles. 

2. Make three copies of the Engineering Engineering Engineering Engineering subnet we just created: Click on the 

Engineering Engineering Engineering Engineering node ⇒ From the EditEditEditEdit menu, select CopyCopyCopyCopy....    From the EditEditEditEdit menu, 
select PastePastePastePaste    three times, placing the subnet in the workspace after each, to 
create the new subnets. 

3. Rename (right-click on the subnet and select Set NameNameNameName) ) ) ) and arrange the 
subnets as shown bellow: 
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4. Double-click the Research Research Research Research node ⇒ Edit Edit Edit Edit the attributes of its LANLANLANLAN ⇒    Edit Edit Edit Edit the 

value of the Application: Supported ProfiApplication: Supported ProfiApplication: Supported ProfiApplication: Supported Profilesleslesles    attribute. ⇒ Change the value of the 

Profile NameProfile NameProfile NameProfile Name    from Engineer Engineer Engineer Engineer to Researcher Researcher Researcher Researcher ⇒ Click OKOKOKOK    twice ⇒ Go to the Go to the Go to the Go to the 

higher levelhigher levelhigher levelhigher level by clicking the  button. 

5. Repeat step 4 with the SaSaSaSalllles es es es node and assign to its Profile NameProfile NameProfile NameProfile Name    the profile 
Sales PersSales PersSales PersSales Person.on.on.on. 

6. Repeat step 4 with the EEEE----ccccommerce ommerce ommerce ommerce node and assign to its Profile NameProfile NameProfile NameProfile Name    the 
profile EEEE----ccccommerce Customer.ommerce Customer.ommerce Customer.ommerce Customer. 

7. Save your project. 

4.4.2.5. Configure the Servers: 

Now we need to implement a subnet that contains the servers. The servers have to 
support the applications defined in the profiles we deployed. You can double-check 
those applications by editing the attributes of our Profile Profile Profile Profile node. Inspect each row 
under the Applications Applications Applications Applications hierarchy, which in turn, is under the Profile ConfigurationProfile ConfigurationProfile ConfigurationProfile Configuration    
hierarchy. You will see that we need servers that support the following applications: 
Web browsing, Email, Telnet, File Transfer, Database, and File Print. 

1. Open the Object PaletteObject PaletteObject PaletteObject Palette  and add a new subnetsubnetsubnetsubnet ⇒ Rename the new subnet 

to ServersServersServersServers ⇒ Double-click the ServersServersServersServers node to enter its workspace. 

2. From the Object Palette, Object Palette, Object Palette, Object Palette, add three ethernet_serverethernet_serverethernet_serverethernet_servers, s, s, s, one ethernet16_switchethernet16_switchethernet16_switchethernet16_switch    
and three 10BaseT10BaseT10BaseT10BaseT links to connect the servers with the switch. 

3. Close the Object PaletteObject PaletteObject PaletteObject Palette.... 

4. Rename the servers and the switch as follows: 
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5. Right-click on each one of the above servers and Edit Edit Edit Edit the value of the 
Application: Application: Application: Application: Supported ServicesSupported ServicesSupported ServicesSupported Services    attribute. 

i. For the Web Server    add four rows to support the following services: WebWebWebWeb    
Browsing (Light HTTP1.1) Web Browsing (Heavy HTTP1.1), EmailBrowsing (Light HTTP1.1) Web Browsing (Heavy HTTP1.1), EmailBrowsing (Light HTTP1.1) Web Browsing (Heavy HTTP1.1), EmailBrowsing (Light HTTP1.1) Web Browsing (Heavy HTTP1.1), Email    (Light), (Light), (Light), (Light), 
and Telnet SessTelnet SessTelnet SessTelnet Session (Light)ion (Light)ion (Light)ion (Light).    

ii. For the File Server    add two rows to support the following services: FileFileFileFile    
Transfer (Light) Transfer (Light) Transfer (Light) Transfer (Light) and File Print (Light)File Print (Light)File Print (Light)File Print (Light).    

iii. For the Database Server add one row to support the following service: 
Database Access (Light)Database Access (Light)Database Access (Light)Database Access (Light).    

6. Go back to the project space by clicking the Go to the higher levelGo to the higher levelGo to the higher levelGo to the higher level  button. 

7. Save your project. 

4.4.2.6. Connect the Subnets: 

Now all subnets are ready to be connected together. 

1. Open the Object PaletteObject PaletteObject PaletteObject Palette     and add four 100BaseT100BaseT100BaseT100BaseT links to connect the 
subnets of the departments to the Servers subnet. 

As you create each link, make sure that it is configured to connect the "switches" 
in both subnets to each other. Do this by choosing them from the drop-down 
menus as follows: 

 

2. Close the Object PaletteObject PaletteObject PaletteObject Palette. 

3. Now your network should resemble the following one: 
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4. Save your project. 

4.4.2.7. Choose the Statistics 

To test the performance of our network we will collect one of the many available 
statistics as follows: 

1. Right-click anywhere in the project workspace and select ChooseChooseChooseChoose Individual  Individual  Individual  Individual 
StatisticsStatisticsStatisticsStatistics    from the pop-up menu. 

2. In the Choose Results dialog box, choose the following statistic: 

 

PagePagePagePage Response TimeResponse TimeResponse TimeResponse Time is the required time to retrieve the entire page. 

3. Click OKOKOKOK. 
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4.4.3. Configure the Simulation 

Here we need to configure the duration of the simulation: 

1. Click on the Configure/Run SimulationConfigure/Run SimulationConfigure/Run SimulationConfigure/Run Simulation  button. 

2. Set the duration to be 30.0 minutes30.0 minutes30.0 minutes30.0 minutes. 

3. Press OKOKOKOK.... 

4.4.4. Duplicate the Scenario 

In the network we just created we assumed that there is no background traffic 
already in the links. In real networks, the links usually have some existing 
background traffic. We will create a duplicate of the SimpleNetworkSimpleNetworkSimpleNetworkSimpleNetwork scenario but 
with background utilization in the 100BaseT100BaseT100BaseT100BaseT links. 

1. Select Duplicate ScenarioDuplicate ScenarioDuplicate ScenarioDuplicate Scenario    from the ScenariosScenariosScenariosScenarios menu and give it the name 

BusyNetworkBusyNetworkBusyNetworkBusyNetwork    ⇒ Click OKOKOKOK. 

2. Select all the 100BaseT100BaseT100BaseT100BaseT    links simultaneously (click on all of them while holding 

the ShiftShiftShiftShift key) ⇒ Right-click on anyone of them ⇒ Edit Edit Edit Edit AttributesAttributesAttributesAttributes    ⇒    Check the 
Apply Changes to Selected ObjectsApply Changes to Selected ObjectsApply Changes to Selected ObjectsApply Changes to Selected Objects    check box. 

3. Expand the hierarchy of the Background UtilizationBackground UtilizationBackground UtilizationBackground Utilization attribute ⇒ Expand the row row row row 

0000 hierarchy ⇒ Assign 99999999 to the background utilization (%)background utilization (%)background utilization (%)background utilization (%) as shown below. 

 

4. Click OKOKOKOK. 

Link utilization is the percentage of the used link bandwidth. 

4.4.5. Run the Simulation 

To run the simulation for both scenarios simultaneously: 

1. Go to the ScenariosScenariosScenariosScenarios menu ⇒ Select Manage ScenariosManage ScenariosManage ScenariosManage Scenarios.... 

2. Change the values under the ResultsResultsResultsResults column to <collectcollectcollectcollect> (or <recollectrecollectrecollectrecollect>) for 

both scenarios. Compare to the following figure. 
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3. Click OKOKOKOK to run the two simulations. Depending on the speed of your processor, 
this may take several seconds to complete. 

4. After the two simulation runs complete (one for each scenario), click CloseCloseCloseClose. 

5. Save your project. 

4.4.6. View the Results 

To view and analyze the results: 

1. Select Compare ResultsCompare ResultsCompare ResultsCompare Results    from the ResultsResultsResultsResults menu. 

2. Change the drop-down menu in the lower-right part of the Compare Results 
dialog box from As IsAs IsAs IsAs Is    to time_averagetime_averagetime_averagetime_average    as shown. 

 

3. Select the Page Response Time (seconds)Page Response Time (seconds)Page Response Time (seconds)Page Response Time (seconds) statistic and click ShowShowShowShow. The 
resulting graph should resemble the one below. (Note: Results may vary slightly 
due to different node placement.) 
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4.5. Further readings 

• OPNET Configuring Applications and Profiles: From the ProtocolsProtocolsProtocolsProtocols menu, select 

Applications Applications Applications Applications ⇒    Model Usage GuideModel Usage GuideModel Usage GuideModel Usage Guide    ⇒ Configuring Applications and Profiles....    

4.6. Exercises 

1) Analyze the result we obtained regarding the HTTP page response time. Collect 
four other statistics, of your choice, and rerun the simulation of the Simple    and 
the Busy    network scenarios. Get the graphs that compare the collected 
statistics. Comment on these results. 

2) In the BusyNetworkBusyNetworkBusyNetworkBusyNetwork scenario, study the utilization%utilization%utilization%utilization% of the CPUs in the servers 

(Right-click on each server and select Choose Individual StatisticsChoose Individual StatisticsChoose Individual StatisticsChoose Individual Statistics ⇒ CPUCPUCPUCPU ⇒ 
UtilizationUtilizationUtilizationUtilization). 

3) Create a new scenario as a duplicate of the BusyNetworkBusyNetworkBusyNetworkBusyNetwork scenario. Name the 
new scenario Q3_OneServerQ3_OneServerQ3_OneServerQ3_OneServer. Replace the three servers with only one server 
that supports all required services. Study the utilization%utilization%utilization%utilization% of that server's CPU. 
Compare this utilization with the three CPU utilizations you obtained in the 
previous exercise. 

4) Create a new scenario as a duplicate of the BusyNetworkBusyNetworkBusyNetworkBusyNetwork scenario. Name the 
new scenario Q4_FasterNetworkQ4_FasterNetworkQ4_FasterNetworkQ4_FasterNetwork. In the Q4_FasterNetworkQ4_FasterNetworkQ4_FasterNetworkQ4_FasterNetwork scenario, replace 
all 100BaseT100BaseT100BaseT100BaseT links in the network with 10Gbps Ethernet10Gbps Ethernet10Gbps Ethernet10Gbps Ethernet links and replace all 
10BaseT10BaseT10BaseT10BaseT links with 100BaseT100BaseT100BaseT100BaseT links. Study how increasing the bandwidth of the 
links affects the performance of the network in the new scenario (e.g., compare 
the HTTP page response time in the new scenario with that of the 
BusyNetworkBusyNetworkBusyNetworkBusyNetwork). 

4.7. Lab Report 

Prepare a report that follows the guidelines explained in Lab 0. The report should 
include the answers to the above exercises as well as the graphs you generated 
from the simulation scenarios. Discuss the results you obtained and compare these 
results with your expectations. Mention any anomalies or unexplained behaviors. 
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5. Laboratory - ATM (A Connection-Oriented, Cell-Switching Technology) 

5.1. Objective 

The objective of this lab is to examine the effect of ATM adaptation layers and 
service classes on the performance of the network. 

5.2. Overview 

Asynchronous Transfer Mode (ATM) is a connection-oriented, packet-switched 
technology. The packets that are switched in an ATM network are of a fixed length, 
53 bytes, and are called cells.cells.cells.cells.    The cell size has a particular effect on carrying voice 
traffic effectively. The ATM Adaptation Layer (AAL) sits between ATM and the 
variable-length packet protocols that might use ATM, such as IP. The AAL header 
contains the information needed by the destination to reassemble the individual 
cells back into the original message. Because ATM was designed to support all 
sorts of services, including voice, video, and data, it was felt that different services 
would have different AAL needs. AAL1 and AAL2 were designed to support 
applications, like voice, that require guaranteed bit rates. AAL3/4 and AAL5 provide 
support for packet data running over ATM. 

ATM provides QoS capabilities through its five service classes: CBR, VBR-rt 
VBR-nrt, ABR, and UBR. With CBR (constant bit rate), sources transmit stream 
traffic at a fixed rate. CBR is well-suited for voice traffic that usually requires circuit 
switching. Therefore, CBR is very important to telephone companies. UBR, 
unspecified bit rate, is ATM's best-effort service. There is one small difference 
between UBR and the best-effort model. Because ATM always requires a signaling 
phase before data is sent, UBR allows the source to specify a maximum rate at 
which it will send. Switches may make use of this information to decide whether to 
admit or reject the new VC (virtual circuit). 

In this lab you will set up an ATM network that carries three applications: Voice, 
Email, and FTP. You will study how the choice of the adaptation layer as well as the 
service classes can affect the performance of the applications. 

5.3. Prelab Activities 

• Read section 3.3 from "Computer Networks: A Systems Approach""Computer Networks: A Systems Approach""Computer Networks: A Systems Approach""Computer Networks: A Systems Approach", , , , 4th EditionEditionEditionEdition.... 

5.4. Procedure 

5.4.1. Create a New Project 

1. Start OPNET IT Guru Academic EditionOPNET IT Guru Academic EditionOPNET IT Guru Academic EditionOPNET IT Guru Academic Edition    ⇒ Choose NewNewNewNew    from the FileFileFileFile menu. 

2. Select ProjectProjectProjectProject and Click OKOKOKOK ⇒ Name the project <your <your <your <your initials>initials>initials>initials>_ATM_ATM_ATM_ATM, and the 

scenario CBR_UBRCBR_UBRCBR_UBRCBR_UBR ⇒ Click OKOKOKOK. 

3. In the Startup Wizard: Initial Topology dialog box, make sure that Create Empty Create Empty Create Empty Create Empty 

ScenarioScenarioScenarioScenario is selected ⇒ Click NextNextNextNext ⇒ Select Choose From MapsChoose From MapsChoose From MapsChoose From Maps from the 

Network Scale list ⇒ Click NextNextNextNext ⇒ Choose USAUSAUSAUSA from the maps ⇒ Click NextNextNextNext ⇒ 
From the Select Technologies list, include the atm_advatm_advatm_advatm_advancedancedancedanced Model Family as 

shown in the following figure ⇒ Click NextNextNextNext ⇒ Click OKOKOKOK. 
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5.4.2. Create and Configure the Network 

5.4.3. Initialize the Network: 

1. The Object Palette    dialog box should now be on the top of your project 

workspace. If it is not there, open it by clicking . Make sure that 
atm_advatm_advatm_advatm_advancedancedancedanced    is selected from the pull-down menu on the object palette. 

2. Add to the project work space the following objects from the palette: ApApApApplication plication plication plication 
ConfigConfigConfigConfig, Profile ConfigProfile ConfigProfile ConfigProfile Config, two atm8_crossconn_advatm8_crossconn_advatm8_crossconn_advatm8_crossconn_adv switches, and a subnetsubnetsubnetsubnet. 

b. To add an object from a palette, click its icon in the object palette ⇒ Move 

your mouse to the workspace and click to place the object ⇒ Right-click to 
get out of "object creation mode." 

3. Close the Object Palette    dialog box and rename (right-click on the node ⇒ Set 
NameNameNameName) the objects you added as shown and then save your project: 

 

5.4.3.1. Configure the Applications: 

1. Right-click on the ApplicationsApplicationsApplicationsApplications node ⇒ Edit Edit Edit Edit AttributesAttributesAttributesAttributes    Expand the AppliAppliAppliApplication cation cation cation 

DefinitionsDefinitionsDefinitionsDefinitions    attribute and set rowsrowsrowsrows to 3333 ⇒ Name the rows: FTP, EMAIL, FTP, EMAIL, FTP, EMAIL, FTP, EMAIL, and 
VOICEVOICEVOICEVOICE. 

i. Go to the FTP FTP FTP FTP row ⇒ Expand the DescriptionDescriptionDescriptionDescription hierarchy ⇒ Assign High High High High 
Load Load Load Load to FTPFTPFTPFTP. 
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ii. Go to the EMAIL EMAIL EMAIL EMAIL row ⇒ Expand the DescriptionDescriptionDescriptionDescription hierarchy ⇒ Assign HighHighHighHigh    
Load Load Load Load to Email. 

iii. Go to the VOICE VOICE VOICE VOICE row ⇒ Expand the DescriptionDescriptionDescriptionDescription hierarchy ⇒ Assign PCM PCM PCM PCM 
Quality SpeechQuality SpeechQuality SpeechQuality Speech    to VoiceVoiceVoiceVoice. 

 

2. Click OKOKOKOK    and then save your project 

PCMPCMPCMPCM stands for Pulse Code Modulation. It is a procedure used to digitize speech before transmitting it over the 
network. 

5.4.3.2. Configure the Profiles: 

1. Right-click on the ProfilesProfilesProfilesProfiles node ⇒ Edit Edit Edit Edit AttributesAttributesAttributesAttributes, Expand the Profile Profile Profile Profile 
ConfigurationConfigurationConfigurationConfiguration attribute and set rowsrowsrowsrows to 3333. 

i. Name and set the attributes of row 0row 0row 0row 0 as shown: 
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ii. Name and set the attributes of row 1 as shown: 

 

iii. Name and set the attributes of row 2 as shown. (Note: To set the DurationDurationDurationDuration to 
exponential(60)exponential(60)exponential(60)exponential(60), you will need to assign "Not UsedNot UsedNot UsedNot Used" to the "Special ValueSpecial ValueSpecial ValueSpecial Value") 

⇒ Close the Object Palette    dialog box. 
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5.4.3.3. Configure the NorthEast Subnet: 

1. Double-click on the NorthNorthNorthNorthEastEastEastEast subnet node. You get an empty workspace, 
indicating that the subnet contains no objects. 

2. Open the object palette  and make sure that atm_advatm_advatm_advatm_advancedancedancedanced is selected from 
the pull-down menu on the object palette … 

3. Add the following items to the subnet workspace one atm8catm8catm8catm8crossconn_advrossconn_advrossconn_advrossconn_adv 
switch one atm_uni_server_advatm_uni_server_advatm_uni_server_advatm_uni_server_adv, four atm_uni_client_advatm_uni_client_advatm_uni_client_advatm_uni_client_adv, and connect them 

with bidirectional atm_advatm_advatm_advatm_adv links ⇒ Close the palette ⇒ Rename the objects as 
shown. 

 

Hint: To edit the attributes of multiple of multiple nodes in the single operation, select all nodes simultaneously 
using shift and left-click, then Edit Edit Edit Edit AttributesAttributesAttributesAttributes of one of the nodes, and select Apply Changes to Selected ObjectsApply Changes to Selected ObjectsApply Changes to Selected ObjectsApply Changes to Selected Objects. 

4. Change the data ratedata ratedata ratedata rate attribute for all links to DS1DS1DS1DS1. 

5. For both NE_Voice1NE_Voice1NE_Voice1NE_Voice1 and NE_Voice2NE_Voice2NE_Voice2NE_Voice2, set the following attributes: 

i. Set ATM Application ParametersATM Application ParametersATM Application ParametersATM Application Parameters to CBRCBRCBRCBR only. 
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ii. Expand the ATM ParametersATM ParametersATM ParametersATM Parameters hierarchy ⇒ Set Queue ConfigurationQueue ConfigurationQueue ConfigurationQueue Configuration to CBRCBRCBRCBR 
only. 

iii. Expand the Application: Supported ProfilesApplication: Supported ProfilesApplication: Supported ProfilesApplication: Supported Profiles hierarchy ⇒ Set rowsrowsrowsrows to 1111 ⇒ 

Expand the row 0row 0row 0row 0 hierarchy ⇒ Set Profile NameProfile NameProfile NameProfile Name to VOICE_VOICE_VOICE_VOICE_PPPP. 

iv. Application: Application: Application: Application: Supported ServicesSupported ServicesSupported ServicesSupported Services ⇒ EditEditEditEdit its value ⇒ Set rowsrowsrowsrows to 1111 ⇒ Set 

NameNameNameName of the added row to VOICEVOICEVOICEVOICE ⇒ Click OKOKOKOK. 

v. Expand the Application: Transport ProtocolApplication: Transport ProtocolApplication: Transport ProtocolApplication: Transport Protocol hierarchy ⇒ Voice Transport = Voice Transport = Voice Transport = Voice Transport = 
AAL2AAL2AAL2AAL2. 

Client AddressClient AddressClient AddressClient Address is the Transport Adaptation Layer (TPAL) address of the node. This value must be unique for each 
node. The TPAL modelTPAL modelTPAL modelTPAL model suite presents a basic, uniform interface between applications and transport layer models. 
All interactions with a remote application through TPAL are organized into session. A session is a single 
conversation between two applications through a transport protocol. 

6. For NE_Voice1NE_Voice1NE_Voice1NE_Voice1, select    Edit Edit Edit Edit AttributesAttributesAttributesAttributes ⇒ Edit the value of the Client AddressClient AddressClient AddressClient Address 
attribute and write down NE_Voice1NE_Voice1NE_Voice1NE_Voice1. 

7. For NE_Voice2NE_Voice2NE_Voice2NE_Voice2, select    Edit Edit Edit Edit AttributesAttributesAttributesAttributes ⇒ Edit the value of the Client AddressClient AddressClient AddressClient Address 
attribute and write down NE_Voice2NE_Voice2NE_Voice2NE_Voice2. 

8. Configure the NE_DataServerNE_DataServerNE_DataServerNE_DataServer as follows: 

i. Application: Application: Application: Application: Supported ServicesSupported ServicesSupported ServicesSupported Services ⇒ EditEditEditEdit its value ⇒ Set rowsrowsrowsrows to 2222 ⇒ Set 

NameNameNameName of the added rows to: EMAILEMAILEMAILEMAIL and FTPFTPFTPFTP ⇒ Click OKOKOKOK. 

ii. Expand the Application: Transport ProApplication: Transport ProApplication: Transport ProApplication: Transport Protocoltocoltocoltocol Specification Specification Specification Specification hierarchy ⇒ Voice Voice Voice Voice 
Transport = AAL2Transport = AAL2Transport = AAL2Transport = AAL2. 

iii. Edit the value of the Server AddressServer AddressServer AddressServer Address attribute and write down NE NE NE NE 
DataServerDataServerDataServerDataServer. 

The queue configurationqueue configurationqueue configurationqueue configuration specifies a one-to-one mapping between output port queues and the QoS that they 
support. A specific queue may be configured to support a specific QoS. 

9. For both NE_Data1NE_Data1NE_Data1NE_Data1 and NE_Data2NE_Data2NE_Data2NE_Data2, set the following attributes: 

i. Expand the ATM ParametersATM ParametersATM ParametersATM Parameters hierarchy ⇒⇒⇒⇒ Set Queue ConfigurationQueue ConfigurationQueue ConfigurationQueue Configuration to 
UBRUBRUBRUBR. 

ii. Expand the Application: Supported ProfilesApplication: Supported ProfilesApplication: Supported ProfilesApplication: Supported Profiles hierarchy ⇒⇒⇒⇒ Set rowsrowsrowsrows to 2 2 2 2 ⇒⇒⇒⇒    
Set Profile NameProfile NameProfile NameProfile Name to FTP_PFTP_PFTP_PFTP_P (for row 0row 0row 0row 0) and to EMAIL_PEMAIL_PEMAIL_PEMAIL_P (for row 1row 1row 1row 1). 

10. For NE_Data1NE_Data1NE_Data1NE_Data1, select    Edit Edit Edit Edit AttributesAttributesAttributesAttributes ⇒ Edit the value of the Client AddressClient AddressClient AddressClient Address 
attribute and write down NE_Data1NE_Data1NE_Data1NE_Data1. 

11. For NE_Data2NE_Data2NE_Data2NE_Data2 select    Edit Edit Edit Edit AttributesAttributesAttributesAttributes ⇒ Edit the value of the Client AddressClient AddressClient AddressClient Address 
attribute and write down NE_Data2NE_Data2NE_Data2NE_Data2. 

12. Save your project. 

5.4.3.4. Add Remaining Subnets: 

1. Now you completed the configuration of the NorthEast subnet. To go back to the 

project space, click the Go to the higher levelGo to the higher levelGo to the higher levelGo to the higher level  button. 

The subnets of the other regions should be similar to the NorthEast one except for 
the names and server addressserver addressserver addressserver addresses. 

2. Make three copies of the subnet we just created. 

3. Rename (right-click on the node ⇒ Set NameNameNameName) the subnets and connect them to 
the switches with bidirectional atm_advatm_advatm_advatm_adv links as shown. (Note: You will be asked 
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to pick the node inside the subnet to be connected to the link. Make sure to 
choose the "switch" inside each subnet to be connected.) 

 

4. Change the data ratedata ratedata ratedata rate for all links to DS1DS1DS1DS1. 

5. Select and double-click each of the new subnets (total four subnets) and 
change the namesnamesnamesnames, server addressserver addressserver addressserver address, and server addressserver addressserver addressserver address of the nodes inside 
these subnets as appropriate (e.g., replace NE with SW for the SouthWest 
subnet). 

Hint: To do step 6, you can right-click on any voice station and choice Edit Similar NodesEdit Similar NodesEdit Similar NodesEdit Similar Nodes. This brings up a table in 
which each node occupies one row and attributes are shown in the columns. Follow the same procedure with 
similar steps in this lab. 

6. For all voicevoicevoicevoice stations in all subnets (total of eight stations), edit the value of the 
Application: Destination PreferencesApplication: Destination PreferencesApplication: Destination PreferencesApplication: Destination Preferences attribute as follows: 

i. Set rowsrowsrowsrows to 1111 ⇒ Set Symbolic NameSymbolic NameSymbolic NameSymbolic Name to VoiceVoiceVoiceVoice Destination  Destination  Destination  Destination ⇒ Click on (…) 

under the Actual Name Actual Name Actual Name Actual Name column ⇒ Set rowsrowsrowsrows to 6666 ⇒ For each row choose a 
voice station that is not in the current subnet. The following figure shows the 
actual names for one of the voicevoicevoicevoice stations in the NorthEast    subnet: 

 

7. For all datadatadatadata stations in all subnets (total of eight stations), configure the 
Application: Destination PreferencesApplication: Destination PreferencesApplication: Destination PreferencesApplication: Destination Preferences attribute as follows: 

ii. Set rowsrowsrowsrows to 2222 ⇒ Set Symbolic NameSymbolic NameSymbolic NameSymbolic Name to FTP ServerFTP ServerFTP ServerFTP Server for the one row and 

Email Server Email Server Email Server Email Server for the other row ⇒ For each symbolic name (i.e., FTP ServerFTP ServerFTP ServerFTP Server 
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and Email Server), click on (.) under the Actual Name Actual Name Actual Name Actual Name column ⇒ Set rowsrowsrowsrows to 

3333 ⇒ For each row choose a data server that is not in the current subnet The 
following figure shows the actual names for one of the datadatadatadata stations in the 
NorthEast    subnet: 

 

Hint: To do step 8 in a single operation, you can use the right-click menu on any switch to Select Similar NodesSelect Similar NodesSelect Similar NodesSelect Similar Nodes, 
then Edit Edit Edit Edit AttribuAttribuAttribuAttributestestestes, and check Apply Changes to Selected ObjectsApply Changes to Selected ObjectsApply Changes to Selected ObjectsApply Changes to Selected Objects. This feature does work, even across objects 
in different subnets. 

8. For all switchesswitchesswitchesswitches in the network (total of six switches) configure the 
Max_Avail_BWMax_Avail_BWMax_Avail_BWMax_Avail_BW of the CBR queue to be 100%, as shown bellow, and the 
MinMinMinMin_Guaran_BW_Guaran_BW_Guaran_BW_Guaran_BW to be 20%. 

 

Max_Avail_BWMax_Avail_BWMax_Avail_BWMax_Avail_BW is the maximum bandwidth allocated to this queue. Calls will be admitted into this queue only if 
they are within the maximum available bandwidth requirement. 

9. Save your project. 

5.4.4. Choose the Statistics 

To test the performance of the applications defined in the network, we will collect 
some of the available statistics as follows: 

1. Right-click anywhere in the project workspace and select Choose Individual Choose Individual Choose Individual Choose Individual 
StatisticsStatisticsStatisticsStatistics from the pop-up menu. 
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2. In the Choose Results dialog box, choose the following statistics: 

 

3. Click OKOKOKOK. 

5.4.5. Configure the Simulation 

Here we need to configure the duration of the simulation: 

1. Click on the Configure/Run SimulationConfigure/Run SimulationConfigure/Run SimulationConfigure/Run Simulation    button: . 

2. Set the duration to be 10.0 minutes10.0 minutes10.0 minutes10.0 minutes. 

3. Click OKOKOKOK. We will be running the simulation later. 

5.4.6. Duplicate the Scenario 

In the network we just created, we used the CBR service class for the Voice 
application and the UBR service class for the FTP and Email applications. To 
analyze the effect of such different classes of services, we will create another 
scenario that is similar to the CBR_UBRCBR_UBRCBR_UBRCBR_UBR scenario we just created but it uses only 
one class of service, UBR, for all applications. In addition, to test the effect of the 
ATM adaptation layer, in the new scenario we will use AAL5 for the Voice 
application rather than AAL2. 

1. Select Duplicate ScenarioDuplicate ScenarioDuplicate ScenarioDuplicate Scenario    from the ScenariosScenariosScenariosScenarios menu and give it the name 

UBR_UBR UBR_UBR UBR_UBR UBR_UBR ⇒ Click OKOKOKOK 
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2. For all voicevoicevoicevoice stations in all subnets, reconfigure them as follows. (Check the 
note below for a faster way to carry out this step.) 

i. Set ATM Application ParametersATM Application ParametersATM Application ParametersATM Application Parameters    to UBRUBRUBRUBR only only only only. 

ii. ATM Parameters ⇒ Set Queue ConfigurationQueue ConfigurationQueue ConfigurationQueue Configuration to UBRUBRUBRUBR. 

iii. Application: Transport ProtocolApplication: Transport ProtocolApplication: Transport ProtocolApplication: Transport Protocol ⇒ Set Voice Transport Voice Transport Voice Transport Voice Transport to AAL5AAL5AAL5AAL5. 

3. Save your project. 

Note:Note:Note:Note:    One easy way to carry out step 2 above is through the network browser 
as: 

• Select Show Network Browser Show Network Browser Show Network Browser Show Network Browser from the ViewViewViewView menu. 

• Select Nodes Nodes Nodes Nodes from the drop-down menu, and check the Only Selected Only Selected Only Selected Only Selected 
check box as shown in the following figure. 

• Write voice voice voice voice in the find field and click Enter.Enter.Enter.Enter.    

• In the network browser you should see a list of all voicevoicevoicevoice stations selected. 

• Right-click on any of the voicevoicevoicevoice stations in the list, select    Edit Edit Edit Edit AttributesAttributesAttributesAttributes, , , , 
and check Apply Changes to Selected ObjectsApply Changes to Selected ObjectsApply Changes to Selected ObjectsApply Changes to Selected Objects.    

• Carry out the configuration changes in step 2 above. 

• To hide the network browser, deselect Show NetShow NetShow NetShow Network Browser work Browser work Browser work Browser from the 
ViewViewViewView menu. 

 

5.4.7. Run the Simulation 

To run the simulation for both scenarios simultaneously: 

1. Go to the ScenariosScenariosScenariosScenarios menu ⇒ Select Manage ScenariosManage ScenariosManage ScenariosManage Scenarios.... 

2. Change the values under the ResultsResultsResultsResults column to <collectcollectcollectcollect>    (or <recollectrecollectrecollectrecollect>) ) ) ) for 
both scenarios. Compare to the following figure. 
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3. Click OKOKOKOK to run the two simulations. Depending on the speed of your processor, 
this may take several minutes to complete. 

4. After the two simulation runs complete, one for each scenario, click CloseCloseCloseClose. 

5. Save your project. 

5.4.8. View the Results 

To view and analyze the results: 

1. Select Compare ResultsCompare ResultsCompare ResultsCompare Results from the ResultsResultsResultsResults menu. 

2. Change the drodrodrodropppp----dowdowdowdown n n n menu in the right-lower part of the Compare Results 
dialog box from As IsAs IsAs IsAs Is    to time_averagetime_averagetime_averagetime_average    as shown. 

 

3. Select the voice Packet Delay VariationPacket Delay VariationPacket Delay VariationPacket Delay Variation statistic and click ShowShowShowShow. The resulting 
graph should resemble the one below. (Note: Result may vary slightly due to 
different node placement.) 
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5.5. Further readings 

• OPNET ATM Model Description: From the ProtocolsProtocolsProtocolsProtocols menu, select ATM ATM ATM ATM ⇒⇒⇒⇒    Model 
Usage Guide. 

5.6. Exercises 

1) Analyze the result we obtained regarding the voice Packet Delay VariationPacket Delay VariationPacket Delay VariationPacket Delay Variation    time. 
Obtain the graphs that compare the Voice packet endVoice packet endVoice packet endVoice packet end----totototo----end delay end delay end delay end delay the Email Email Email Email 
downloaddownloaddownloaddownload response time,  response time,  response time,  response time, and the FTP download response time FTP download response time FTP download response time FTP download response time for both 
scenarios. Comment on the results. 

2) Create another scenario as a duplicate of the CBR_UBRCBR_UBRCBR_UBRCBR_UBR scenario Name the 
new scenario Q2_CBR_ABRQ2_CBR_ABRQ2_CBR_ABRQ2_CBR_ABR. In the new scenario you should use the ABRABRABRABR 
class of service for data, i.e., the FTP and Email applications in the data 
stations. Compare the performance of the CBR_ABRCBR_ABRCBR_ABRCBR_ABR scenario with that of the 
CBR_UBRCBR_UBRCBR_UBRCBR_UBR scenario. 

Hints: 

- To set ABRABRABRABR class of service to a node, assign ABR Only ABR Only ABR Only ABR Only to its ATM ATM ATM ATM 
Application ParametersApplication ParametersApplication ParametersApplication Parameters    attribute and ABR only (Per VC Queue) ABR only (Per VC Queue) ABR only (Per VC Queue) ABR only (Per VC Queue) to its 
Queue Configuration Queue Configuration Queue Configuration Queue Configuration (one of the ATM Parameters).ATM Parameters).ATM Parameters).ATM Parameters). 

- For all switchesswitchesswitchesswitches in the network (total of 6 switches), configure the 
Max_Avail_BWMax_Avail_BWMax_Avail_BWMax_Avail_BW    of the ABR ABR ABR ABR queue to be 100% and the Min_Guaran_BWMin_Guaran_BWMin_Guaran_BWMin_Guaran_BW    to 
be 20%. 

3) Edit the FTP application defined in the ApplicationsApplicationsApplicationsApplications node so that its File SizeFile SizeFile SizeFile Size is 
twice the current size (i.e., make it 100000 bytes instead of 50000 bytes). Edit 
the EMAILEMAILEMAILEMAIL application defined in the ApplicationsApplicationsApplicationsApplications node so that its File SizeFile SizeFile SizeFile Size is 
five times the current size (i.e., make it 10000 bytes instead of 2000 bytes). 
Study how this affects the voice application performance in both the CBR_UBRCBR_UBRCBR_UBRCBR_UBR 
and UBR_UBRUBR_UBRUBR_UBRUBR_UBR scenarios. (Hint: to answer this exercise, you might need to 
create duplicates of the CBR_UBRCBR_UBRCBR_UBRCBR_UBR and UBR_UBRUBR_UBRUBR_UBRUBR_UBR scenarios. Name the new 
scenarios Q3_CBR_UBRQ3_CBR_UBRQ3_CBR_UBRQ3_CBR_UBR and Q3_UBR_UBRQ3_UBR_UBRQ3_UBR_UBRQ3_UBR_UBR respectively). 
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5.7. Lab Report 

Prepare a report that follows the guidelines explained in Lab 0. The report should 
include the answers to the above exercises as well as the graphs you generated 
from the simulation scenarios. Discuss the results you obtained and compare these 
results with your expectations. Mention any anomalies or unexplained behaviors. 
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6. Laboratory - RIP: Routing Information Protocol (A Routing Protocol 
Based on the Distance-Vector Algorithm) 

6.1. Objective 

The objective of this lab is to configure and analyze the performance of the Routing 
Information Protocol (RIP) model. 

6.2. Overview 

A router in the network needs to be able to look at a packet's destination address 
and then determines which one of the output ports is the best choice to get the 
packet to that address. The router makes this decision by consulting a forwarding 
table. The fundamental problem of routing is: How do routers acquire the 
information in their forwarding tables? 

Routing algorithms are required to build the routing tables and hence forwarding 
tables. The basic problem of routing is to find the lowest-cost path between any two 
nodes, where the cost of a path equals the sum of the costs of all the edges that 
make up the path. Routing is achieved in most practical networks by running routing 
protocols among the nodes. The protocols provide a distributed, dynamic way to 
solve the problem of finding the lowest-cost path in the presence of link and node 
failures and changing edge costs. 

One of the main classes of routing algorithms is the distance-vector algorithm. Each 
node constructs a vector containing the distances (costs) to all other nodes and 
distributes that vector to its immediate neighbors RIP is the canonical example of a 
routing protocol built on the distance-vector algorithm. Routers running RIP send 
their advertisements regularly (e.g., every 30 seconds). A router also sends an 
update message whenever a triggered update from another router causes it to 
change its routing table. 

The Internet Control Message Protocol (ICMP) can be utilized to analyze the 
performance of the created routes. It can be used to model traffic between routers 
without the need of running applications in an end node. 

In this lab you will set up a network that utilizes RIP as its routing protocol. You will 
analyze the routing tables generated in the routers, and you will observe how RIP is 
affected by link failures. You will also utilize the ICMP to create echo reply 
messages (i.e., ping) to analyze the created routes. 

6.3. Prelab Activities 

• Read sections 4.1.5, 4.1.7, and 4.2.2 from "Computer Networks: A Systems "Computer Networks: A Systems "Computer Networks: A Systems "Computer Networks: A Systems 
Approach"Approach"Approach"Approach", , , , 4th EditionEditionEditionEdition....    

Go to www.net-seal.net/animations.php    and play the following animations: 
• The Address Resolution Protocol (ARP). Example1, Example2, Example3. 

• ARP with Multiple Networks. 

• Routing and Forwarding. 

6.4. Procedure 

6.4.1. Create a New Project 

1. Start OPNET IT Guru Academic EditionOPNET IT Guru Academic EditionOPNET IT Guru Academic EditionOPNET IT Guru Academic Edition ⇒ Choose NewNewNewNew from the FileFileFileFile menu. 
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2. Select ProjectProjectProjectProject and Click OKOKOKOK    ⇒ Name the project <your initials><your initials><your initials><your initials>_RIP_RIP_RIP_RIP,    and the 

scenario NO_FailureNO_FailureNO_FailureNO_Failure    ⇒ Click OKOKOKOK. 

3. In the Startup Wizard: Initial Topology    dialog box, make sure that Create Empty Create Empty Create Empty Create Empty 

ScenarioScenarioScenarioScenario    is selected ⇒ Click NextNextNextNext    ⇒    Select CampusCampusCampusCampus    from the Network Scale list 
⇒ Click NextNextNextNext    three times ⇒ Click OKOKOKOK. 

6.4.2. Create and Configure the Network 

6.4.2.1. Initialize the Network: 

1. The Object Palette    dialog box should now be on top of your project workspace. 

If it is not there, open it by clicking . Make sure that the internet_toolboxinternet_toolboxinternet_toolboxinternet_toolbox    is 
selected from the pull-down menu on the object palette. 

2. Add to the project workspace the following objects from the palette: one 
ethernet4_slip8_gtwyethernet4_slip8_gtwyethernet4_slip8_gtwyethernet4_slip8_gtwy router and two 100BaseT100BaseT100BaseT100BaseT_LAN objects. 

a. To add an object from a palette, click its icon in the object palette ⇒ Move 

your mouse to the workspace ⇒ Click to place the object ⇒ Right-click to 
stop creating objects of that type. 

3. Use bidirectional 100BaseT100BaseT100BaseT100BaseT links to connect the objects you just added as in the 

following figure. Also, rename the objects as shown (right-click on the node ⇒ 
Set NameNameNameName). 

4. Close the Object Palette    dialog box. 

5. Save your project. 

The ethernet4_slip8_gtwyethernet4_slip8_gtwyethernet4_slip8_gtwyethernet4_slip8_gtwy node model represents an IP based gateway supporting four Ethernet hub interfaces 
and eight serial line interfaces. IP packets arriving on any interface are routed to the appropriate output interface 
based on their destination IP address. The Routing Information Protocol (RIP) or the Open Shortest Path First 
(OSPF) protocol may be used to dynamically and automatically create the gateway’s routing tables and select 
routes in an adaptive manner. 

 

6.4.2.2. Configure the Router: 

1. Right-click on Router1Router1Router1Router1 ⇒    Edit Edit Edit Edit AttributesAttributesAttributesAttributes ⇒ Expand the IP Routing ParametersIP Routing ParametersIP Routing ParametersIP Routing Parameters    
hierarchy and set the following: 

i. Routing TRouting TRouting TRouting Tableableableable Export = Once at End of Simulation.  Export = Once at End of Simulation.  Export = Once at End of Simulation.  Export = Once at End of Simulation. This asks the router to 
export its routing table at the end of the simulation to the simulation log. 

2. Click OKOKOKOK and then save your project. 

6.4.2.3. Add the Remaining LANs: 

1. Highlight or select simultaneously (using shift and left-click) all five objects that 
you currently have in the project workspace (one router, two LANs, and two 
links). You can click-and-drag a box around the objects to do this. 
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2. Press Ctri+CCtri+CCtri+CCtri+C to copy the selected objects and then press Ctri+VCtri+VCtri+VCtri+V to paste them. 

3. Repeat step 2 three times to generate three new copies of the objects and 
arrange them in a way similar to the following figure. Rename all objects as 
shown. 

4. Connect routers, as shown, using PPP_DS3PPP_DS3PPP_DS3PPP_DS3 links. 

 

The PPP_DS3PPP_DS3PPP_DS3PPP_DS3 link has a data rate of 44.736 Mbps. 

6.4.3. Choose the Statistics 

To test the performance of the RIP protocol, we will collect the following statistics: 

1. Right-click anywhere in the project workspace and select Choose Individual Choose Individual Choose Individual Choose Individual 
StatisticsStatisticsStatisticsStatistics    from the pop-up menu. 

2. In the Choose Results dialog box, check the following statistics: 

a. Global StatisticsGlobal StatisticsGlobal StatisticsGlobal Statistics    ⇒    RIP RIP RIP RIP ⇒    Traffic SentTraffic SentTraffic SentTraffic Sent (bits/sec)(bits/sec)(bits/sec)(bits/sec)....    

b. GlobalGlobalGlobalGlobal    StatisticsStatisticsStatisticsStatistics ⇒ RIP RIP RIP RIP ⇒    TrafficTrafficTrafficTraffic    RecervedRecervedRecervedRecerved    (bits(bits(bits(bits////sec)sec)sec)sec). 

c. Nodes Statistics Nodes Statistics Nodes Statistics Nodes Statistics ⇒ Route Table Route Table Route Table Route Table    ⇒    Total Number of UpdatesTotal Number of UpdatesTotal Number of UpdatesTotal Number of Updates....    

3. Click OKOKOKOK and then save your project. 

RlP trafficRlP trafficRlP trafficRlP traffic is the total amount of RIP update traffic (in bits) sent/received per second by all the nodes using RlP as 
the routing protocol in the IP interfaces in the node. 

Total Number of UpdatesTotal Number of UpdatesTotal Number of UpdatesTotal Number of Updates is the number of times the routing table at    this node gets updated (e.g., due to a new 
route addition, an existing route deletion, and/or a next hop update). 

6.4.4. Configure the Simulation 

Here we need to configure some of the simulation parameters: 
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1. Click on  and the Configure Simulation window should appear. 

2. Set the duration to be 10.0 minutes10.0 minutes10.0 minutes10.0 minutes.... 

3. Click on the Global AttributesGlobal AttributesGlobal AttributesGlobal Attributes tab and change the following attributes: 

a. IP Dynamic Routing Protocol = RIP. IP Dynamic Routing Protocol = RIP. IP Dynamic Routing Protocol = RIP. IP Dynamic Routing Protocol = RIP. This sets the RIP protocol to be the 
routing protocol of all routers in the network. 

b. IP Interface Addressing Mode = IP Interface Addressing Mode = IP Interface Addressing Mode = IP Interface Addressing Mode = Auto Addressed/ExportAuto Addressed/ExportAuto Addressed/ExportAuto Addressed/Export. 

c. RIP Sim Efficiency = DisabledRIP Sim Efficiency = DisabledRIP Sim Efficiency = DisabledRIP Sim Efficiency = Disabled. If this attribute is enabled, RIP will stop after 
the "RIP Stop Time" But we need the RIP to keep updating the routing table 
in case there is any change in the network (as we will see in the second 
scenario). 

4. Click OKOKOKOK and then save the project. 

 

Auto Addressed Auto Addressed Auto Addressed Auto Addressed means that all IP interfaces are assigned IP addresses automatically during simulations. The 
class of address (e.g., A, B, or C) is determined based on the number of hosts in the designed network. Subnet 
masks assigned to these interfaces are the default subnet masks for that class. 

ExpoExpoExpoExportrtrtrt causes the auto-assigned lP interface to a file (name of the file is <net_name> ip_address.gdf and gets 
saved in the primary model directory). 

6.4.5. The Ping Scenario 

In this scenario we will utilize the ping model to print the list of traversed nodes while 
the ICMP request message is sent to the destination and the ICMP response is 
received from the destination. Traversed routes are logged in the simulation log file 
… 

1. Select Duplicate ScenarioDuplicate ScenarioDuplicate ScenarioDuplicate Scenario    from the ScenariosScenariosScenariosScenarios menu and name it ICMP_PingICMP_PingICMP_PingICMP_Ping    ⇒ 
Click OOOOKKKK. 

2. Select both Router1Router1Router1Router1 and Router3Router3Router3Router3 simultaneously (click on both of them while 

holding the ShiftShiftShiftShift key) ⇒ Select the ProtocolsProtocolsProtocolsProtocols menu ⇒ IPIPIPIP    ⇒    DemandsDemandsDemandsDemands    ⇒    
Configure Ping Traffic on Selected NodesConfigure Ping Traffic on Selected NodesConfigure Ping Traffic on Selected NodesConfigure Ping Traffic on Selected Nodes. 

3. Change the Pattern attribute to Record Route as shown ⇒ Click OKOKOKOK.... 
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Notice that a Ping Parameter    node will be added to the project space. In addition the 
ping demand is created between Rotuer1    and Router3    as a dotted line. 

6.4.6. The Failure Scenario 

The routers in the network we created will build their routing tables with no need to 
update these tables further because we didn't simulate any node or link failures. In 
this scenario we will simulate failures so that we can compare the behavior of the 
routers in both cases. 

1. Select Duplicate ScenarioDuplicate ScenarioDuplicate ScenarioDuplicate Scenario    from the ScenarioScenarioScenarioScenariossss menu and name it Failure Failure Failure Failure ⇒    Click 
OKOKOKOK. 

2. Open Object Palette by clicking . Select the UtilitiesUtilitiesUtilitiesUtilities palette from the 

drop-down menu ⇒ Add a Failure RecoveryFailure RecoveryFailure RecoveryFailure Recovery object to your workspace and 

name it FailureFailureFailureFailure as shown ⇒ Close the Object Palette    dialog box. 
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3. Right-click on the FailureFailureFailureFailure object ⇒ Edit Edit Edit Edit AttributesAttributesAttributesAttributes ⇒ Expand the Link Link Link Link 

Failure/Recovery SpecificationFailure/Recovery SpecificationFailure/Recovery SpecificationFailure/Recovery Specification hierarchy ⇒ Set rowsrowsrowsrows to 1111 ⇒ Set the attributes 
of the added row, row 0row 0row 0row 0, as follows: 

 

4. This will "fail" the link between Router1Router1Router1Router1 and Router2Router2Router2Router2 200 seconds into the 
simulation. 

5. Click OKOKOKOK and then save the project. 

6.4.7. Run the Simulation 

To run the simulation for both scenarios simultaneously: 
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1. Go to the ScenariosScenariosScenariosScenarios menu ⇒ Select Manage ScenariosManage ScenariosManage ScenariosManage Scenarios. 

2. Change the values under the ResultsResultsResultsResults column to <collectcollectcollectcollect> (or <recrecrecrecollectollectollectollect>) for the 
three scenarios. Compare to the following figure. 

 

3. Click OKOKOKOK to run the three simulations. Depending on the speed of your 
processor, this may take several seconds to complete. 

4. After the three simulation runs complete, one for each scenario, click CloseCloseCloseClose ⇒    
Save your project. 

6.4.8. View the Results 

6.4.8.1. Compare the Number of Updates: 

1. Select Compare ResultsCompare ResultsCompare ResultsCompare Results from the ResultsResultsResultsResults menu. 

2. Change the drop-down menu in the right-lower part of the Compare Results 
dialog box to Stacked StatisticsStacked StatisticsStacked StatisticsStacked Statistics and Select ScenariosSelect ScenariosSelect ScenariosSelect Scenarios as shown. 

 

3. Select the Total Number of UpdatesTotal Number of UpdatesTotal Number of UpdatesTotal Number of Updates statistic for Router1Router1Router1Router1 and click ShowShowShowShow ⇒ 
Select the NO_FailureNO_FailureNO_FailureNO_Failure and FailureFailureFailureFailure scenarios in the Select ScenariosSelect ScenariosSelect ScenariosSelect Scenarios dialog box. 

4. You should get two graphs, one for each scenario. Right-click on each graph 

and select DraDraDraDraw Stylew Stylew Stylew Style ⇒ BarBarBarBar. 

5. The resulting graphs should resemble the following (you can zoom in on the 
graphs by clicking-and-dragging a box over the region of interest): 
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6.4.8.2. Obtain the IP Addresses of the Interface: 

Before    checking the contents of the routing tables, we need to determine the IP 
address information for all interfaces in the current network. Recall that these IP 
addresses are assigned automatically during simulation, and we set the global 
attribute IP Interface Addressing Mode IP Interface Addressing Mode IP Interface Addressing Mode IP Interface Addressing Mode to export this information to a file. 

1. From the FileFileFileFile menu choose Model Files Model Files Model Files Model Files ⇒ Refresh Model Directories.  Refresh Model Directories.  Refresh Model Directories.  Refresh Model Directories. This 
causes OPNET IT Guru to search the model directories and update its list of 
files. 

2. From the FileFileFileFile menu choose OpenOpenOpenOpen ⇒ From the drop-down menu choose Generic Generic Generic Generic 

Data FileData FileData FileData File ⇒ Select the <your initials><your initials><your initials><your initials>_RIP_RIP_RIP_RIP----NO_NO_NO_NO_FailureFailureFailureFailure----ip_addressesip_addressesip_addressesip_addresses file (the 
other file created from the FailureFailureFailureFailure scenario should contain the same 

information) ⇒ Click OKOKOKOK. 
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3. The following is a part of the gdfgdfgdfgdf file content. It shows the IP addresses assigned 
to the interfaces of Router1Router1Router1Router1 in our network. For example the interface of Router1Router1Router1Router1 
that is connected to Net11Net11Net11Net11 has the IP address 192.0.0.1 (Note: Your result may 
vary due to different nodes placement.) The Subnet MaskSubnet MaskSubnet MaskSubnet Mask associated with that 
interface indicates that the address of the sub-network, to which the interface is 
connected, is 192.0.0.0 (i.e., the logical AND of the interface IP address and the 
subnet mask). 

 

4. Print out the layout of the network you implemented in this lab. On this layout, 
from the information included in the gdfgdfgdfgdf file, write down the IP addresses 
associated with Router1Router1Router1Router1 as well as the addresses assigned to each 
sub-network as shown in the following two figures (Note: Your IP addresses 
may vary due to different nodes placement.) 
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6.4.8.3. Getting the Ping Report: 

1. To check the content of the ping report for Router1Router1Router1Router1: 

i. Go to the ICMP_Ping ICMP_Ping ICMP_Ping ICMP_Ping scenario ⇒ Go to the ResultsResultsResultsResults menu ⇒ Open    

Simulation LogSimulation LogSimulation LogSimulation Log ⇒ Click on the field PING REPORTPING REPORTPING REPORTPING REPORT for "CampusCampusCampusCampus Network Network Network Network    
Router1Router1Router1Router1". The report should resemble the following one: 

 

6.4.8.4. Compare the Routing Tables Content: 

1. To check the content of the routing tables in Router1Router1Router1Router1    for the Failure Failure Failure Failure and 
NO_FailureNO_FailureNO_FailureNO_Failure scenarios: 

i. Go to the ResultsResultsResultsResults menu. ⇒ Open Simulation Log Simulation Log Simulation Log Simulation Log ⇒ Expand the hierarchy 

on the left as shown below. ⇒ Click on the field COMMON ROUTE TABLECOMMON ROUTE TABLECOMMON ROUTE TABLECOMMON ROUTE TABLE. 

 

2. Carry out the previous step for the Failure and NO_FailureNO_FailureNO_FailureNO_Failure scenarios. The 
following are partial contents of Router1Router1Router1Router1's routing table for both scenarios (Note: 
Your results may vary due to different nodes placement): 

Routing table of Router1Router1Router1Router1 (NO FailureNO FailureNO FailureNO Failure scenario): 
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Loopback interfaceLoopback interfaceLoopback interfaceLoopback interface allows a client and a server on the same host to communicate with each other using TCP/IP. 

Routing table of Router1Router1Router1Router1 (FailureFailureFailureFailure scenario): 

 

6.5. Further readings 

• RIP: IETF RFC number 2453 (www.ietf.org/rfc.html) 

• ICMP. IETF RFC number 792 (www.ietf.org/rfc.html). 

6.6. Exercises 

1) Obtain and analyze the graphs that compare the sent RIP traffic for the Failure Failure Failure Failure 
and NO_FailureNO_FailureNO_FailureNO_Failure scenarios. Make sure to change the draw style for the graphs to 
BarBarBarBar. 

2) Describe and explain the effect of the failure of the link connecting Router1Router1Router1Router1    to 
Router2Router2Router2Router2    on the routing tables of RRRRouter1outer1outer1outer1. 

3) Create another scenario as a duplicate of the FailureFailureFailureFailure scenario. Name the new 
scenario Q3_RecoverQ3_RecoverQ3_RecoverQ3_Recover. In this new scenario have the link connecting Router1Router1Router1Router1    to 
Router2Router2Router2Router2    recover after 400 seconds (make sure to keep the failure that occurs at 
the 200th second). Generate and analyze the graph that shows the effect of this 
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recovery on the Total Number of UpdatesTotal Number of UpdatesTotal Number of UpdatesTotal Number of Updates    in the routing table of Router1Router1Router1Router1. Check 
the contents of Router1Router1Router1Router1's routing table. Compare this table with the 
corresponding routing tables generated in the NO_FailureNO_FailureNO_FailureNO_Failure    and FailureFailureFailureFailure 
scenarios.  

4) Change the Ping packet size to 5000 bytes (Hint:    Edit the attributes of the Ping 
Parameters node). Run the simulation to generate a new Ping report. What is 
the effect of the new size on the ICMP packet response time? 

6.7. Lab Report 

Prepare a report that follows the guidelines explained in Lab 0. The report should 
include the answers to the above exercises as well as the graphs you generated 
from the simulation scenarios. Discuss the results you obtained and compare these 
results with your expectations. Mention any anomalies or unexplained behaviors. 
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7. Laboratory - OSPF: Open Shortest Path First (A Routing Protocol 
Based on the Link-State Algorithm) 

7.1. Objective 

The objective of this lab is to configure and analyze the performance of the Open 
Shortest Path First (OSPF) routing protocol. 

7.2. Overview 

In Lab 6 we discussed RIP, which is the canonical example of a routing protocol built 
on the distance-vector algorithm. Each node constructs a vector containing the 
distances (costs) to all other nodes and distributes that vector to its immediate 
neighbors. Link-state routing is the second major class of intra-domain routing 
protocol. The basic idea behind link-state protocols is very simple: Every node 
knows how to reach its directly connected neighbors, and if we make sure that the 
totality of this knowledge is disseminated to every node, then every node will have 
enough knowledge of the network to build a complete map of the network. 

Once a given node has a complete map for the topology of the network, it is able to 
decide the best route to each destination. Calculating those routes is based on a 
well-known algorithm from graph theory - Dijkstra's shortest-path algorithm. 

OSPF introduces another layer of hierarchy into routing by allowing a domain to be 
partitioned into areas. This means that a router within a domain does not 
necessarily need to know how to reach every network within that domain — it may be 
sufficient for it to know how to get to the right area. Thus, there is a reduction in the 
amount of information that must be transmitted to and stored in each node. In 
addition, OSPF allows multiple routes to the same destination to be assigned the 
same cost and will cause traffic to be distributed evenly over those routers. 

In this lab, you will set up a network that utilizes OSPF as its routing protocol. You 
will analyze the routing tables generated in the routers and will observe how the 
resulting routes are affected by assigning areas and enabling load balancing. 

7.3. Prelab Activities 

• Read sections 4.2.3 and 4.2.4 from "Computer Networks: A Systems Approach""Computer Networks: A Systems Approach""Computer Networks: A Systems Approach""Computer Networks: A Systems Approach",,,,    
4th EditionEditionEditionEdition....    

Go to www.netwww.netwww.netwww.net----seal.net/animations.phpseal.net/animations.phpseal.net/animations.phpseal.net/animations.php    and play the following animation: 
• Routing and forwarding. 

7.4. Procedure 

7.4.1. Create a New Project 

1. Start OPNET IT Guru Academic EditionOPNET IT Guru Academic EditionOPNET IT Guru Academic EditionOPNET IT Guru Academic Edition ⇒ Choose NewNewNewNew from the FileFileFileFile menu. 

2. Select ProjectProjectProjectProject and Click OKOKOKOK ⇒ Name the project <your initials<your initials<your initials<your initials>_OSPF_OSPF_OSPF_OSPF,    and the 

scenario NoNoNoNo_Areas _Areas _Areas _Areas ⇒ Click OKOKOKOK. 

3. In the Startup Wizard: Initial Topology    dialog box, make sure that Create Empty Create Empty Create Empty Create Empty 

ScenarioScenarioScenarioScenario    is selected ⇒ Click NextNextNextNext    ⇒ Select CampusCampusCampusCampus    from the Network Scale list 
⇒ Click NextNextNextNext    three times ⇒ Click OKOKOKOK. 
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7.4.2. Create and Configure the Network 

7.4.2.1. Initialize the Network: 

1. The Object Palette    dialog box should now be on top of your project workspace. 

If it is not there, open it by clicking . Select the routers routers routers routers item from the 
pull-down menu on the object palette. 

a. Add to the project workspace eight routers of type slip8slip8slip8slip8_gtwy. _gtwy. _gtwy. _gtwy. To add an 

object from a palette, click its icon in the object palette. ⇒ Move your mouse 

to the workspace and click to place the object. ⇒ You can keep on 
left-clicking to create additional objects. Right-click when you are finished 
placing the last object. 

2. Switch the palette configuration so it contains the internet_toolboxinternet_toolboxinternet_toolboxinternet_toolbox. Use 
bidirectional PPP_DS3PPP_DS3PPP_DS3PPP_DS3 links to connect the routers. Rename the routers as 
shown below. 

3. Close the Object Palette and then save your project. 

 

The slip8_gtwyslip8_gtwyslip8_gtwyslip8_gtwy node model represents an IP based gateway supporting up to eight serial line interfaces at a 
selectable data rate. The RIP or OSPF protocols may be used to automatically any dynamically create the 
gateway’s routes in an adaptive manner. 

The PPP_PPP_PPP_PPP_DS3DS3DS3DS3 link has a data of 44.736 Mbps. 

7.4.2.2. Configure the Link Costs: 

1. We need to assign link costs to match the following graph: 

 

2. Like many popular commercial routers, OPNET router models support a 
parameter called a reference bandwidth to calculate the actual cost, as follows: 

CostCostCostCost = ( = ( = ( = (Reference bandwidthReference bandwidthReference bandwidthReference bandwidth)/()/()/()/(Link bandwidthLink bandwidthLink bandwidthLink bandwidth))))    

where the default value of the reference bandwidth    is 1,000,000 Kbps. 
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3. For example, to assign a cost of 5 to a link, assign a bandwidth of 200,000 Kbps 
to that link. Note that this is not the actual bandwidth of the link in the sense of 
transmission speed, but merely a parameter used to configure link costs. 

4. To assign the costs to the links of our network, do the following: 

i. Select all links in your network that correspond to the links with a cost of 5 in 
the above graph by shift-clicking on them. 

ii. Select the ProtocolsProtocolsProtocolsProtocols menu ⇒    IPIPIPIP ⇒ RoutingRoutingRoutingRouting ⇒ Configure Interface Metric Configure Interface Metric Configure Interface Metric Configure Interface Metric    
InformationInformationInformationInformation. 

iii. Assign 200200200200,,,,000 000 000 000 to the Bandwidth (Kbps)Bandwidth (Kbps)Bandwidth (Kbps)Bandwidth (Kbps) field ⇒ Check the InterfacesInterfacesInterfacesInterfaces    

across selected links across selected links across selected links across selected links radio button, as shown ⇒ Click OKOKOKOK.... 

 

5. Repeat step 4 for all links with a cost of 10 but assign 100,000 Kbps to the 
Bandwidth (Kbps)Bandwidth (Kbps)Bandwidth (Kbps)Bandwidth (Kbps) field. 

6. Repeat step 4 for all links with a cost of 20 but assign 50,000 Kbps to the 
Bandwidth (Kbps)Bandwidth (Kbps)Bandwidth (Kbps)Bandwidth (Kbps) field. 

7. Save your project. 

7.4.2.3. Configure the Traffic Demands: 

1. Select both RouterARouterARouterARouterA and RouterCRouterCRouterCRouterC by shift-clicking on them. 

i. Select the ProtocolsProtocolsProtocolsProtocols menu ⇒ IP IP IP IP ⇒ Demands  Demands  Demands  Demands ⇒ Create Traffic Demands  Create Traffic Demands  Create Traffic Demands  Create Traffic Demands ⇒ 

Check the FromFromFromFrom RouterRouterRouterRouterAAAA    radio button as shown ⇒ Keep the color as blue 

⇒ Click CreateCreateCreateCreate. Now you should see a blue-dotted line representing the 
traffic demand between RouterARouterARouterARouterA    and RouterCRouterCRouterCRouterC....    

 

2. Select both RouterBRouterBRouterBRouterB and RouterHRouterHRouterHRouterH by shift-clicking on them. 
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i. Select the ProtocolsProtocolsProtocolsProtocols menu ⇒ IPIPIPIP ⇒ DemandsDemandsDemandsDemands ⇒ Create Traffic DemandsCreate Traffic DemandsCreate Traffic DemandsCreate Traffic Demands ⇒ 

Check the FromFromFromFrom RouterRouterRouterRouterBBBB radio button ⇒ Change the color to redredredred ⇒ Click 

OKOKOKOK ⇒ Click CreateCreateCreateCreate. 

Now you can see the lines representing the traffic demands as shown. 

 

3. To hide these lines: Select the ViewViewViewView menu ⇒ Select Demand ObjectsDemand ObjectsDemand ObjectsDemand Objects ⇒ Select 
Hide AllHide AllHide AllHide All. 

4. Save your project. 

7.4.2.4. Configure the Routing Protocol and Addresses: 

1. Select the PPPProtocolsrotocolsrotocolsrotocols menu ⇒ IPIPIPIP ⇒ RoutingRoutingRoutingRouting ⇒ Configure Routing ProtocolsConfigure Routing ProtocolsConfigure Routing ProtocolsConfigure Routing Protocols. 

2. Check the OSPFOSPFOSPFOSPF check box ⇒ Uncheck the RIPRIPRIPRIP check box ⇒ Uncheck the 
Visualize Routing DomainsVisualize Routing DomainsVisualize Routing DomainsVisualize Routing Domains check box, as shown: 

 

3. Click OKOKOKOK. 

4. Select RouterARouterARouterARouterA and RouterBRouterBRouterBRouterB only ⇒ Select the ProtocolsProtocolsProtocolsProtocols menu ⇒ IPIPIPIP ⇒ RouRouRouRoutingtingtingting 

⇒ Select Export Routing Table for Selected RoutersExport Routing Table for Selected RoutersExport Routing Table for Selected RoutersExport Routing Table for Selected Routers ⇒ Click OKOKOKOK on the Status 
Confirm dialog box. 

Auto-Assign IP AddressIP AddressIP AddressIP Addresses assigns a unique IP address to connected IP interfaces whose IP address is currently 
set to auto-assigned. It does not change the value of manually set IP address. 
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7.4.3. Configure the Simulation 

Here we need to configure some of the simulation parameters: 

1. Click on  and the Configure Simulation window should appear. 

2. Set the duration to be 10.0 minutes10.0 minutes10.0 minutes10.0 minutes. 

3. Click OKOKOKOK and then save your project. 

7.4.4. Duplicate the Scenario 

In the network we just created, all routers belong to one level of hierarchy (i.e., one 
area). Also, we didn't enforce load balancing for any routes. Two new scenarios will 
be created. The first new scenario will define two new areas in addition to the 
backbone area. The second one will be configured to balance the load for the traffic 
demands between RouterBRouterBRouterBRouterB and RouterHRouterHRouterHRouterH. 

7.4.4.1. The Areas Scenario: 

1. Select Duplicate ScenarioDuplicate ScenarioDuplicate ScenarioDuplicate Scenario    from the ScenariosScenariosScenariosScenarios menu and give it the name ArArArAreas eas eas eas 

⇒ Click OKOKOKOK. 

2. Area 0.0.0.10.0.0.10.0.0.10.0.0.1: 

i. Select the three links that connect RouterARouterARouterARouterA, , , , RouterBRouterBRouterBRouterB, , , , and RouterCRouterCRouterCRouterC    by 

shift-clicking on them ⇒ Select the ProtocolsProtocolsProtocolsProtocols menu OSPF OSPF OSPF OSPF ⇒ Configure  Configure  Configure  Configure 

Areas Areas Areas Areas ⇒ Assign the value 0.0.0.10.0.0.10.0.0.10.0.0.1    to the Area Identifier, Area Identifier, Area Identifier, Area Identifier, as shown ⇒ Click 
OKOKOKOK....    

 

ii. Right-click on RouterCRouterCRouterCRouterC ⇒ Edit Edit Edit Edit AttributesAttributesAttributesAttributes ⇒ Expand the OSPF ParametersOSPF ParametersOSPF ParametersOSPF Parameters 

hierarchy ⇒ Expand the Loopback InterfacesLoopback InterfacesLoopback InterfacesLoopback Interfaces hierarchy ⇒ Expand the row0row0row0row0 

hierarchy ⇒ Assign 0.0.0.10.0.0.10.0.0.10.0.0.1 to the value of the Area IDArea IDArea IDArea ID attribute ⇒ Click OKOKOKOK. 

3. Area 0.0.0.20.0.0.20.0.0.20.0.0.2 

i. Click somewhere in the project workspace to disable the selected links and 
then repeat step 2222-i for the three links that connect RouterFRouterFRouterFRouterF, RouterG, RouterG, RouterG, RouterG, and 
RouterHRouterHRouterHRouterH    but assign the value 0.0.0.2 0.0.0.2 0.0.0.2 0.0.0.2 to their Area IdentifierArea IdentifierArea IdentifierArea Identifier. 

4. To visualize the areas we just created, select the ProtocolsProtocolsProtocolsProtocols menu ⇒ OSPFOSPFOSPFOSPF ⇒ 

VVVVisualize Areasisualize Areasisualize Areasisualize Areas ⇒ Click OKOKOKOK. The network should look like the following one with 
different colors assigned to each area (you may get different colors though). 

Loopback interface allows a client and a server on the same host to communicate with each other using TCP/IP. 

Note: 

• The area you did not configure is the backbone area and its Area Area Area Area IdIdIdIdententententiiiifier = fier = fier = fier = 
0.0.0.0. 

• The figure shows the links with a thickness of 3. 
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7.4.4.2. The Balanced Scenario: 

1. Under the ScenariosScenariosScenariosScenarios menu, Switch to ScenarioScenarioScenarioScenario ⇒ Select No_AreasNo_AreasNo_AreasNo_Areas. 

2. Select DuplDuplDuplDuplicate Scenarioicate Scenarioicate Scenarioicate Scenario from the ScenariosScenariosScenariosScenarios menu, and give it the name 

BalancedBalancedBalancedBalanced ⇒ Click OKOKOKOK. 

3. In the new scenario, select both RouterBRouterBRouterBRouterB and RouterHRouterHRouterHRouterH by shift-clicking on them. 

4. Select the ProtocolsProtocolsProtocolsProtocols menu ⇒ IPIPIPIP ⇒ RoutingRoutingRoutingRouting ⇒ Configure Load BalancingLoad BalancingLoad BalancingLoad Balancing 

Options ⇒ Make sure that the option is PacketPacketPacketPacket----BasedBasedBasedBased and the radio button 

Selected RoutersSelected RoutersSelected RoutersSelected Routers is selected as shown ⇒ Click OKOKOKOK. 

 

5. Save your project. 

OPNET provides two types of IP load balancing. 

With Destination BasedDestination BasedDestination BasedDestination Based, load balancing is done on a per destination basis. The route chosen from the source 
router to the destination network is the same for all packets. 

With Packet BasedPacket BasedPacket BasedPacket Based, load balancing is done on a per packet basis. The route chosen from the source router to the 
destination network is determined for every individual packet. 

7.4.5. Run the Simulation 

To run the simulation for the three scenarios simultaneously: 

1. Go to the ScenariosScenariosScenariosScenarios menu ⇒ Select Manage ScenariosManage ScenariosManage ScenariosManage Scenarios. 

2. Click on the row of each scenario and click the Collect Collect Collect Collect ResultsResultsResultsResults button. This 
should change the values under the ResultsResultsResultsResults column to <collectcollectcollectcollect>    as shown. 



 

 network simulation experiments manual.doc utorak, 28. rujan 2010 83 

 

3. Click OKOKOKOK to run the three simulations. Depending on the speed of your 
processor, this may take several seconds to complete. 

4. After the three simulation runs complete, one for each scenario, click CloseCloseCloseClose and 
then save your project. 

7.4.6. View the Results 

7.4.6.1. The No_Areas Scenario: 

1. Go back to the No_AreasNo_AreasNo_AreasNo_Areas scenario. 

2. To display the route for the traffic demand between RouterARouterARouterARouterA and RouterCRouterCRouterCRouterC: 

Select the ProtocolsProtocolsProtocolsProtocols menu ⇒ IPIPIPIP ⇒ DemandsDemandsDemandsDemands ⇒ Display RoutesDisplay RoutesDisplay RoutesDisplay Routes for Configured Configured Configured Configured 

DemandsDemandsDemandsDemands. ⇒ Expand the hierarchies as shown and select RouterARouterARouterARouterA � RouterCRouterCRouterCRouterC 

⇒ Go to the DisplayDisplayDisplayDisplay column and pick YesYesYesYes ⇒ Click CloseCloseCloseClose. 

 

3. The resulting route will appear on the network as shown: 

 

4. Repeat step 2 to show the route for the traffic demand between RouterBRouterBRouterBRouterB and 
RouterHRouterHRouterHRouterH. The route is as shown below. (Note: Depending on the order in which 
you created the network topology, the other “equal-cost” path can be used, that 
is, the RouterB-RouterA-RouterD-RouterF-RouterH path). 
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7.4.6.2. The Areas Scenario: 

1. Go to scenario AreasAreasAreasAreas. 

2. Display the route for the traffic demand between RouterARouterARouterARouterA and RouterCRouterCRouterCRouterC. The 
route is as shown: 

 

3. Save your project. 

7.4.6.3. The Balanced Scenario: 

1. Go to scenario BalancedBalancedBalancedBalanced 

2. Display the route for the traffic demand between RouterBRouterBRouterBRouterB and RouterHRouterHRouterHRouterH. The 
route is as shown: 
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3. Save your project. 

7.5. Further readings 

1. OPNET OSPF Model Description: From the ProtocolsProtocolsProtocolsProtocols menu, select OSPF OSPF OSPF OSPF ⇒ Model 
Usage Guide.    

2. OSPF: IETF RFC number 2328 (www.ietf.org/rfc.html). 

7.6. Exercises 

1) Explain why, for the same pair of routers, the Areas Areas Areas Areas and BalancedBalancedBalancedBalanced    scenarios 
result in different routes than those observed in the No_AreasNo_AreasNo_AreasNo_Areas scenario. 

2) Using the simulation log, examine the generated routing table in RouterARouterARouterARouterA    for 
each one of the three scenarios. Explain the values assigned to the Metric    
column of each route. 

Hints: 

Refer to the View Results    section in Lab 6 for information about examining the 
routing tables. You will need to set the global attribute IP Interface Addressing IP Interface Addressing IP Interface Addressing IP Interface Addressing 
Mode Mode Mode Mode to the value Auto Addressed/ExportAuto Addressed/ExportAuto Addressed/ExportAuto Addressed/Export    and rerun the simulation. 

To determine the IP address information for all interfaces, you need to open the 
Generic Data File    that contains the IP addresses and associated with the 
scenarios. 

3) OPNET allows you to examine the link-state database that is used by each 
router to build the directed graph of the network. Examine this database for 
RouterARouterARouterARouterA in the No_AreasNo_AreasNo_AreasNo_Areas scenario. Show how RouterARouterARouterARouterA utilizes this database to 
create a map for the topology of the network and draw this map (This is the map 
that will be used later by the router to create its routing table.) 

Hints: 

• To export the link-state database of a router, Edit Edit Edit Edit the attributes of the router 
and set the LLLLink State Database Export ink State Database Export ink State Database Export ink State Database Export parameter (one of the OSPF OSPF OSPF OSPF 
Parameters, Parameters, Parameters, Parameters, under Processes) Processes) Processes) Processes) to Once at End of SimulationOnce at End of SimulationOnce at End of SimulationOnce at End of Simulation. 

• You will need to set the global attribute IP Interface Addressing Mode IP Interface Addressing Mode IP Interface Addressing Mode IP Interface Addressing Mode to the 
value Auto Addressed/ExportAuto Addressed/ExportAuto Addressed/ExportAuto Addressed/Export. . . . This will allow you to check the automatically 
assigned IP addresses to the interfaces of the network. (Refer to the notes 
of exercise 2 above.) 

• After rerunning the simulation, you can check the link-state database by 
opening the simulation log (from the ResultsResultsResultsResults menu). The link-state database 

is available in Classes Classes Classes Classes ⇒    OSPFOSPFOSPFOSPF    ⇒    LSDB_ExportLSDB_ExportLSDB_ExportLSDB_Export. 

4) Create another scenario as a duplicate of the No_AreasNo_AreasNo_AreasNo_Areas scenario Name the new 
scenario Q4_No_Areas_FailureQ4_No_Areas_FailureQ4_No_Areas_FailureQ4_No_Areas_Failure. In this new scenario simulate a failure of the 
link connecting RouterDRouterDRouterDRouterD and RotuerERotuerERotuerERotuerE. Have this failure start after 100 seconds. 
Read the simulation. Show how that link failure affects the content of the 
link-state database and routing table of RouterARouterARouterARouterA. (You will need to disable the 
global attribute OSPF Sim EfficiencyOSPF Sim EfficiencyOSPF Sim EfficiencyOSPF Sim Efficiency. This will allow OSPF to update the routing 
table if there is any change in the network.) 

5) For both No_AreasNo_AreasNo_AreasNo_Areas and Q4_No_Areas_FailureQ4_No_Areas_FailureQ4_No_Areas_FailureQ4_No_Areas_Failure scenario, collect the Traffic SentTraffic SentTraffic SentTraffic Sent 
(bits/sec)(bits/sec)(bits/sec)(bits/sec) statistic (one of the Global Statistics under OSPF). Rerun the 
simulation for these two scenarios and obtain the graph that compares the 
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OSPF's Traffic SentTraffic SentTraffic SentTraffic Sent (bits/sec)(bits/sec)(bits/sec)(bits/sec) in both scenarios. Comment on the obtained 
graph. 

Note: A stub network only carries local traffic (i.e., packets to and from local hosts). Even if it has paths to more 
than one other network, it does not carry traffic for other networks (RFC 1983). 

7.7. Lab Report 

Prepare a report that follows the guidelines explained in Lab 0. The report 
should include the answers to the above exercises as well as the graphs you 
generated from the simulation scenarios. Discuss the results you obtained and 
compare these results with your expectations. Mention any anomalies or 
unexplained behaviors. 
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8. Laboratory - Border Gateway Protocol (BGP) (An Interdomain Routing 
Protocol) 

8.1. Objective 

The objective of this lab is to simulate and study the basic features of an interdomain 
routing protocol called Border Gateway Protocol (BGP). 

8.2. Overview 

The Internet is organized as a set of routing domains. Each routing domain is called 
an autonomous system (AS). Each AS is controlled by a single administrative entity 
(e.g., an AS of a single service provider). Each AS has a unique 16-bit identification 
number. This number is assigned by a central authority. An AS employs its own 
intradomain    routing protocol (e.g., RIP or OSPF). Different ASs establish routes 
among each other through interdomain    routing protocols. The border gateway 
protocol (BGP) is one of the major interdomain routing protocols. 

The main goal of BGP is to find any path to the destination that is loop-free. This is 
different from the common goal of intradomain routing protocols, which is to find an 
optimal route to the destination based on a specific link metric. The routers that 
connect different ASs are called border gateways. The task of the border gateways 
is to forward packets between ASs. Each AS has also at least one BGP speaker 
BGP speakers exchange reachability information among ASs. 

BGP advertises the complete path to the destination AS as an enumerated list. This 
way routing loops can be avoided. A BGP speaker can also apply some policies 
such as balancing the load over the neighboring ASs. If a BGP speaker has a choice 
of several different routes to a destination, it will advertise the best one according to 
its own local policies. BGP is defined to run on top of TCP and hence BGP speakers 
do not need to worry about acknowledging received information or retransmission of 
sent information. 

In this lab you will set up a network with three different ASs. RIP will be used as the 
intradomain routing protocol and BGP as the interdomain one. You will analyze the 
routing tables generated in the routers as well as the effect of applying a simple 
policy. 

8.3. Prelab Activities 

• Read section 4.3 from "Computer Networks: A Systems Approach""Computer Networks: A Systems Approach""Computer Networks: A Systems Approach""Computer Networks: A Systems Approach", , , , 4th EditionEditionEditionEdition....    

Go to www.netwww.netwww.netwww.net----seal.net/animations.phpseal.net/animations.phpseal.net/animations.phpseal.net/animations.php    and play the following animation: 
• IP Subnets. 

8.4. Procedure 

8.4.1. Create a New Project 

1. Start OPNET IT Guru Academic EditionOPNET IT Guru Academic EditionOPNET IT Guru Academic EditionOPNET IT Guru Academic Edition ⇒ Choose NewNewNewNew from the FileFileFileFile menu. 

2. Select ProjectProjectProjectProject and Click OKOKOKOK    ⇒ Name the project <your initials><your initials><your initials><your initials>_BGP, _BGP, _BGP, _BGP, and the 

scenario No_BGPNo_BGPNo_BGPNo_BGP    ⇒ Click OKOKOKOK. 

3. In the Startup Wizard: Initial Topology    dialog box, make sure that Create Empty Create Empty Create Empty Create Empty 

ScenarioScenarioScenarioScenario    is selected ⇒ Click NextNextNextNext    ⇒ Select CampusCampusCampusCampus    from the Network Scale list 
⇒ Click NextNextNextNext    three times ⇒ Click OKOKOKOK. 
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8.4.2. Create and Configure the Network 

8.4.2.1. Initialize the Network: 

1. The Object Palette    dialog box should now be on top of your project workspace. 

If it is not there, open it by clicking . Make sure that the internet_toolboxinternet_toolboxinternet_toolboxinternet_toolbox    is 
selected from the pull-down menu on the object palette. 

2. Add to the project workspace the following objects from the palette: six 
ethernet4_slip8_gtwyethernet4_slip8_gtwyethernet4_slip8_gtwyethernet4_slip8_gtwy routers and two 100BaseT100BaseT100BaseT100BaseT_LAN_LAN_LAN_LAN objects. 

a. To add an object from a palette, click its icon in the object palette ⇒ Move 

your mouse to the workspace ⇒ Click to place the object ⇒ Right-click to 
stop creating objects of that type. 

3. Use bidirectional PPP_DS3PPP_DS3PPP_DS3PPP_DS3 links to connect the routers you just added as in the 
following figure. Also, rename the network objects as shown (right-click on the 

node ⇒ Set NameNameNameName). 

4. Use a bidirectional 100BaseT100BaseT100BaseT100BaseT link to connect LAN_LAN_LAN_LAN_WestWestWestWest to Router1Router1Router1Router1 and another 
100BaseT100BaseT100BaseT100BaseT link to connect LAN_LAN_LAN_LAN_EastEastEastEast to Router6Router6Router6Router6 as in the following figure. 

5. Close the Object Palette    dialog box. 

6. Save your project. 

 

The ethernet4_slip8_gtwyethernet4_slip8_gtwyethernet4_slip8_gtwyethernet4_slip8_gtwy node model represents an IP based gateway supporting four Ethernet hub interfaces 
and eight serial line interfaces. IP packets arriving on any interface are routed to the appropriate output interface 
based on their destination IP address. 

8.4.2.2. Routers Configuration: 

1. Highlight or select simultaneously (using shift- and left-click) all six routers ⇒ 

Right-click on any router ⇒ Edit Edit Edit Edit AttributesAttributesAttributesAttributes. ⇒ Check the Apply Changes to Apply Changes to Apply Changes to Apply Changes to 
Selected ObjectsSelected ObjectsSelected ObjectsSelected Objects    check box. 

2. Expand the BGP ParametersBGP ParametersBGP ParametersBGP Parameters hierarchy and set the following: 

i. RedistributionRedistributionRedistributionRedistribution � Routing Protocols Routing Protocols Routing Protocols Routing Protocols � RIP RIP RIP RIP � Redistribute Redistribute Redistribute Redistribute w/w/w/w/ DefaultDefaultDefaultDefault.... 
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3. Expand the IP Routing ParametersIP Routing ParametersIP Routing ParametersIP Routing Parameters hierarchy and set the following: 

i. Routing Table Export = Once at End of SimulationRouting Table Export = Once at End of SimulationRouting Table Export = Once at End of SimulationRouting Table Export = Once at End of Simulation. This asks the router to 
export its routing table at the end of the simulation to the simulation log. 

4. Expand the RIP ParametersRIP ParametersRIP ParametersRIP Parameters hierarchy and set the following: 

i. RedistributionRedistributionRedistributionRedistribution    �    RoutRoutRoutRoutiiiing Protocolsng Protocolsng Protocolsng Protocols    �    Directly Connected Directly Connected Directly Connected Directly Connected � Redistribute  Redistribute  Redistribute  Redistribute 
w/ Defaultw/ Defaultw/ Defaultw/ Default. 

5. Click OKOKOKOK    and then save your project. 

Redistribute w/ Default Redistribute w/ Default Redistribute w/ Default Redistribute w/ Default allows router to have a route to a destination that belongs to another Autonomous System. 

8.4.2.3. Application Configuration: 

1. Right-click on LAN_LAN_LAN_LAN_WestWestWestWest ⇒ Edit Edit Edit Edit AttributesAttributesAttributesAttributes ⇒ Assign AllAllAllAll to Application: Application: Application: Application: 

Supported ServicesSupported ServicesSupported ServicesSupported Services ⇒ Assign WestWestWestWest_Server_Server_Server_Server to the LAN Server Name attribute 

as shown ⇒ Click OKOKOKOK. 

Notice that two objects for Applications    and Profiles will be added automatically 
to the project. 

 

2. Right-click on LAN_LAN_LAN_LAN_EastEastEastEast ⇒ Edit Edit Edit Edit AttributesAttributesAttributesAttributes: 

i. Expand the Application: Supported ProfilesApplication: Supported ProfilesApplication: Supported ProfilesApplication: Supported Profiles hierarchy ⇒ Set rowsrowsrowsrows to 1111 ⇒ 

Expand the row 0row 0row 0row 0 hierarchy ⇒ Set Profile NameProfile NameProfile NameProfile Name    to EEEE----ccccommerceommerceommerceommerce    CustomerCustomerCustomerCustomer. 

ii. Edit the Application: Destination PreferencesApplication: Destination PreferencesApplication: Destination PreferencesApplication: Destination Preferences attribute as follows: 

Set rowsrowsrowsrows to 1111 ⇒ Set Symbolic NameSymbolic NameSymbolic NameSymbolic Name to HTTP Server HTTP Server HTTP Server HTTP Server ⇒ Edit Actual Name Actual Name Actual Name Actual Name ⇒ 

Set rowsrowsrowsrows to 1111 ⇒ In the new row, assign WestWestWestWest____Server Server Server Server to the Name Name Name Name column. 

3. Click OKOKOKOK three times and then save your project. 

8.4.3. Configure the Simulation 

Here we need to configure some of the simulation parameters: 
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1. Click on  and the Configure Simulation window should appear. 

2. Set the duration to be 10.0 minutes10.0 minutes10.0 minutes10.0 minutes. 

3. Click on the Global AttributesGlobal AttributesGlobal AttributesGlobal Attributes tab and make sure that the following attributes are 
assigned as follows: 

a. IP Interface Addressing Mode = IP Interface Addressing Mode = IP Interface Addressing Mode = IP Interface Addressing Mode = Auto Addressed/ExportAuto Addressed/ExportAuto Addressed/ExportAuto Addressed/Export. 

b.b.b.b. IP Routing Table Export/Import = ExportIP Routing Table Export/Import = ExportIP Routing Table Export/Import = ExportIP Routing Table Export/Import = Export.    

c. RIP Sim Efficiency = DisRIP Sim Efficiency = DisRIP Sim Efficiency = DisRIP Sim Efficiency = Disabledabledabledabled. If the attribute is enabled, RIP will stop after 
the „RIP Stop Time”. But we need the RIP to keep updating the routing table 
in case there is any change in the network. 

4. Click OKOKOKOK and then save the project. 

 

Auto AddressedAuto AddressedAuto AddressedAuto Addressed means that all IP interfaces are assigned. IP addresses automatically during simulation. The 
class of address (e.g., A, B, or C) is determined based on the number of hosts in the designed network. Subnet 
masks assigned to these interfaces are the default subnet masks for that class. 

ExportExportExportExport causes the auto assigned IP interface to be exported to a file (name of the file is 
<net_name>ip_addresses.gdf<net_name>ip_addresses.gdf<net_name>ip_addresses.gdf<net_name>ip_addresses.gdf and gets saved in the primary model directory). 

8.4.4. Choose the Statistics 

1. Right-click on LAN_LAN_LAN_LAN_EastEastEastEast    and select Choose Individual StatistiChoose Individual StatistiChoose Individual StatistiChoose Individual Statisticscscscs    from the 

pop-up menu ⇒ From the Client HTTP Client HTTP Client HTTP Client HTTP hierarchy choose the Traffic ReceivedTraffic ReceivedTraffic ReceivedTraffic Received    

(bytes/sec) (bytes/sec) (bytes/sec) (bytes/sec) statistic ⇒ Click OKOKOKOK. 

2. Right-click on the link that connects Router2Router2Router2Router2    to Router3Router3Router3Router3    and select Choose Choose Choose Choose 

Individual StatisticsIndividual StatisticsIndividual StatisticsIndividual Statistics    from the pop-up menu ⇒ From the pointpointpointpoint----ttttoooo----popopopoint int int int hierarchy 

choose the """"Throughput (bits/sec)Throughput (bits/sec)Throughput (bits/sec)Throughput (bits/sec)    ����" statistic ⇒ Click OKOKOKOK. 

Note:    If the name of the link is "Router3Router3Router3Router3 <-> Router2Router2Router2Router2" then you will need to choose 
the "Throughput (bits/sec)Throughput (bits/sec)Throughput (bits/sec)Throughput (bits/sec) " statistic instead. 

3. Right-click on the link that connects Router2Router2Router2Router2    to Router4Router4Router4Router4    and select Choose Choose Choose Choose 

Individual StatisticsIndividual StatisticsIndividual StatisticsIndividual Statistics    from the pop-up menu ⇒ From the pointpointpointpoint----totototo----point point point point hierarchy 

choose the """"Throughput (bits/sec)Throughput (bits/sec)Throughput (bits/sec)Throughput (bits/sec)    ����" statistic ⇒ Click OKOKOKOK. 
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Note::::    If the name of the link is "Router4Router4Router4Router4 <-> Router2Router2Router2Router2" then you will need to choose 
the """"TTTThroughput (bits/sec)hroughput (bits/sec)hroughput (bits/sec)hroughput (bits/sec)    " statistic instead. 

4. Save your project. 

8.4.5. Router Interfaces and IP Addresses 

Before setting up the routers to use BGP, we need to get the information of the 
routers' interfaces along with the IP addresses associated to these interfaces. 
Recall that these IP addresses are assigned automatically during simulation, and 
we set the global attribute IP Interface Addressing ModeIP Interface Addressing ModeIP Interface Addressing ModeIP Interface Addressing Mode to export this information to 
a file. 

1. First we need to run the simulation. Click on  and the Configure Simulation 
window should appear ⇒ Click on RunRunRunRun. 

2. After the simulation run completes click CloseCloseCloseClose. 

3. From the FileFileFileFile menu choose Model Model Model Model FilesFilesFilesFiles    ⇒ Refresh Model DirectorieRefresh Model DirectorieRefresh Model DirectorieRefresh Model Directories. This 
causes OPNET IT Guru to search the model directories and update its list of 
files. 

4. From the FileFileFileFile menu choose OpenOpenOpenOpen. ⇒ From the drop-down menu choose 

Generic Data FileGeneric Data FileGeneric Data FileGeneric Data File ⇒ Select the <your initials><your initials><your initials><your initials>_BGP_BGP_BGP_BGP----No_BGPNo_BGPNo_BGPNo_BGP----ipipipip____addressesaddressesaddressesaddresses file 

⇒ Click OKOKOKOK.... 

The file that contains all the information about router interfaces and their IP 
addresses will open. Table 1 shows the interface number and IP addresses 
between the six routers in our projects. For example Router1Router1Router1Router1 is connected to 
Router2Router2Router2Router2 through interface (IF) 11, which is assigned 192.0.1.1 as its IP address. A 
router is connected to itself by a Loop-back interface as shown. Create a similar 
table for your project but note that your result may vary due to different nodes 
placement. 

Table 1: Interfaces that connect the routers and their assigned IP addresses. 

Routers 1 2 3 4 5 6 

1 
IF: 12 
IP: 192.0.2.1 

IF: 11 
IP: 192.0.1.1 

    

2 
IF: 10 
IP: 192.0.1.2 

IF: 12 
IP: 192.0.8.1 

IF:11 
IP: 192.0.4.2 

lF:4 
IP: 192.0.7.1 

  

3  
IF: 10 
IP: 192.0.4.1 

IF: 12 
IP: 192.0.6.1 

IF: 11 
IP: 192.0.5.1 

IF: 4 
IP: 192.0.3.1 

 

4  
IF: 10 
IP: 192.0.7.2 

IF: 11 
IP: 192.0.5.2 

IF: 12 
IP: 192.010.1 

IF 4 
IP: 192.0.9.1 

 

5   
IF: 10 
IP: 192.0.3.2 

IF: 11 
IP: 192.0.9.2 

IF: 12 
IP: 192.0.12.1 

IF: 4 
IP: 1920.11.1 

6     
IF: 10 
IP: 192.0.11.2 

IF: 12 
IP: 192.0.14.1 

8.4.6. Creating the BGP Scenario 

In the network we just created, all routers belong to the same autonomous system. 
We will divide the network into three autonomous systems and utilize BGP to route 
packets among these systems. 

1. Select Duplicate ScenarioDuplicate ScenarioDuplicate ScenarioDuplicate Scenario    from the ScenariosScenariosScenariosScenarios menu and name it BGP_SimpleBGP_SimpleBGP_SimpleBGP_Simple    

⇒ Click OKOKOKOK. 
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2. Highlight or select simultaneously (using shift and left-click) Router1Router1Router1Router1 and 

Router2Router2Router2Router2 ⇒ Right-click on Router1Router1Router1Router1 ⇒ Edit Edit Edit Edit AttributesAttributesAttributesAttributes ⇒ Check the Apply Apply Apply Apply 
Changes to Selected ObjectsChanges to Selected ObjectsChanges to Selected ObjectsChanges to Selected Objects check box. 

3. Expand the IP Routing ParametersIP Routing ParametersIP Routing ParametersIP Routing Parameters hierarchy and set the Autonomous System Autonomous System Autonomous System Autonomous System 

NumberNumberNumberNumber to 12121212 ⇒ Click OKOKOKOK. 

4. Repeat steps 2 and 3 above for routers Router3Router3Router3Router3 and Router4Router4Router4Router4. Assign their 
Autonomous System NumberAutonomous System NumberAutonomous System NumberAutonomous System Number to 34343434. 

5. Repeat steps 2 and 3 above for routers Router5Router5Router5Router5 and Router6Router6Router6Router6. Assign their 
Autonomous System NumberAutonomous System NumberAutonomous System NumberAutonomous System Number to 56565656. 

The following figure shows the created autonomous systems. The figure shows also 
the interfaces that connect routers across different autonomous systems. There 
interfaces are taken from Table 1 above (note: the interface numbers in your project 
may vary). The next step is to disable the RIP protocol on the shown interfaces. 

 

6. Right-click on Router2Router2Router2Router2 ⇒ Edit Edit Edit Edit AttributesAttributesAttributesAttributes ⇒ Expand the IP Routing ParametersIP Routing ParametersIP Routing ParametersIP Routing Parameters 

hierarchy ⇒ Expand the Interface InformationInterface InformationInterface InformationInterface Information hierarchy ⇒ Expand row 4row 4row 4row 4 

hierarchy. ⇒ Click on the values of the Routing Protocol(s)Routing Protocol(s)Routing Protocol(s)Routing Protocol(s) attribute ⇒ Disable 

RIPRIPRIPRIP as shown ⇒ Click OKOKOKOK twice. 
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7. Repeat step 6 above for all other interfaces that connect routers across 
autonomous systems (i.e., All the eight inter-domain interfaces shown above). 

8. Save your project. 

8.4.7. Configuring the BGP Neighbor Information 

If you try to run the simulation of the BGP_SimpleBGP_SimpleBGP_SimpleBGP_Simple scenario, you will receive 
hundreds of errors! This is because there is no routing protocol running between the 
inter-domain routers. Therefore, no routing tables are created to deliver packets 
among autonomous systems. The solution is to utilize BGP by defining the 
neighbors of inter-domain routers. Table 2 shows the neighbors of the routers that 
will run BGP. Neighbors are defined by their interface IP address and the AS 
number. For each router in Table 2 carry out the following step: 

1. Right-click on the router ⇒ Edit Edit Edit Edit AttributesAttributesAttributesAttributes ⇒ Expand the BGP ParametersBGP ParametersBGP ParametersBGP Parameters 

hierarchy ⇒ Expand the Neighbor InformationNeighbor InformationNeighbor InformationNeighbor Information hierarchy ⇒ Assign to the rowsrowsrowsrows 
attribute the value 1 for Router1Router1Router1Router1 and Router6Router6Router6Router6. For all other routers, assign the 

value 3 to the rowsrowsrowsrows attribute ⇒ Utilize Table 2 to assign the corresponding 
values to the IP AddressIP AddressIP AddressIP Address, Remote ASRemote ASRemote ASRemote AS, and Update SourceUpdate SourceUpdate SourceUpdate Source attributes for each of 
the added rows. 

Note:    the values to be assigned to the IP AddressIP AddressIP AddressIP Address attribute have to match the values 
you will collect in your Table 1. 

2. Save your project. 

Table 2: Neighbors’ info for inter-domain routers. 

BGP ParametersBGP ParametersBGP ParametersBGP Parameters ⇒⇒⇒⇒ Neighbor InformationNeighbor InformationNeighbor InformationNeighbor Information 
Routers 

row 0row 0row 0row 0 row 1 row 2 

Router1Router1Router1Router1 
IP Address: 192.0.8.1 
Remote AS: 12 
Update Source: Loopback 

  

Router2Router2Router2Router2 
IP Address 192.0.4.1 
Remote AS: 34 
Update Source Not Used 

IP Address: 192.0.7.2 
Remote AS: 34 
Update Source Not Used 

IP Address: 192.0.2.1 
Remote AS: 12 
Update Source: Loopback 
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BGP ParametersBGP ParametersBGP ParametersBGP Parameters ⇒⇒⇒⇒ Neighbor InformationNeighbor InformationNeighbor InformationNeighbor Information 
Routers 

row 0row 0row 0row 0 row 1 row 2 

Router3Router3Router3Router3 
IP Address 192.0.4.2 
Remote AS: 12 
Update Source Not Used 

IP Address: 192.0.3.2 
Remote AS: 56 
Update Source: Not Used 

IP Address: 192.0.10.1 
Remote AS: 34 
Update Source: Loopback 

Router4Router4Router4Router4 
IP Address: 192.0.7.1 
Remote AS: 12 
Update Source: Not Used 

IP Address: 192 0.9.2 
Remote AS: 56 
Update Source: Not Used 

IP Address: 192.0.6.1 
Remote AS: 34 
Update Source: Loopback 

Router5Router5Router5Router5 
IP Address: 192.0.3.1 
Remote AS: 34 
Update Source: Not Used 

IP Address: 192.0.9.1 
Remote AS: 34 
Update Source: Not Used_ 

IP Address 192.0.14.1 
Remote AS: 56 
Update Source: Loopback 

Router6Router6Router6Router6 
IP Address: 192.0.12.1 
Remote AS: 56 
Update Source: Loopback 

  

8.4.8. Creating the BGP with Policy Scenario 

BGP allows for routing policies that can be enforced using route maps. We will 
utilize this feature to configure Router2Router2Router2Router2 to redirect its load on the two egress links of 
its autonomous system. 

1. First make sure that your project is in the BGP_SimpleBGP_SimpleBGP_SimpleBGP_Simple    scenario. Select 

Duplicate ScenarioDuplicate ScenarioDuplicate ScenarioDuplicate Scenario    from the ScenariosScenariosScenariosScenarios menu and name it BGP_Policy BGP_Policy BGP_Policy BGP_Policy ⇒ Click 
OKOKOKOK. 

2. Right-click on Router2Router2Router2Router2 ⇒ Edit Edit Edit Edit AttributesAttributesAttributesAttributes ⇒ Expand the IP Routing ParametersIP Routing ParametersIP Routing ParametersIP Routing Parameters 

hierarchy ⇒ Expand the Route Map ConfigurRoute Map ConfigurRoute Map ConfigurRoute Map Configurationationationation hierarchy. ⇒ Set the 
attributes as shown in the following figure. 

The purpose of the created route map is to reduce the degree of preference of 
the "route to AS 56" to the value 10 (Note: the normal value is "99", which is 
calculated as 100 - number of AS that should be crossed to reach the 
destination). 
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The next step is to assign the above route map to the link connecting Router2Router2Router2Router2 to 
Router3Router3Router3Router3. This way traffic from Router2Router2Router2Router2 to AS 56 will be preferred to go through 
Router4Router4Router4Router4 instead. 

3. Right-click on RouteRouteRouteRouter2r2r2r2 ⇒ Edit Edit Edit Edit AttributesAttributesAttributesAttributes ⇒ Expand the BGP ParametersBGP ParametersBGP ParametersBGP Parameters 

hierarchy ⇒ Expand the Neighbor InformationNeighbor InformationNeighbor InformationNeighbor Information hierarchy ⇒ Expand the row that 

has the IP address of Router3Router3Router3Router3 interface (it is row 0row 0row 0row 0 in my project) ⇒ Expand the 

Routing PoliciesRouting PoliciesRouting PoliciesRouting Policies hierarchy ⇒ Set its attribute as shown in the following figure. 

4. Click OKOKOKOK and save your project. 

 

8.4.9. Run the Simulation 

To run the simulation for the three scenarios simultaneously: 

1. Go to the ScenariosScenariosScenariosScenarios menu ⇒ Select Manage ScenariosManage ScenariosManage ScenariosManage Scenarios.... 

2. Change the values under the ResultsResultsResultsResults column to <collectcollectcollectcollect> (or <recollectrecollectrecollectrecollect>) for the 
three scenarios. Compare to the following figure. 
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3. Click OKOKOKOK to run the three simulations. Depending on the speed of your 
processor, this may take several minutes to complete. 

4. After the three simulation runs complete, one for each scenario, click CloseCloseCloseClose. ⇒ 
Save your project. 

8.4.10. View the Results 

8.4.10.1. Compare the Routing Tables Content: 

1. To check the content of the routing tables in Router2Router2Router2Router2    for both scenarios: 

i. Go to the ResultsResultsResultsResults menu ⇒ Open Simulation Log Simulation Log Simulation Log Simulation Log ⇒ Expand the hierarchy on 

the left as shown below ⇒ Click on the field COMMON ROUTE TABLE COMMON ROUTE TABLE COMMON ROUTE TABLE COMMON ROUTE TABLE in 
the row corresponds to RouRouRouRoutttter2er2er2er2. 

 

2. Carry out the previous step for scenario No_BGPNo_BGPNo_BGPNo_BGP and scenario BGP_SimpleBGP_SimpleBGP_SimpleBGP_Simple. 
The following are partial contents of Router2Router2Router2Router2’s routing table for both scenarios 
(Note: Your results may vary due to different nodes placement): 

Routing table of Router2Router2Router2Router2 for the No_BGPNo_BGPNo_BGPNo_BGP scenario. 

 

Routing table of Router2Router2Router2Router2 for the BGP_SimpleBGP_SimpleBGP_SimpleBGP_Simple scenario: 
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8.4.10.2. Compare the load in the network: 

1. Select Compare ResultsCompare ResultsCompare ResultsCompare Results from the ResultsResultsResultsResults menu. 

2. Change the drop-down menu in the right-lower part of the Compare ResultsCompare ResultsCompare ResultsCompare Results 
dialog box from As IsAs IsAs IsAs Is    to time_averagetime_averagetime_averagetime_average    as shown. 

 

3. Select and show the graphs of the following statistics: Traffic ReceivedTraffic ReceivedTraffic ReceivedTraffic Received in 
LAN_LAN_LAN_LAN_EastEastEastEast, throughput in the Router2Router2Router2Router2-Router3Router3Router3Router3 link, and throughput in the 
Router2Router2Router2Router2-Router4Router4Router4Router4 link. The resulting graphs should resemble the graphs below. 
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8.5. Further readings 

• A Border Gateway Protocol 4 (BGP-4): IETF RFC number 1771 
(www.ietf.org/rfc.html). 

• Application of the Border Gateway Protocol in the Internet: IETF RFC number 1772 
(www.ietf.org/rfc.html). 

• BGP4 Protocol Analysis: IETF RFC number 1774 (www.ietf.org/rfc.html). 

8.6. Exercises 

1) Obtain and analyze the routing table for Router5Router5Router5Router5 in the project before and after 
applying BGPBGPBGPBGP. 

2) Analyze the graphs that show the throughput in both Router2Router2Router2Router2-Router3Router3Router3Router3 link and 
Router2Router2Router2Router2-Router4Router4Router4Router4 link. Explain the effect of applying the routing policy on these 
throughputs. 

3) Create another scenario as a duplicate of the BGP_SimpleBGP_SimpleBGP_SimpleBGP_Simple    scenario. Name the 
new scenario BGPBGPBGPBGP_OSPF_OSPF_OSPF_OSPF_RIP. _RIP. _RIP. _RIP. In this new scenario change the intra-domain 
routing protocol in AS 56 AS 56 AS 56 AS 56 to be OSPF OSPF OSPF OSPF instead of RIP. RIP. RIP. RIP. Run the new scenario and 
check the contents of Router5Router5Router5Router5’s    routing table. Analyze the content of this table. 

8.7. Lab Report 

Prepare a report that follows the guidelines explained in Lab 0. The report should 
include the answers to the above exercises as well as the graphs you generated 
from the simulation scenarios. Discuss the results you obtained and compare these 
results with your expectations. Mention any anomalies or unexplained behaviors. 
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9. Laboratory - TCP: Transmission Control Protocol (A Reliable, 
Connection-Oriented, Byte-Stream Service) 

9.1. Objective 

This lab is designed to demonstrate the congestion control algorithms implemented 
by the Transmission Control Protocol (TCP). The lab provides a number of 
scenarios to simulate these algorithms. You will compare the performance of the 
algorithms through the analysis of the simulation results. 

9.2. Overview 

The Internet's TCP guarantees the reliable, in-order delivery of a stream of bytes. It 
includes a flow-control mechanism for the byte streams that allows the receiver to 
limit how much data the sender can transmit at a given time. In addition, TCP 
implements a highly tuned congestion-control mechanism. The idea of this 
mechanism is to throttle how fast TCP sends data to keep the sender from 
overloading the network 

The idea of TCP congestion control is for each source to determine how much 
capacity is available in the network, so that it knows how many packets it can safely 
have in transit. It maintains a state variable for each connection, called the 
congestion window, which is used by the source to limit how much data the source is 
allowed to have in transit at a given time. TCP uses a mechanism, called additive    
increase/multiplicative decrease,,,,    that decreases the congestion window when the 
level of congestion goes up and increases the congestion window when the level of 
congestion goes down. TCP interprets timeouts as a sign of congestion. Each time 
a timeout occurs, the source sets the congestion window to half of its previous 
value. This halving corresponds to the multiplicative decrease    part of the 
mechanism. The congestion window is not allowed to fall below the size of a single 
packet (the TCP maximum segment size, or MSS). Every time the source 
successfully sends a congestion window worth of packets, it adds the equivalent of 
one packet to the congestion window; this is the additive increase    part of the 
mechanism. 

TCP uses a mechanism called slow start    to increase the congestion window 
"rapidly" from a cold start in TCP connections. It increases the congestion window 
exponentially, rather than linearly. Finally, TCP utilizes a mechanism called fast 
retransmit and fast recovery. Fast retransmit is a heuristic that sometimes triggers 
the retransmission of a dropped packet sooner than the regular timeout mechanism 

In this lab you will set up a network that utilizes TCP as its end-to-end transmission 
protocol and analyze the size of the congestion window with different mechanisms. 

9.3. Prelab Activities 

• Read sections 5.1 and 5.2 from "Computer Networks: A Systems Approach""Computer Networks: A Systems Approach""Computer Networks: A Systems Approach""Computer Networks: A Systems Approach", , , , 4th 
EditionEditionEditionEdition. 

Go to www.netwww.netwww.netwww.net----seal.net/animations.phpseal.net/animations.phpseal.net/animations.phpseal.net/animations.php    and play the following animations: 
• TCP Connections. 

• TCP Multiplexing. 

• TCP Buffering and Sequencing. 

• User Datagram Protocol (UDP). 



 

 network simulation experiments manual.doc utorak, 28. rujan 2010 100 

9.4. Procedure 

9.4.1. Create a New Project 

1. Start OPNET IT Guru Academic Edition    ⇒ Choose New    from the File menu. 

2. Select Project and Click OK ⇒ Name the project <your initials><your initials><your initials><your initials>_TCP, and the 

scenario No_Drop ⇒ Click OK. 

3. In the Startup Wizard: Initial Topology dialog box, make sure that Create Empty 

Scenario is selected ⇒ Click Next - ⇒ Select Choose From Maps from the 

Network Scale list ⇒ Click Next ⇒ Choose USA from the Map List ⇒ Click Next 

twice ⇒ Click OK. 

9.4.2. Create and Configure the Network 

9.4.2.1. Initialize the Network: 

1. The Object Palette    dialog box should now be on the top of your project space. If 

it is not there, open it by clicking . Make sure that the internet_toolbox item is 
selected from the pull-down menu on the object palette. 

2. Add to the project workspace the following objects from the palette: Application 
Config, Profile Config, an ip32_Cloud, and two subnets. 

a. To add an object from a palette, click its icon in the object palette ⇒ Move 

your mouse to the workspace ⇒ Click to drop the object in the desired 

location ⇒ Right-click to finish creating objects of that type. 

3. Close the palette. 

4. Rename the objects you added as shown and then save your project: 

 

The ip32_cloudip32_cloudip32_cloudip32_cloud node model represents an IP cloud supporting up to 32 serial line interfaces at a selectable data 
rate through which IP traffic can be modeled. IP packets arriving on any cloud interface are routed to the 
appropriate output interface based on their destination IP address. The RIP or OSFP protocol may be used to 
automatically and dynamically create the cloud’s routing tables and select routes in an adaptive manner. This 
cloud requests a fixed amount of time to route each packet, as determined by the Packet LatencyPacket LatencyPacket LatencyPacket Latency attribute of the 
node. 



 

 network simulation experiments manual.doc utorak, 28. rujan 2010 101 

9.4.2.2. Configure the Applications: 

1. Right-click on the Applications node ⇒ Edit Edit Edit Edit Attributes ⇒ Expand the Application 

Definitions attribute and set rows to 1 ⇒ Expand the new row ⇒ Name the row 
FTP_Application. 

i. Expand the DescriptionDescriptionDescriptionDescription hierarchy. ⇒ Edit the FTP FTP FTP FTP row as shown (you will 
need to set the Special Value Special Value Special Value Special Value to Not Used Not Used Not Used Not Used while editing the shown 
attributes): 

  

2. Click OK twice and then save your project. 

9.4.2.3. Configure the Profiles: 

1. Right-click on the Profiles node ⇒ Edit Edit Edit Edit Attributes ⇒ Expand the Profile 
Configuration attribute and set rows to 1. 

i. Name and set the attributes of row 0row 0row 0row 0 as shown ⇒ Click OKOKOKOK. 
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9.4.2.4. Configure the West Subnet: 

1. Double-click on the West subnet node. You get an empty workspace, indicating 
that the subnet contains no objects. 

2. Open the object palette  and make sure that the internet_toolbox item is 
selected from the pull-down menu. 

3. Add the following items to the subnet workspace: one ethernet_server, , , , one 
ethernet4_slip8_gtwy    router, and connect them with a bidirectional 100_BaseT    

link ⇒    Close    the palette ⇒ Rename the objects as shown. 

 

The ethernet4_slip8ethernet4_slip8ethernet4_slip8ethernet4_slip8____gtwygtwygtwygtwy mode model represents an IP-based gateway supporting four Ethernet hub 
interfaces and eight serial line interfaces. 

1. Right-click on the Server_West node ⇒ Edit Edit Edit Edit Attributes: 

i. Edit Application: Application: Application: Application: Supported ServicesSupported ServicesSupported ServicesSupported Services    ⇒ Set rowsrowsrowsrows to 1111 ⇒ Set NameNameNameName to 

FTPApplication FTPApplication FTPApplication FTPApplication ⇒    Click OKOKOKOK....    

ii. Edit the value of the Server AddressServer AddressServer AddressServer Address attribute and write down Server_Server_Server_Server_WestWestWestWest.    

iii. Expand the TCP ParametersTCP ParametersTCP ParametersTCP Parameters    hierarchy ⇒ Set both Fast RetransmitFast RetransmitFast RetransmitFast Retransmit    and 
Fast RecoveryFast RecoveryFast RecoveryFast Recovery    to DisDisDisDisableableableabled.d.d.d.    

2. Click OK and then save your project. 

Now, you have completed the configuration of the WestWestWestWest subnet. To go back to the 

top level of the project, click the Go to next higher levelGo to next higher levelGo to next higher levelGo to next higher level     button. 

9.4.2.5. Configure the East Subnet: 

1. Double-click on the East subnet node. You get an empty workspace, indicating 
that the subnet contains no objects. 

2. Open the object palette  and make sure that the internet_toolbox item is 
selected from the pull-down menu. 

3. Add the following items to the subnet workspace: one ethernet_wkstn, one 
ethernet4_slip8_gtwy router, and connect them with a bidirectional 100_BaseT 

link ⇒ Close the palette ⇒ Rename the objects as shown. 

 

4. Right-click on the Client_East node ⇒ Edit Edit Edit Edit Attributes: 

i. Expand the Application: Supported ProfilesApplication: Supported ProfilesApplication: Supported ProfilesApplication: Supported Profiles hierarchy ⇒ Set rowsrowsrowsrows to 1111 ⇒ 

Expand the row 0row 0row 0row 0 hierarchy ⇒ Set Profile NameProfile NameProfile NameProfile Name    to FTP_PFTP_PFTP_PFTP_Profilerofilerofilerofile.... 

ii. Assign Client_ Client_ Client_ Client_ EastEastEastEast    to the Client AddressClient AddressClient AddressClient Address    attributes. 
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iii. Edit the Application: Destination PreferencesApplication: Destination PreferencesApplication: Destination PreferencesApplication: Destination Preferences    attribute as follows: 

Set rowsrowsrowsrows to 1111 ⇒ Set Symbolic NameSymbolic NameSymbolic NameSymbolic Name to FTP ServerFTP ServerFTP ServerFTP Server    ⇒ Edit Actual Name Actual Name Actual Name Actual Name ⇒ 

Set rowsrowsrowsrows to 1111 ⇒ In the new row, assign Server_Server_Server_Server_WestWestWestWest    to the Name Name Name Name column. 

5. Click OK three times and then save your project. 

6. You have now completed the configuration of the East subnet. To go back to the 

project space, click the Go to next higher levelGo to next higher levelGo to next higher levelGo to next higher level  button. 

9.4.2.6. Connect the Subnets to the IP Cloud: 

1. Open the object palette . 

2. Using two PPP_DS3 bidirectional links connect the East subnet to the IP Cloud 
and the West subnet to the IP Cloud. 

3. A pop-up dialog box will appear asking you what to connect the subnet to the IP 
Cloud with. Make sure to select the "routers." 

4. Close the palette. 

 

9.4.3. Choose the Statistics 

1. Right-click on Server_Server_Server_Server_WestWestWestWest in the WestWestWestWest subnet and select Choose IndividualChoose IndividualChoose IndividualChoose Individual 
StatisticsStatisticsStatisticsStatistics from the pop-up menu. 

2. In the Choose ResultsChoose ResultsChoose ResultsChoose Results dialog box, choose the following statistic: 

3. TCP Connection    ⇒    Congestion Window SizeCongestion Window SizeCongestion Window SizeCongestion Window Size (bytes)    and Sent Sent Sent Sent Segment Segment Segment Segment 
Sequence NumberSequence NumberSequence NumberSequence Number. 

4. Right-click on the Congestion Window SizeCongestion Window SizeCongestion Window SizeCongestion Window Size (bytes) statistic ⇒ Choose Choose Choose Choose Change Change Change Change 

Collection ModeCollection ModeCollection ModeCollection Mode ⇒ In the dialog box check AdvancedAdvancedAdvancedAdvanced ⇒ From the drop-down 

menu assign all values to CaptureCaptureCaptureCapture mode as shown ⇒ Click OK. 
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OPNET provides the following capture modes: 

• All values – collects every data point from a statistic. 

• Sample – collects the data according to a user specified time interval or sample count. For example, if the 
time interval is 10, data is sampled and recorded every 10

th
 second. If the sample count is 10, every 10

th
 data 

points is recorded. All other data points are discarded. 

• Bucket – collects all of the points over the time interval or sample count into a “data busket” and generates a 
result from each bucket. This is the default mode. 

5. Right-click on the Sent Segment Sequence Number statistic ⇒ Choose Change 

Collection Mode ⇒ In the dialog box check Advanced ⇒ From the drop-down 
menu, assign all values to Capture mode. 

6. Click OK twice and then save your project. 

7. Click the Go to next higher level  button. 

9.4.4. Configure the Simulation 

Here we need to configure the duration of the simulation: 

1. Click on  and the Configure Simulation window should appear. 

2. Set the duration to be 10.0 minutes. 

3. Click OK and then save your project. 

9.4.5. Duplicate the Scenario 

In the network we just created we assumed a perfect network with no discarded 
packets. Also, we disabled the fast retransmit and fast recovery techniques in TCP. 
To analyze the effects of discarded packets and those congestion-control 
techniques, we will create two additional scenarios. 

1. Select Duplicate ScenarioDuplicate ScenarioDuplicate ScenarioDuplicate Scenario from the ScenariosScenariosScenariosScenarios menu and give it the name 

Drop_NoFastDrop_NoFastDrop_NoFastDrop_NoFast ⇒ Click OKOKOKOK. 

2. In the new scenario, right-click on the IP CloudIP CloudIP CloudIP Cloud ⇒    Edit Edit Edit Edit AttributesAttributesAttributesAttributes ⇒    Assign 
0.05%0.05%0.05%0.05% to the Packet Discard RatioPacket Discard RatioPacket Discard RatioPacket Discard Ratio attribute. 

3. Click OKOKOKOK and then save your project. 

4. While you are still in the Drop_NoFastDrop_NoFastDrop_NoFastDrop_NoFast scenario, select Duplicate ScenarioDuplicate ScenarioDuplicate ScenarioDuplicate Scenario from 
the ScenariosScenariosScenariosScenarios menu and give it the name DropDropDropDrop_Fast_Fast_Fast_Fast. 
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5. In the Drop_FastDrop_FastDrop_FastDrop_Fast scenario, right-click on Server_ Server_ Server_ Server_ WestWestWestWest, which is inside the WestWestWestWest 

subnet ⇒    Edit Edit Edit Edit AttributesAttributesAttributesAttributes ⇒    Expand the TCP ParametersTCP ParametersTCP ParametersTCP Parameters hierarchy ⇒ EnEnEnEnableableableable 

the Fast RetransmitFast RetransmitFast RetransmitFast Retransmit attribute ⇒ Assign RenoRenoRenoReno to the Fast RecoveryFast RecoveryFast RecoveryFast Recovery attribute. 

6. Click OKOKOKOK and then save your project. 

With fast transmitfast transmitfast transmitfast transmit, TCP performs a retransmission of what appears to be the missing segment for a retransmission 
timer to expire. After fast retransmit sends what appears to be the missing segment, congestion advance but not 
slow start is performed. This is the fast recoveryfast recoveryfast recoveryfast recovery algorithm. The fast retransmit and fast recovery algorithms are 
usually implemented together (RFC 2001). 

9.4.6. Run the Simulation 

To run the simulation for the three scenarios simultaneously: 

1. Go to the ScenariosScenariosScenariosScenarios menu ⇒ Select Manage ScenariosManage ScenariosManage ScenariosManage Scenarios.... 

2. Change the values under the ResultsResultsResultsResults column to <collectcollectcollectcollect> (or <recollectrecollectrecollectrecollect>) for 

the three scenarios. Compare to the following figure. 

 

3. Click OKOKOKOK    to run the three simulations. Depending on the speed of your 
processor, this may take several minutes to complete. 

4. After the three simulation runs complete, one for each scenario, click CloseCloseCloseClose    ⇒    
Save your project. 

9.4.7. View the Results 

To view and analyze the results. 

1. Switch to the Drop_NoFastDrop_NoFastDrop_NoFastDrop_NoFast    scenario (the second one) and choose View Results View Results View Results View Results 
from the ResultsResultsResultsResults menu. 

2. Fully expand the Object Statistics Object Statistics Object Statistics Object Statistics hierarchy and select the following two results: 
Congestion Window SizeCongestion Window SizeCongestion Window SizeCongestion Window Size (bytes) (bytes) (bytes) (bytes)    and Sent Sent Sent Sent Segment Sequence NumberSegment Sequence NumberSegment Sequence NumberSegment Sequence Number. 

To switch to a scenario, choose Switch to ScenarioSwitch to ScenarioSwitch to ScenarioSwitch to Scenario from the ScenariosScenariosScenariosScenarios menu or just press Ctrl+<scenario Ctrl+<scenario Ctrl+<scenario Ctrl+<scenario 
number>number>number>number>    
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3. Click ShowShowShowShow. The resulting graphs should resemble the ones below. 

 

4. To zoom in on the details in the graph, click and drag your mouse to draw a 
rectangle, as shown above. 

5. The graph should be redrawn to resemble the following one: 
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6. Notice the Segment Sequence NumberSegment Sequence NumberSegment Sequence NumberSegment Sequence Number is almost flat with every drop in the 
congestion window. 

7. Close the View Results dialog box and select Compare ResultsCompare ResultsCompare ResultsCompare Results from the Result Result Result Result 
menu. 

8. Fully expand the Object StatisticsObject StatisticsObject StatisticsObject Statistics hierarchy as shown and select the following 
result: Sent Sent Sent Sent Segment Sequence NumberSegment Sequence NumberSegment Sequence NumberSegment Sequence Number. 

 

9. Click ShowShowShowShow. After zooming in, the resulting graph should resemble the one 
below. 
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9.5. Further readings 

• OPNET TCP Model Description: From the ProProProProtocolstocolstocolstocols menu, select TCP TCP TCP TCP ⇒    Model 
Usage Guide.    

• Transmission Control Protocol: IETF RFC number 793 (www.ietf.org/rfc.html). 

9.6. Exercises 

1) Why does the Segment Sequence NumberSegment Sequence NumberSegment Sequence NumberSegment Sequence Number remain unchanged (indicated by a 
horizontal line in the graphs) with every drop in the congestion window? 

2) Analyze the graph that compares the SeSeSeSegment Sequence gment Sequence gment Sequence gment Sequence numbers of the three 
scenarios. Why does the Drop_NoFastDrop_NoFastDrop_NoFastDrop_NoFast    scenario have the slowest growth in 
sequence numbers? 

3) In the Drop_NoFastDrop_NoFastDrop_NoFastDrop_NoFast    scenario, obtain the overlaid graph that compares Sent Sent Sent Sent 
Segment Sequence NumberSegment Sequence NumberSegment Sequence NumberSegment Sequence Number    with Received Segment ACK NumberReceived Segment ACK NumberReceived Segment ACK NumberReceived Segment ACK Number    for 
Server_Server_Server_Server_WestWestWestWest. . . . Explain the graph. 

Hint: 

Make sure to assign all valuesall valuesall valuesall values to the Capture modeCapture modeCapture modeCapture mode    of the Received Segment Received Segment Received Segment Received Segment 
ACK Number ACK Number ACK Number ACK Number statistic. 

4) Create another scenario as a duplicate of the Drop_FastDrop_FastDrop_FastDrop_Fast    scenario. Name the 
new scenario Q4_Q4_Q4_Q4_Drop_FastDrop_FastDrop_FastDrop_Fast_Buf_Buf_Buf_Buffffferererer. In the new scenario, edit the attributes of 
the Client_EastClient_EastClient_EastClient_East node and assign 65535 to its Receiver Buffer (bytes) Receiver Buffer (bytes) Receiver Buffer (bytes) Receiver Buffer (bytes) attribute 
(one of the TCP ParametersTCP ParametersTCP ParametersTCP Parameters). Generate a graph that shows how the Congestion Congestion Congestion Congestion 
Window SizeWindow SizeWindow SizeWindow Size (bytes) (bytes) (bytes) (bytes)    of Server_Server_Server_Server_WestWestWestWest    gets affected by the increase in the 
receiver buffer (compare the congestion window size graph from the Drop_FastDrop_FastDrop_FastDrop_Fast    
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scenario with the corresponding graph from the Q4_Q4_Q4_Q4_Drop_FastDrop_FastDrop_FastDrop_Fast_Buffer _Buffer _Buffer _Buffer 
scenario.) 

9.7. Lab Report 

Prepare a report that follows the guidelines explained in Lab 0. The report should 
include the answers to the above exercises as well as the graphs you generated 
from the simulation scenarios. Discuss the results you obtained and compare these 
results with your expectations. Mention any anomalies or unexplained behaviors. 
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10. Laboratory - Queuing Disciplines (Order of Packet Transmission and 
Dropping) 

10.1. Objective 

The objective of this lab is to examine the effect of different queuing disciplines on 
packet delivery and delay for different services. 

10.2. Overview 

As part of the resource allocation mechanisms, each router must implement some 
queuing discipline that governs how packets are buffered while waiting to be 
transmitted. Various queuing disciplines can be used to control which packets get 
transmitted (bandwidth allocation) and which packets get dropped (buffer space). 
The queuing discipline also affects the latency experienced by a packet, by 
determining how long a packet waits to be transmitted. Examples of the common 
queuing disciplines are first-in-first-out (FIFO) queuing, priority queuing (PQ), and 
weighted-fair queuing (WFQ). 

The idea of FIFO queuing is that the first packet that arrives at a router is the first 
packet to be transmitted. Given that the amount of buffer space at each router is 
finite, if a packet arrives and the queue (buffer space) is full, then the router discards 
(drops) that packet. This is done without regard to which flow the packet belongs to 
or how important the packet is. 

PQPQPQPQ is a simple variation of the basic FIFO queuing. The idea is to mark each packet 
with a priority; the mark could be carried, for example, in the IP Type of Service 
(ToS) field. The routers then implement multiple FIFO queues, one for each priority 
class. Within each priority, packets are still managed in a FIFO manner. This 
queuing discipline allows high-priority packets to cut to the front of the line. 

The idea of the fair queuing (FQ) discipline is to maintain a separate queue for each 
flow currently being handled by the router. The router then services these queues in 
a round-robin manner. WFQ allows a weight to be assigned to each flow (queue). 
This weight effectively controls the percentage of the link's bandwidth each flow will 
get. We could use ToS bits in the IP header to identify that weight. 

In this lab you will set up a network that carries three applications: FTP, Video, and 
VoIP. You will study how the choice of the queuing discipline in the routers can 
affect the performance of the applications and the utilization of the network 
resources. 

10.3. Prelab Activities 

• Read section 6.2 from "Com"Com"Com"Computer Networks: A Systems Approach"puter Networks: A Systems Approach"puter Networks: A Systems Approach"puter Networks: A Systems Approach", , , , 4th EditionEditionEditionEdition....    

Go to www.netwww.netwww.netwww.net----seal.net/animations.phpseal.net/animations.phpseal.net/animations.phpseal.net/animations.php    and play the following animations: 
• Switch Congestion. 

• IP Fragmentation. 

10.4. Procedure 

10.4.1. Create a New Project 

1. Start OPNET IT Guru Academic EditionOPNET IT Guru Academic EditionOPNET IT Guru Academic EditionOPNET IT Guru Academic Edition    ⇒ Choose NewNewNewNew    from the FileFileFileFile menu. 
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2. Select ProjectProjectProjectProject and Click OKOKOKOK ⇒ Name the project <your initials><your initials><your initials><your initials>_Queues_Queues_Queues_Queues, and 

the scenario FIFOFIFOFIFOFIFO ⇒ Click OKOKOKOK. 

3. In the Startup Wizard: Initial Topology dialog box, make sure that Create Empty Create Empty Create Empty Create Empty 

ScenarioScenarioScenarioScenario is selected ⇒ Click NextNextNextNext ⇒ Select CampusCampusCampusCampus from the Network Scale list 
⇒ Click NextNextNextNext three times ⇒ Click OOOOKKKK. 

10.4.2. Create and Configure the Network 

10.4.2.1. Initialize the Network: 

1. The Object Palette    dialog box should be now on the top of your project space. If 

it is not there, open it by clicking . Make sure that the internet_toolboxinternet_toolboxinternet_toolboxinternet_toolbox    item is 
selected from the pull-down menu on the object palette. 

2. Add to the project workspace the following objects from the palette: Application Application Application Application 
ConfigConfigConfigConfig, Profile ConfigProfile ConfigProfile ConfigProfile Config, QoS Attribute ConfigQoS Attribute ConfigQoS Attribute ConfigQoS Attribute Config, five ethernet_wkstnethernet_wkstnethernet_wkstnethernet_wkstn, one 
ethernet_serverethernet_serverethernet_serverethernet_server, and two ethernet4_slip8_gtwyethernet4_slip8_gtwyethernet4_slip8_gtwyethernet4_slip8_gtwy routers. 

3. Connect both routers together with a bidirectional PPP_DS1PPP_DS1PPP_DS1PPP_DS1 link. 

4. Connect the workstations and the server to the routers using bidirectional 
10Base_T10Base_T10Base_T10Base_T links as shown. 

5. Rename the objects you added as shown and then save your project. 

 
Applications 

 
Profiles 

 
QoS 

 

The QoS Attribute ConfigQoS Attribute ConfigQoS Attribute ConfigQoS Attribute Config node defines attribute configuration details for protocols supported at the IP layer. 
These specifications can be referenced by the individual nodes using symbolic names. It defines different queuing 
profiles such as FIFO, WFQ, priority queuing, custom queuing, MWRR, MDRR, and DWRR. 

10.4.2.2. Configure the Applications: 

1. Right-click on the ApplicationsApplicationsApplicationsApplications node ⇒ Edit Edit Edit Edit AttributesAttributesAttributesAttributes ⇒ Expand the Application Application Application Application 

DefinitionsDefinitionsDefinitionsDefinitions hierarchy ⇒ Set rowsrowsrowsrows to 3 ⇒ Name the rows: FTP ApplicationFTP ApplicationFTP ApplicationFTP Application, VVVVideo ideo ideo ideo 
ApplicatApplicatApplicatApplicationionionion, and VoIP ApplicationVoIP ApplicationVoIP ApplicationVoIP Application. 

i. Go to the FTP ApplicationFTP ApplicationFTP ApplicationFTP Application    row ⇒ Expand the DescriptionDescriptionDescriptionDescription hierarchy ⇒ 

Assign High Load High Load High Load High Load to Ftp Ftp Ftp Ftp ⇒ Click on the High Load High Load High Load High Load value and choose EditEditEditEdit    

from the drop-down menu ⇒ Assign Constant(10) Constant(10) Constant(10) Constant(10) to IIIIntentententerrrr----Request TRequest TRequest TRequest Tiiiimemememe    ⇒ 
Assign Constant(10000Constant(10000Constant(10000Constant(1000000) 00) 00) 00) to FileFileFileFile Siz Siz Siz Size. e. e. e. Keep the Type of ServiceType of ServiceType of ServiceType of Service    (ToSToSToSToS) as 
Best Effort (0)Best Effort (0)Best Effort (0)Best Effort (0). 
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ii. Go to the Video Video Video Video ApplicationApplicationApplicationApplication row ⇒ Expand the DescriptionDescriptionDescriptionDescription hierarchy ⇒ 

Assign Low Resolution VideoLow Resolution VideoLow Resolution VideoLow Resolution Video to Video ConferencingVideo ConferencingVideo ConferencingVideo Conferencing ⇒ Click on the Low Low Low Low 

Resolution VideoResolution VideoResolution VideoResolution Video value and choose EditEditEditEdit ⇒ Edit the value of the Type of Type of Type of Type of 

ServiceServiceServiceService field (the Configure TOS/DSCPConfigure TOS/DSCPConfigure TOS/DSCPConfigure TOS/DSCP window appears) ⇒ From the drop- 

down menu, assign Streaming Multimedia (4)Streaming Multimedia (4)Streaming Multimedia (4)Streaming Multimedia (4) to ToSToSToSToS ⇒ Click OKOKOKOK twice. 

iii. Go to the VoIP ApplicationVoIP ApplicationVoIP ApplicationVoIP Application row ⇒ Expand the DescriptionDescriptionDescriptionDescription hierarchy ⇒ 
Assign PCM Quality SpeechPCM Quality SpeechPCM Quality SpeechPCM Quality Speech to VoiceVoiceVoiceVoice. If you edit it, you can see that the ToS 
assigned to it is Interactive Voice (6)Interactive Voice (6)Interactive Voice (6)Interactive Voice (6). 

2. Click OKOKOKOK and then save your project. 

 

Type of ServiceType of ServiceType of ServiceType of Service (ToS) is assigned to the IP packets. It represents a session attribute that allows packets to be 
provided the appropriate service in the IP queues. 

BestBestBestBest----efforteffortefforteffort delivery means that delivery of a packet is attempted but is not guaranteed. 

PCMPCMPCMPCM (Pulse Code Modulation) is a procedure used to digitize speech before transmitting it over the network. 

10.4.2.3. Configure the Profiles: 

1. Right-click on the ProfilesProfilesProfilesProfiles node ⇒ Edit Edit Edit Edit AttributesAttributesAttributesAttributes ⇒ Expand the Profile Profile Profile Profile 

ConfigurationConfigurationConfigurationConfiguration hierarchy ⇒ Set rowsrowsrowsrows to 3333. 

i. Name and set the attributes of row 0row 0row 0row 0 as shown: 



 

 network simulation experiments manual.doc utorak, 28. rujan 2010 113 

 

ii. Name and set the attributes of row 1 as shown: 

 

iii. Name and set the attributes of row 2 as shown: 
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2. Click OKOKOKOK and then save your project. 

10.4.2.4. Configure the Queues: 

We will keep the default queuing profiles that are defined in our Queues Queues Queues Queues object. It is 
recommended that you check out the configuration of the FIFO, PQ, and WFQ 
profiles. 

10.4.2.5. Configure the Workstations and Servers: 

1. Right-click on the FTP ClientFTP ClientFTP ClientFTP Client ⇒ Edit Edit Edit Edit AttributesAttributesAttributesAttributes ⇒ Expand the Application: Application: Application: Application: 

Supported ProfilesSupported ProfilesSupported ProfilesSupported Profiles hierarchy ⇒ Set rowsrowsrowsrows to 1111 ⇒ Set Profile NameProfile NameProfile NameProfile Name to FTP ProfileFTP ProfileFTP ProfileFTP Profile 

⇒ Click OKOKOKOK. 

2. Right-click on the Video ClientVideo ClientVideo ClientVideo Client ⇒ Edit Edit Edit Edit AttributesAttributesAttributesAttributes ⇒ Expand the AppAppAppApplication: lication: lication: lication: 

Supported ProfilesSupported ProfilesSupported ProfilesSupported Profiles hierarchy ⇒ Set rowsrowsrowsrows to 1111 ⇒ Set Profile NameProfile NameProfile NameProfile Name to Video Video Video Video 

ProfileProfileProfileProfile ⇒ Click OKOKOKOK. 

3. Right-click on the VoIP VoIP VoIP VoIP WestWestWestWest ⇒ Edit Edit Edit Edit AttributesAttributesAttributesAttributes. 

i. Expand the Application: Supported ProfilesApplication: Supported ProfilesApplication: Supported ProfilesApplication: Supported Profiles hierarchy ⇒ Set rowsrowsrowsrows to 1111 ⇒ 
Set Profile Name to VoIP ProfileVoIP ProfileVoIP ProfileVoIP Profile. 

ii. Edit the Application: Application: Application: Application: Supported ServicesSupported ServicesSupported ServicesSupported Services value ⇒ Set rowsrowsrowsrows to 1111 ⇒ Set 

Service NameService NameService NameService Name to VoIP ApplicationVoIP ApplicationVoIP ApplicationVoIP Application ⇒ Click OKOKOKOK twice. 

4. Right-click on the VoIP VoIP VoIP VoIP EastEastEastEast ⇒ Edit Edit Edit Edit AttributesAttributesAttributesAttributes. 

i. Expand the Application: Supported ProfilesApplication: Supported ProfilesApplication: Supported ProfilesApplication: Supported Profiles hierarchy ⇒ Set rowsrowsrowsrows to 1111 ⇒ 
Set Profile NameProfile NameProfile NameProfile Name to VoIP ProfileVoIP ProfileVoIP ProfileVoIP Profile. 

ii. Edit the Application: Application: Application: Application: Supported ServicesSupported ServicesSupported ServicesSupported Services value ⇒ Set rowsrowsrowsrows to 1111 ⇒ Set 

Service NameService NameService NameService Name to VoIP ApplicationVoIP ApplicationVoIP ApplicationVoIP Application ⇒ Click OKOKOKOK twice. 

5. Right-click on the FTP ServerFTP ServerFTP ServerFTP Server ⇒ Edit Edit Edit Edit AttributesAttributesAttributesAttributes ⇒ Edit the Application: Application: Application: Application: 

Supported ServicesSupported ServicesSupported ServicesSupported Services value ⇒ Set rowsrowsrowsrows to 1111 ⇒ Set Service NameService NameService NameService Name to FTP FTP FTP FTP 

ApplicationApplicationApplicationApplication ⇒ Click OKOKOKOK twice. 
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6. Right-click on the Video ServerVideo ServerVideo ServerVideo Server ⇒ Edit Edit Edit Edit AttributesAttributesAttributesAttributes ⇒ Edit the Application: Application: Application: Application: 

Supported ServicesSupported ServicesSupported ServicesSupported Services value ⇒ Set rowsrowsrowsrows to 1111 ⇒ Set Service NameService NameService NameService Name to VideoVideoVideoVideo ⇒ 
Click OKOKOKOK twice. 

7. Save your project. 

10.4.2.6. Configure the Routers: 

1. Click on the link connecting the EastEastEastEast and WestWestWestWest routers to select it. ⇒ From the 
ProtocolsProtocolsProtocolsProtocols menu choose IP IP IP IP � QoS  QoS  QoS  QoS � Configure QoS Configure QoS Configure QoS Configure QoS. 

2. Make sure the selected items are as shown in the following QoS Configuration 
dialog box ⇒ Click OKOKOKOK. 

 

Note:    Since the Visualize QoSVisualize QoSVisualize QoSVisualize QoS Configuration Configuration Configuration Configuration radio button is checked, the link is 
colored based on the QoS scheme used (blue for FIFO). 

3. Save your project. 

10.4.3. Choose the Statistics 

To test the performance of the applications defined in the network, we will collect 
some of the available statistics as follows: 

1. Right-click anywhere in the project workspace and select Choose Individual Choose Individual Choose Individual Choose Individual 
StatisticsStatisticsStatisticsStatistics from the pop-up menu. 

2. In the Choose Results dialog box, select the following global statistics: 
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3. Click OKOKOKOK and then save your project. 

Traffic DroTraffic DroTraffic DroTraffic Droppedppedppedpped. The number of IP diagrams dropped by all nodes in the network across all IP interfaces. The 
reason for dropping an IP datagram can be any one of the following: 

• Insufficient space in the queue 

• Maximum number of bops exceeded by an IP datagram. 

• On nonrouting nodes, a local router interface was not found to be used as the next hop. 

• On routing nodes, the route table lookup failed to yield a route to the destination. 

10.4.4. Configure the Simulation 

Here we need to configure the duration of the simulation. 

1. Click on  and the Configure Simulation window should appear. 

2. Set the duration to be 150 seconds150 seconds150 seconds150 seconds. 
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3. Click OKOKOKOK and then save your project. 

10.4.5. Duplicate the Scenario 

In the network we just created, we used the FIFO queuing discipline in the routers. 
To analyze the effect of different queuing disciplines, we will create two more 
scenarios to test the PQPQPQPQ and WFQWFQWFQWFQ disciplines. 

A. Select Duplicate ScenarioDuplicate ScenarioDuplicate ScenarioDuplicate Scenario    from the ScenariosScenariosScenariosScenarios menu and give it the name PQPQPQPQ    ⇒ Click 
OKOKOKOK. 

1. Click on the link connecting the EastEastEastEast    and WestWestWestWest    routers to select it ⇒ From the 
ProtocolsProtocolsProtocolsProtocols menu choose IP IP IP IP � QoS  QoS  QoS  QoS � Configure QoS Configure QoS Configure QoS Configure QoS. 

2. Make sure the selected items are as shown in the following QoS Configuration    
dialog box ⇒ Click OKOKOKOK. 

 

Note:Note:Note:Note:    Since the Visualize QoS ConfigurationVisualize QoS ConfigurationVisualize QoS ConfigurationVisualize QoS Configuration    radio button is checked, the link is 
colored based on the QoS scheme used (orange for priority queuing). 

3. Save your project. 

B. Select Duplicate ScenarioDuplicate ScenarioDuplicate ScenarioDuplicate Scenario    from the ScenariosScenariosScenariosScenarios menu and give it the name WFQWFQWFQWFQ    ⇒    Click 
OKOKOKOK. 

1. Click on the link connecting the EastEastEastEast    and WestWestWestWest    routers to select it ⇒ From the 
ProtocolsProtocolsProtocolsProtocols menu choose IP IP IP IP � QoS  QoS  QoS  QoS � Configure QoS Configure QoS Configure QoS Configure QoS. 

2. Make sure the selected items are as shown in the following QoS Configuration 
dialog box ⇒ Click OKOKOKOK. 
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Note. Note. Note. Note. Since the Visualize QoS ConfigurationVisualize QoS ConfigurationVisualize QoS ConfigurationVisualize QoS Configuration radio button is checked the link is 
colored based on the QQQQooooSSSS scheme used (green for WFQ). 

3. Save your project. 

10.4.6. Run the Simulation 

To run the simulation for the three scenarios simultaneously: 

1. Go to the ScenariosScenariosScenariosScenarios menu ⇒ Select Manage ScenariosManage ScenariosManage ScenariosManage Scenarios.... 

2. Change the values under the ResultsResultsResultsResults column to <collectcollectcollectcollect> (or <recollectrecollectrecollectrecollect>) for the 
three scenarios. Compare to the following figure. 

 

3. Click OKOKOKOK to run the three simulations. Depending on the speed of your 
processor, this may take several minutes to complete. 

4. After the simulation completes the three runs, one for each scenario, click 
CloseCloseCloseClose. 

5. Save your project. 

Note:    Actual results will vary slightly based on the actual node positioning in the 
project. 

10.4.7. View the Results 

To view and analyze the results: 

1. Select Compare ResultsCompare ResultsCompare ResultsCompare Results from the ResultsResultsResultsResults menu. 

2. Select the IP Traffic Dropped Traffic Dropped Traffic Dropped Traffic Dropped statistic and click ShowShowShowShow. . . . The resulting graph 
should resemble the one below. Note:    The shown graph is the result of zooming 
into the region of interest on the original graph. 
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3. Create the graph for Video ConferencingVideo ConferencingVideo ConferencingVideo Conferencing    Traffic ReceivedTraffic ReceivedTraffic ReceivedTraffic Received:::: 

 

4. Create the graph for VoiVoiVoiVoice ce ce ce Traffic ReceivedTraffic ReceivedTraffic ReceivedTraffic Received: 



 

 network simulation experiments manual.doc utorak, 28. rujan 2010 120 

 

5. Create graphs for Voice Packet EndVoice Packet EndVoice Packet EndVoice Packet End----totototo----end Delayend Delayend Delayend Delay and Voice Voice Voice Voice Packet Delay Packet Delay Packet Delay Packet Delay 
VariationVariationVariationVariation (Note: the trace for WFQWFQWFQWFQ is not shown on the following graphs 
because it is overlapped by the trace of PQPQPQPQ.) 

 

10.5. Further readings 

• The Differentiated Services Field: IETF RFC number 2474 (www.ietf.org/rfc.html). 

10.6. Exercises 

1) Analyze the graphs we obtained and verify the overlap of the Voice Packet Voice Packet Voice Packet Voice Packet 
EndEndEndEnd----totototo----end Delayend Delayend Delayend Delay and Voice Voice Voice Voice Packet Delay VariationPacket Delay VariationPacket Delay VariationPacket Delay Variation graphs. Compare the three 
queuing disciplines and explain their effect on the performance of the three 
applications. 
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2) In the implemented project, edit the QueuesQueuesQueuesQueues object and check the profiles 
assigned to the FIFOFIFOFIFOFIFO, PQPQPQPQ, and WFQWFQWFQWFQ disciplines. For each profile answer the 
following questions: 

a. How many queues are associated with each discipline? 

b. In this lab, we used ToSToSToSToS to identify the priority and weight for the PQPQPQPQ and 
WFQWFQWFQWFQ disciplines respectively. What are the other parameters that can be 
used to identify the priority and weight? 

c. In PQPQPQPQ, how are queues configured to serve different ToSToSToSToS values? 

d. In WFQWFQWFQWFQ, how are queues configured to serve different ToSToSToSToS values? 

3) For all scenarios, choose the "queuing delayqueuing delayqueuing delayqueuing delay    " statistic for the link that 
connects EastEastEastEast Router Router Router Router and WestWestWestWest Router Router Router Router. Rerun the simulation and generate the 
graph that compares that queuing delayqueuing delayqueuing delayqueuing delay for all queuing disciplines (scenarios). 
Analyze this graph. 

Hint: 

• The "queuing dqueuing dqueuing dqueuing delayelayelayelay " statistic is under the point-to-point hierarchy. 

10.7. Lab Report 

Prepare a report that follows the guidelines explained in Lab 0. The report should 
include the answers to the above exercises as well as the graphs you generated 
from the simulation scenarios. Discuss the results you obtained and compare these 
results with your expectations. Mention any anomalies or unexplained behaviors. 
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11. Laboratory - RSVP: Resource Reservation Protocol (Providing QoS by 
Reserving Resources in the Network) 

11.1. Objective 

The objective of this lab is to study the Resource Reservation Protocol (RSVP) as a 
part of the Integrated Services approach to providing Quality of Service (QoS) to 
individual applications or flows. 

11.2. Overview 

For many years, packet-switched networks have offered the promise of supporting 
multimedia applications, that is, those that combine audio, video, and data. Audio 
and video applications are examples of real-time    applications. In the best-effort 
model, the network tries to deliver your data but makes no promises and leaves the 
"cleanup operation" to the edges. This model is not sufficient for real-time 
applications. What we need is a new service model - one in which applications that 
need better assurances can request such service from the network. The network 
may then respond by providing an assurance that it will do better or perhaps by 
saying that it cannot promise anything better at the moment. A network that can 
provide different levels of service is often said to support QoS. 

Two approaches have been developed to provide a range of QoS: Integrated 
Services and Differentiated Services. The Resource Reservation Protocol follows 
the Integrated Services approach, whereby QoS is provided to individual 
applications or flows. The Differentiated Services approach provides QoS to large 
classes of data or aggregated traffic. 

While connection-oriented networks have always needed some sort of setup 
protocol to establish the necessary virtual circuit state in the routers, connectionless 
networks like the Internet have had no such protocols. One of the key assumptions 
underlying RSVP is that it should not detract from the robustness that we find in the 
Internet. Therefore, RSVP uses the idea of soft state    in the routers. Soft state - in 
contrast to the hard state found in connection-oriented networks—does not need to 
be explicitly deleted when it is no longer needed instead, it times out after some 
fairly short period if it is not periodically refreshed. RSVP adopts the 
receiver-oriented    approach - the receivers keep track of their own resource 
requirements, and they periodically send refresh messages to keep the soft state in 
place. 

In this tab you will set up a network that carries real-time applications and that 
utilizes RSVP to provide QoS to one of these applications. You will study how RSVP 
contributes to the performance of the application that makes use of it. 

11.3. Prelab Activities 

• Read section 6.5 from "Computer Networks: A Systems Approach""Computer Networks: A Systems Approach""Computer Networks: A Systems Approach""Computer Networks: A Systems Approach", , , , 4th EditionEditionEditionEdition....    

Go to www.netwww.netwww.netwww.net----seal.net/animations.phpseal.net/animations.phpseal.net/animations.phpseal.net/animations.php    and play the following animation: 
• TCP Flow Control. 

11.4. Procedure 

11.4.1. Create the Project 

1. Start OPNET IT Guru Academic EditionOPNET IT Guru Academic EditionOPNET IT Guru Academic EditionOPNET IT Guru Academic Edition    ⇒ Choose OpenOpenOpenOpen from the FileFileFileFile menu. 
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2. Select the project you created in Lab 9: <your initials><your initials><your initials><your initials>_Queues_Queues_Queues_Queues ⇒ Click OKOKOKOK. 

3. From the FileFileFileFile menu, choose Save AsSave AsSave AsSave As ⇒ Rename the project to <your <your <your <your 

initiate>_RSVPinitiate>_RSVPinitiate>_RSVPinitiate>_RSVP ⇒ Click OKOKOKOK. 

4. From the ScenariosScenariosScenariosScenarios menu, choose Manage ScenariosManage ScenariosManage ScenariosManage Scenarios ⇒ Click on FIFOFIFOFIFOFIFO ⇒ Click 

DeleteDeleteDeleteDelete ⇒ Click on PQPQPQPQ ⇒ Click DeleteDeleteDeleteDelete. 

 

5. Click on WFQWFQWFQWFQ and rename it to QoS_RSVPQoS_RSVPQoS_RSVPQoS_RSVP ⇒ Click OKOKOKOK. 

6. Make sure that you have only the QoS_RSVPQoS_RSVPQoS_RSVPQoS_RSVP scenario in your project. The 
following figure shows one way to check for the available scenarios in the 
project. 

 

7. Save your project. 

The idea of the FQFQFQFQ (fair queuing) discipline is to maintain a separate queue for each flow currently being handled 
by the router. The router then service these queue in a round robin manner. 

WFQWFQWFQWFQ allows a weight to be assigned to each flow (queue). This weight effectively controls the percentage of the 
link’s bandwidth each flow will get. We could use the ToS (Type of Service) field in the IP header to identify that 
weight. 

11.4.2. Configure the Network 

11.4.2.1. Add More VoIP Nodes: 

In this project we will set up the two VoIP nodes so that one will always be the Caller    
party and the other will be the Called    party. In addition, we will add two new VoIP 
Caller    and Called    nodes. These new nodes will utilize RSVP to reserve their 
required resources through the network. 
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1. Right-click on the VoIP VoIP VoIP VoIP EastEastEastEast node ⇒ Edit Edit Edit Edit AttributesAttributesAttributesAttributes. ⇒ Rename the node to 

Voice CalledVoice CalledVoice CalledVoice Called ⇒ Assign NoneNoneNoneNone to the Application: Supported ProfilesApplication: Supported ProfilesApplication: Supported ProfilesApplication: Supported Profiles attribute ⇒ 

Assign Voice CalledVoice CalledVoice CalledVoice Called to the Client AddressClient AddressClient AddressClient Address attribute ⇒ Click OKOKOKOK. 

2. Right-click on the VoIP VoIP VoIP VoIP WestWestWestWest node ⇒ Edit Edit Edit Edit AttribAttribAttribAttributesutesutesutes. 

i. Rename the node to Voice CallerVoice CallerVoice CallerVoice Caller. 

ii. Assign NoneNoneNoneNone    to the Application: Application: Application: Application: Supported ServicesSupported ServicesSupported ServicesSupported Services    attribute. 

iii. Edit the value of the Application: Destination PreferencesApplication: Destination PreferencesApplication: Destination PreferencesApplication: Destination Preferences    attribute ⇒ Set 

Rows Rows Rows Rows to 1111 ⇒    Assign Voice Destination Voice Destination Voice Destination Voice Destination to the Symbolic Name Symbolic Name Symbolic Name Symbolic Name of the new 

row ⇒ Edit the Actual Name Actual Name Actual Name Actual Name attribute ⇒ Set Rows Rows Rows Rows to 1111 ⇒ Assign Voice Voice Voice Voice 
CalledCalledCalledCalled    to the Name Name Name Name attribute of the new row as shown. 

iv. Click OKOKOKOK    three times. 

 

3. Click on the Voice CalledVoice CalledVoice CalledVoice Called node to select it ⇒ From the EditEditEditEdit menu, select CopyCopyCopyCopy 

⇒ From the EditEditEditEdit menu, select PastePastePastePaste (alternatively, use the standard keyboard 
shortcuts, CtrlCtrlCtrlCtrl----CCCC and CtrlCtrlCtrlCtrl----VVVV). 

i. Locate the new node somewhere below the Voice CalledVoice CalledVoice CalledVoice Called node on the 

screen ⇒ Connect the new node to the EastEastEastEast Router Router Router Router using a 10BaseT10BaseT10BaseT10BaseT link. 

ii. Right-click on the new node ⇒ Edit Edit Edit Edit AttributesAttributesAttributesAttributes. 

iii. Click on the ethernet_wkstnethernet_wkstnethernet_wkstnethernet_wkstn value of the modelmodelmodelmodel attribute ⇒ Select EditEditEditEdit ⇒ 
Select the ethernet_wkstn_advethernet_wkstn_advethernet_wkstn_advethernet_wkstn_adv model. 

iv. Rename it to Voice_RSVP CalledVoice_RSVP CalledVoice_RSVP CalledVoice_RSVP Called ⇒ Assign Voice_RSVP CalledVoice_RSVP CalledVoice_RSVP CalledVoice_RSVP Called to its 
Client AddressClient AddressClient AddressClient Address attribute. 

v. Click OKOKOKOK. 

4. Copy and paste the Voice CallerVoice CallerVoice CallerVoice Caller node. 

i. Locate the new node somewhere below the Voice CallerVoice CallerVoice CallerVoice Caller    node ⇒ Connect 
the new node to the WestWestWestWest Router Router Router Router    using a 10BaseT10BaseT10BaseT10BaseT link. 
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ii. Right-click on the new node ⇒ Edit Edit Edit Edit AttributesAttributesAttributesAttributes....    

iii. Click on the ethernet_wkstnethernet_wkstnethernet_wkstnethernet_wkstn    value of the modelmodelmodelmodel attribute ⇒ Select EditEditEditEdit    ⇒ 
Select the ethernet_wkstn_advethernet_wkstn_advethernet_wkstn_advethernet_wkstn_adv    model. 

iv. Rename it to Voice_RSVP CallerVoice_RSVP CallerVoice_RSVP CallerVoice_RSVP Caller. 

v. Edit the Application: Destination PreferencesApplication: Destination PreferencesApplication: Destination PreferencesApplication: Destination Preferences    attribute ⇒ Open the ActualActualActualActual    

Name Name Name Name table by clicking in the value field of Actual Name Actual Name Actual Name Actual Name ⇒    Assign 
Voice_RSVP CalledVoice_RSVP CalledVoice_RSVP CalledVoice_RSVP Called    to the Name Name Name Name attribute (this is to replace the current 
value, which is Voice CalledVoice CalledVoice CalledVoice Called)))). 

vi. Click OKOKOKOK three times. 

5. Rename the QueuesQueuesQueuesQueues node in the project to QoSQoSQoSQoS. Your project should look like 
the following diagram. 

6. Save your project. 

 
Applications 

 
Profiles 

 
QoS 

 

11.4.2.2. Define the Data Flow: 

Here, we will define the data flow characteristics of the voice traffic in the network. 
The sender's RSVP module periodically sends RSVP Path messages, that uses the 
data flow characteristics to describe the traffic generated by the sender. When the 
receiver's RSVP module receives the Path message, the receiver host application 
checks the characteristics of the requested data flow and decides if resources 
should be reserved. Once a decision is made to request network resource 
reservation, the host application sends a request to the local RSVP module to assist 
in the reservation setup. The receiver's RSVP module then carries the request as 
Resv messages to all nodes along the reverse data path to the sender. 

The flow is defined by its required bandwidth and buffer size. Bandwidth is set to be 
the token    bucket rate    in the flow specification of the Path and Resv messages. The 
buffer size represents the amount of the application "bursty" data to be buffered. It 
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specifies the token bucket size    that will be set in the Path or Resv messages for the 
session. 

2. Right-click on the QoS QoS QoS QoS node ⇒ Edit Edit Edit Edit AttributesAttributesAttributesAttributes....    

i. Expand the RSVP Flow Specification RSVP Flow Specification RSVP Flow Specification RSVP Flow Specification hierarchy and its row 0row 0row 0row 0    hierarchy ⇒ 

Set NameNameNameName to RSVP_FlowRSVP_FlowRSVP_FlowRSVP_Flow    ⇒ Assign 50,000 50,000 50,000 50,000 to the Bandwidth (bytes/sec) Bandwidth (bytes/sec) Bandwidth (bytes/sec) Bandwidth (bytes/sec) 

attribute ⇒ Assign 10,000 10,000 10,000 10,000 to the Buffer Size (bytes) Buffer Size (bytes) Buffer Size (bytes) Buffer Size (bytes) attribute. 

ii. Expand the RSVP Profiles RSVP Profiles RSVP Profiles RSVP Profiles hierarchy and its row 0row 0row 0row 0    hierarchy ⇒ Set Profile Profile Profile Profile 
NameNameNameName    to RSVP_ProfileRSVP_ProfileRSVP_ProfileRSVP_Profile. 

iii. Click OKOKOKOK and then save your project. 

 

11.4.2.3. Configure the Application: 

Here we will create a VoIP application that utilizes the RSVP flow specifications we 
configured. 

1. Right-click on the ApplicationsApplicationsApplicationsApplications node ⇒ Edit Edit Edit Edit AttributesAttributesAttributesAttributes ⇒ Expand the Application Application Application Application 

DefinitionsDefinitionsDefinitionsDefinitions hierarchy ⇒ Set rowsrowsrowsrows to 4444 (to add a fourth row to the Application Application Application Application 
DefinitionsDefinitionsDefinitionsDefinitions attribute). 

i. Name and set the attributes of row 3 as shown: 
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ii. Click on the PCM QuPCM QuPCM QuPCM Quality Speechality Speechality Speechality Speech value (shown above) ⇒ Select EditEditEditEdit ⇒ 

Edit the value of the RSVP ParametersRSVP ParametersRSVP ParametersRSVP Parameters attribute ⇒ Assign the following 

values (recall that we defined the RSVP_FlowRSVP_FlowRSVP_FlowRSVP_Flow in the QoS node) ⇒ Click 
OKOKOKOK three times. 

 

Note that the characteristics of the Outbound FlOutbound FlOutbound FlOutbound Flow ow ow ow are carried in the Path messages 
to be sent from sender to receiver, and the characteristics of the Inbound Flow Inbound Flow Inbound Flow Inbound Flow 
parameters are carried in the Resv messages to be sent from the receiver to the 
sender. 

11.4.2.4. Configure the Profile: 

1. Right-click on the ProfilesProfilesProfilesProfiles node ⇒ Edit Edit Edit Edit AttributesAttributesAttributesAttributes    ⇒ Expand the Profile Profile Profile Profile 

ConfigurationConfigurationConfigurationConfiguration    hierarchy ⇒ Set rowsrowsrowsrows to 4444 (to add a fourth row to the Profile Profile Profile Profile 

ConfigurationConfigurationConfigurationConfiguration    attribute) ⇒ Name and set the attributes of row 3 as shown: 
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2. Click OKOKOKOK    and then save your project. 

11.4.2.5. Configure the Interfaces: 

OPNET IT Guru supports RSVP on a per-interface basis; RSVP can be enabled or 
disabled for each node's interface. 

1. Simultaneously select (shift + left-click) the following three links: 

 

2. From the ProtocolsProtocolsProtocolsProtocols menu, select RSVPRSVPRSVPRSVP ⇒ Select Configure Interface StaConfigure Interface StaConfigure Interface StaConfigure Interface Statustustustus ⇒ 

Make the selections shown below in the configuration dialog box ⇒ Click OKOKOKOK 
and then save your project. 
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The above process enables RSVP on all interfaces along the path between the two 
Voice parties that need to utilize RSVP. 

11.4.2.6. Configure the Hosts and Routers: 

In OPNET IT Guru, the RSVP process runs only in IP-enabled nodes. The advanced 
versions (*_adv*_adv*_adv*_adv) of those node models must be used, as we did already, to 
configure RSVP-related parameters. In addition, the RSVP model in OPNET IT 
Guru requires either WFQ or custom queuing schemes. 

1. Right-click on the Voice_RSVP CallerVoice_RSVP CallerVoice_RSVP CallerVoice_RSVP Caller    node ⇒ Edit Edit Edit Edit AttributesAttributesAttributesAttributes. 

i. Expand the Application: Supported ProfilesApplication: Supported ProfilesApplication: Supported ProfilesApplication: Supported Profiles hierarchy and its row 0row 0row 0row 0    

hierarchy ⇒ Assign VolP_RSVPVolP_RSVPVolP_RSVPVolP_RSVP Profile  Profile  Profile  Profile to the Profile NameProfile NameProfile NameProfile Name    attribute. 

ii. Expand the Application: RSVApplication: RSVApplication: RSVApplication: RSVP ParametersP ParametersP ParametersP Parameters    hierarchy ⇒ Expand its VoiceVoiceVoiceVoice 

hierarchy ⇒ Enable    the RSVP StatusRSVP StatusRSVP StatusRSVP Status    ⇒ Expand the Profile ListProfile ListProfile ListProfile List    hierarchy 

⇒ Assign to the Profile attributeProfile attributeProfile attributeProfile attribute of row 0row 0row 0row 0    the value RSVP_ProfileRSVP_ProfileRSVP_ProfileRSVP_Profile. 

 

iii. Expand the IP Host ParametersIP Host ParametersIP Host ParametersIP Host Parameters hierarchy ⇒ Expand its Interface Interface Interface Interface 

InformationInformationInformationInformation hierarchy ⇒ Expand the QoS InformationQoS InformationQoS InformationQoS Information hierarchy ⇒ Assign 

WFQWFQWFQWFQ to the Queuing SchemeQueuing SchemeQueuing SchemeQueuing Scheme attribute ⇒ Assign ToS BasedToS BasedToS BasedToS Based to the Queuing Queuing Queuing Queuing 

Profile attributeProfile attributeProfile attributeProfile attribute ⇒ Assign RSVP EnabledRSVP EnabledRSVP EnabledRSVP Enabled to the RSVP InfoRSVP InfoRSVP InfoRSVP Info attribute. 
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Type of serviceType of serviceType of serviceType of service (ToS) is assigned to the IP packets. It represents a session attribute that allows packets to be 
provided the appropriate service in the IP queues. 

iv. Expand the RSVP Protocol ParametersRSVP Protocol ParametersRSVP Protocol ParametersRSVP Protocol Parameters hierarchy ⇒ Expand the Interface Interface Interface Interface 
InformationInformationInformationInformation hierarchy. (You should notice that the word Enabled is listed in 
the summary line. When you expand it, you will see that it is the value of 
RSVP StatusRSVP StatusRSVP StatusRSVP Status. If Enabled is not listed, go back to the Configure the 
Interfaces steps.) ⇒ Expand the hierarchy of the row of that interface ⇒ 
Assign 75757575%%%% to both the Maximum ReservableMaximum ReservableMaximum ReservableMaximum Reservable BW BW BW BW and Maximum Maximum Maximum Maximum 
Bandwidth Per FlowBandwidth Per FlowBandwidth Per FlowBandwidth Per Flow attributes as shown: 

 

v. Click OKOKOKOK. 

Maximum Reservable BW Maximum Reservable BW Maximum Reservable BW Maximum Reservable BW specifies the percentage of the bandwidth of the connected link that RSVP can reserve 
on the interface. 

Maximum Bandwidth Per FlowMaximum Bandwidth Per FlowMaximum Bandwidth Per FlowMaximum Bandwidth Per Flow specifies the amount of reservable bandwidth that can be allocated to a single 
flow. 

2. Right-click on the Voice_RSVP CalledVoice_RSVP CalledVoice_RSVP CalledVoice_RSVP Called    node ⇒ Edit Edit Edit Edit AttributesAttributesAttributesAttributes. 

i. Edit the Application: Application: Application: Application: Supported ServicesSupported ServicesSupported ServicesSupported Services attribute. The Application: 
Supported Services Table will popup ⇒ In that table, replace the VoIP VoIP VoIP VoIP 
ApApApApplicationplicationplicationplication with VolP_RSVPVolP_RSVPVolP_RSVPVolP_RSVP and Click OKOKOKOK. 

ii. Expand the Application: RSVP ParametersApplication: RSVP ParametersApplication: RSVP ParametersApplication: RSVP Parameters hierarchy ⇒ Expand its VoiceVoiceVoiceVoice 

hierarchy. ⇒ Enable the RSVP StatusRSVP StatusRSVP StatusRSVP Status ⇒ Expand the Profile ListProfile ListProfile ListProfile List hierarchy 

⇒ Edit the value of the Profile attributeProfile attributeProfile attributeProfile attribute of row 0row 0row 0row 0 and enter RSVP_ProfileRSVP_ProfileRSVP_ProfileRSVP_Profile. 
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iii. Expand the IP Host ParametersIP Host ParametersIP Host ParametersIP Host Parameters hierarchy ⇒ Expand its Interface Interface Interface Interface 

InformationInformationInformationInformation hierarchy ⇒ Expand the QoS InformationQoS InformationQoS InformationQoS Information hierarchy ⇒ Assign 

WFQWFQWFQWFQ to the Queuing SchemeQueuing SchemeQueuing SchemeQueuing Scheme attribute ⇒ Assign ToS BasedToS BasedToS BasedToS Based to the Queuing Queuing Queuing Queuing 

Profile attributeProfile attributeProfile attributeProfile attribute ⇒ Assign RSVP EnabledRSVP EnabledRSVP EnabledRSVP Enabled to the RSVP InRSVP InRSVP InRSVP Infofofofo attribute. 

iv. Expand the RSVP Protocol ParametersRSVP Protocol ParametersRSVP Protocol ParametersRSVP Protocol Parameters hierarchy ⇒ Expand the Interface Interface Interface Interface 
InformationInformationInformationInformation hierarchy. (You should notice that the RSVP StatusRSVP StatusRSVP StatusRSVP Status of the 
interface that is connected to the router is Enabled. If not, go back to the 
Configure the Interfaces steps.) ⇒ Expand the hierarchy of the row of that 
interface ⇒ Assign 75757575%%%% to both Maximum Reservable BWMaximum Reservable BWMaximum Reservable BWMaximum Reservable BW and Maximum Maximum Maximum Maximum 
Bandwidth Per FlowBandwidth Per FlowBandwidth Per FlowBandwidth Per Flow attributes. 

v. Click OKOKOKOK. 

3. Right-click on the EastEastEastEast Router Router Router Router    node ⇒ Edit Edit Edit Edit AttributesAttributesAttributesAttributes. 

i. Click on the Ethernet4_slip8_gtwyEthernet4_slip8_gtwyEthernet4_slip8_gtwyEthernet4_slip8_gtwy value of the modelmodelmodelmodel attribute. ⇒ Select 

EditEditEditEdit ⇒ Select the Ethernet4_slip8_gtwy_advEthernet4_slip8_gtwy_advEthernet4_slip8_gtwy_advEthernet4_slip8_gtwy_adv model. 

ii. Expand the RSVP Protocol ParametersRSVP Protocol ParametersRSVP Protocol ParametersRSVP Protocol Parameters hierarchy ⇒ Expand the Interface Interface Interface Interface 
InformationInformationInformationInformation hierarchy. (You should notice that the RSVP StatusRSVP StatusRSVP StatusRSVP Status of two 
interfaces, which are connected to the WWWWestestestest Router Router Router Router and the Voice_RSVP Voice_RSVP Voice_RSVP Voice_RSVP 
CalledCalledCalledCalled node, are Enabled. If not, go back to the Configure the Interfaces 
steps.) ⇒ Expand the hierarchies of the rows of these two interfaces ⇒ 
Assign 75757575%%%% to both Maximum Reservable BWMaximum Reservable BWMaximum Reservable BWMaximum Reservable BW and Maximum Bandwidth Maximum Bandwidth Maximum Bandwidth Maximum Bandwidth 
Per FlowPer FlowPer FlowPer Flow attributes. 

iii. Expand the IP Routing ParametersIP Routing ParametersIP Routing ParametersIP Routing Parameters hierarchy ⇒ Expand the Interface Interface Interface Interface 

InformationInformationInformationInformation hierarchy ⇒ Expand the hierarchies of the rows of the same two 

interfaces you configured in the previous step (step ii) ⇒ Expand the QoS QoS QoS QoS 

InformationInformationInformationInformation hierarchy for both ⇒ Set QQQQueuing Schemeueuing Schemeueuing Schemeueuing Scheme to WFQWFQWFQWFQ and 
Queuing ProfileQueuing ProfileQueuing ProfileQueuing Profile to ToS BasedToS BasedToS BasedToS Based for both. 

iv. Click OKOKOKOK. 

4. Right-click on the WestWestWestWest Router Router Router Router    node ⇒ Edit Edit Edit Edit AttributesAttributesAttributesAttributes. 

i. Click on the EtheEtheEtheEthernet4_srnet4_srnet4_srnet4_sIIIIip8_gtwyip8_gtwyip8_gtwyip8_gtwy value of the modelmodelmodelmodel attribute ⇒ Select 

EditEditEditEdit    ⇒ Select the EtheEtheEtheEthernet4_srnet4_srnet4_srnet4_sIIIIip8_gtwyip8_gtwyip8_gtwyip8_gtwy_adv _adv _adv _adv model. 

ii. Expand the RSVP Protocol ParametersRSVP Protocol ParametersRSVP Protocol ParametersRSVP Protocol Parameters    hierarchy ⇒ Expand the Interface Interface Interface Interface 
InformationInformationInformationInformation    hierarchy. (You should notice that the RSVP StatusRSVP StatusRSVP StatusRSVP Status    of two 
interfaces, which are connected to the EastEastEastEast Router Router Router Router    and the Voice_RSVP Voice_RSVP Voice_RSVP Voice_RSVP 
CallerCallerCallerCaller    node, are Enabled.    If not, go back to the Configure the Interfaces    
steps.) ⇒ Expand the hierarchies of the rows of these two interfaces ⇒ 
Assign 75757575%%%%    to both Maximum Reservable BWMaximum Reservable BWMaximum Reservable BWMaximum Reservable BW    and Maximum Bandwidth Maximum Bandwidth Maximum Bandwidth Maximum Bandwidth 
Per FlowPer FlowPer FlowPer Flow    attributes. 

iii. Expand the IP Routing ParametersIP Routing ParametersIP Routing ParametersIP Routing Parameters    hierarchy ⇒ Expand the Interface Interface Interface Interface 

InformationInformationInformationInformation    hierarchy ⇒ Expand the hierarchies of the rows of the same two 

interfaces you configured in the previous step (step ii) ⇒ Expand the QoS QoS QoS QoS 

InformationInformationInformationInformation    hierarchy for both ⇒ Set Queuing SchemeQueuing SchemeQueuing SchemeQueuing Scheme    to WFQWFQWFQWFQ    and 
Queuing ProfileQueuing ProfileQueuing ProfileQueuing Profile    to ToS BasedToS BasedToS BasedToS Based    for both. 

iv. Click OKOKOKOK. 

11.4.3. Choose the Statistics 

We will select statistics from three different nodes: 
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11.4.3.1. Voice_RSVP Caller Statistics: 

1. Right-click on the Voice_RSVP CallerVoice_RSVP CallerVoice_RSVP CallerVoice_RSVP Caller    node and select Choose Individual Choose Individual Choose Individual Choose Individual 
StatisticsStatisticsStatisticsStatistics    from the pop-up menu. 

2. Expand the RSVPRSVPRSVPRSVP hierarchy and select Number of Path StNumber of Path StNumber of Path StNumber of Path Statesatesatesates. 

3. Right-click on the Number of Path StatesNumber of Path StatesNumber of Path StatesNumber of Path States statistic ⇒ Select Change Draw StyleChange Draw StyleChange Draw StyleChange Draw Style 

from the pop-up menu ⇒ Choose bar chartbar chartbar chartbar chart. 

4. Right-click on the Number of Path StatesNumber of Path StatesNumber of Path StatesNumber of Path States statistic ⇒ Select Change Collection Change Collection Change Collection Change Collection 

ModeModeModeMode from the pop-up menu ⇒ Check the AdvancedAdvancedAdvancedAdvanced checkbox ⇒ From the 

Capture modeCapture modeCapture modeCapture mode drop-down menu, select all valuesall valuesall valuesall values, as shown ⇒ Click OKOKOKOK. 

 

5. Expand the Voice Calling PartyVoice Calling PartyVoice Calling PartyVoice Calling Party hierarchy and select the following statistics: 
Packet Delay VariationPacket Delay VariationPacket Delay VariationPacket Delay Variation and Packet EndPacket EndPacket EndPacket End----totototo----End End End End Delay (sec)Delay (sec)Delay (sec)Delay (sec). 

6. Click OKOKOKOK. 

Packet Delay VariatioPacket Delay VariatioPacket Delay VariatioPacket Delay Variationnnn is the variance among end-to-end delays for voice packets received by this node. 

Packet EndPacket EndPacket EndPacket End----totototo----End DelayEnd DelayEnd DelayEnd Delay for a voice packet is measured from the time it is created to the time it is received. 

11.4.3.2. Voice_RSVP Called Statistics: 

1. Right-click on the Voice_RSVP CaVoice_RSVP CaVoice_RSVP CaVoice_RSVP Calledlledlledlled node and select Choose Individual Choose Individual Choose Individual Choose Individual 
StatisticsStatisticsStatisticsStatistics from the pop-up menu. 

2. Expand the RSVPRSVPRSVPRSVP hierarchy and select Number of Resv StatesNumber of Resv StatesNumber of Resv StatesNumber of Resv States. 

3. Right-click on the Number of Resv StatesNumber of Resv StatesNumber of Resv StatesNumber of Resv States statistic ⇒ Select Change Draw StyleChange Draw StyleChange Draw StyleChange Draw Style 

from the pop-up menu ⇒ Choose bar chartbar chartbar chartbar chart. 

4. Right-click on the Number of Resv StatesNumber of Resv StatesNumber of Resv StatesNumber of Resv States statistic ⇒ Select Change Collection Change Collection Change Collection Change Collection 

ModeModeModeMode from the pop-up menu ⇒ Check the AdvancedAdvancedAdvancedAdvanced checkbox ⇒ From the 

Capture modeCapture modeCapture modeCapture mode drop-down menu, select all valuesall valuesall valuesall values ⇒ Click OKOKOKOK. 

5. Click OKOKOKOK. 

11.4.3.3. Voice Caller Statistics: 

1. Right-click on the VoiVoiVoiVoice Callerce Callerce Callerce Caller    node and select Choose Individual StatisticsChoose Individual StatisticsChoose Individual StatisticsChoose Individual Statistics    
from the pop-up menu. 

2. Expand the Voice Calling PartyVoice Calling PartyVoice Calling PartyVoice Calling Party    hierarchy and select the following statistics: 
Packet Delay VariationPacket Delay VariationPacket Delay VariationPacket Delay Variation    and Packet EndPacket EndPacket EndPacket End----totototo----End End End End Delay (sec)Delay (sec)Delay (sec)Delay (sec). 

3. Click OKOKOKOK. 
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11.4.4. Configure the Simulation 

Here, we need to configure the duration of the simulation: 

1. Click on  and the Configure Simulation window should appear. 

2. Make sure that the duration is set to 150 seconds150 seconds150 seconds150 seconds. 

3. Click on the Global AttributesGlobal AttributesGlobal AttributesGlobal Attributes tab and make sure that the following attribute is 
enabled: 

a. RSVP Sim Efficiency = Enabled. RSVP Sim Efficiency = Enabled. RSVP Sim Efficiency = Enabled. RSVP Sim Efficiency = Enabled. This decreases the simulation time and 
memory requirements by not sending refresh messages (i.e., Path and 
Resv refreshes). 

4. Click OKOKOKOK and then save your project. 

11.4.5. Run the Simulation 

To run the simulation: 

1. Click on     and then click the Run Run Run Run button. Depending on the speed of your 
processor, this may take several minutes to complete. 

2. After the simulation completes, click CloseCloseCloseClose.... 

3. Save your project. 

11.4.6. View the Results 

To view and analyze the results: 

1. Select ViewViewViewView    ResultsResultsResultsResults    from the ResultsResultsResultsResults menu. 

2. As shown in the following figure, choose the Packet Packet Packet Packet EndEndEndEnd_to_to_to_to____EEEEnd Delay nd Delay nd Delay nd Delay for both 
the Voice CallerVoice CallerVoice CallerVoice Caller    and Voice_RSVP CallerVoice_RSVP CallerVoice_RSVP CallerVoice_RSVP Caller    nodes. Choose Overlaid StatisticsOverlaid StatisticsOverlaid StatisticsOverlaid Statistics    and 
time_averagetime_averagetime_averagetime_average. 

 

3. Click ShowShowShowShow to get the following graph. (Note: To zoom in on the graph, click and 
drag your mouse to draw a rectangle around the area of interest and release the 
mouse button.) 
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4. Similarly, you can get the following graph that compares the Packet Delay Packet Delay Packet Delay Packet Delay 
VariationVariationVariationVariation for both the Voice CallerVoice CallerVoice CallerVoice Caller and Voice_RVoice_RVoice_RVoice_RSVP CallerSVP CallerSVP CallerSVP Caller nodes. (Note: Make 
sure to "unselect" the statistics you chose for the previous graph.) 

 

5. Finally, prepare the graph that displays the number of Path and Resv states by 
selecting the following statistics. Make sure to select Stacked StatisticsStacked StatisticsStacked StatisticsStacked Statistics and As As As As 
IsIsIsIs as shown. 
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6. Right-click on the resulting graph and choose EditEditEditEdit Panel Properties Panel Properties Panel Properties Panel Properties ⇒ Change 
the assigned values to the Horizontal MinHorizontal MinHorizontal MinHorizontal Min and Horizontal MaxHorizontal MaxHorizontal MaxHorizontal Max fields as shown 
(your graph might require a slightly different range): 

 

7. Click OKOKOKOK. The resulting graph should resemble the one below. 
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11.5. Further readings 

• OPNET RSVP Model Description: From the ProtocolsProtocolsProtocolsProtocols menu, select RSVPRSVPRSVPRSVP    ⇒    Model 
Usage Guide.    

11.6. Exercises 

1) Analyze the graphs we obtained in this lab. Show the effect of RSVP on the 
Voice application and explain the obtained numbers of Path and Resv states. 

2) How does the data rate of the link connecting the EastEastEastEast    and WestWestWestWest    routers affect 
the performance (e.g., Packet EnPacket EnPacket EnPacket Endddd----totototo----End Delay) End Delay) End Delay) End Delay) of the Voice and Video 
Conference applications? To answer this question, create a new scenario as a 
duplicate of the QoS_RSVPQoS_RSVPQoS_RSVPQoS_RSVP    scenario. Name the new scenario Q2_HighRateQ2_HighRateQ2_HighRateQ2_HighRate. In 
the Q2_HighRate Q2_HighRate Q2_HighRate Q2_HighRate scenario replace the current PPP_DS1PPP_DS1PPP_DS1PPP_DS1    link (data rate 1.544 
Mbps) with a PPP_DS3PPP_DS3PPP_DS3PPP_DS3    link (data rate 44.736 Mbps). 

11.7. Lab Report 

Prepare a report that follows the guidelines explained in Lab 0. The report should 
include the answers to the above exercises as well as the graphs you generated 
from the simulation scenarios. Discuss the results you obtained and compare these 
results with your expectations. Mention any anomalies or unexplained behaviors. 
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12. Laboratory - Firewalls and VPN (Network Security and Virtual Private 
Networks) 

12.1. Objective 

The objective of this lab is to study the role of firewalls and Virtual Private Networks 
VPNs) in providing security to shared public networks such as the Internet. 

12.2. Overview 

Computer networks are typically a shared resource used by many applications for 
many different purposes. Sometimes the data transmitted between application 
processes is confidential, and the application users would prefer that others not be 
able to read it. 

A firewall is a specially programmed router that sits between a site and the rest of 
the network. It is a router in the sense that it is connected to two or more physical 
networks and it forwards packets from one network to another, but it also fitters the 
packets that flow through it. A firewall allows the system administrator to implement 
a security policy in one centralized place. File-based firewalls are the simplest and 
most widely deployed type of firewall. They are configured with a table of addresses 
that characterize the packets they will and will not forward. 

A VPN is an example of providing a controlled connectivity over a public network 
such as the Internet. VPNs utilize a concept called an IP tunnel - a virtual 
point-to-point    link between a pair of nodes that are actually separated by an arbitrary 
number of networks. The virtual link is created within the router at the entrance to 
the tunnel by providing it with the IP address of the router at the far end of the tunnel. 
Whenever the router at the entrance of the tunnel wants to send a packet over this 
virtual link, it encapsulates the packet inside an IP datagram. The destination 
address in the IP header is the address of the router at the far end of the tunnel, 
white the source address is that of the encapsulating router. 

In this lab you will set up a network where servers are accessed over the Internet by 
customers who have different privileges. You will study how firewalls and VPNs can 
provide security to the information in the servers while maintaining access for 
customers with the appropriate privilege. 

12.3. Prelab Activities 

• Read section 4.5.3 from "C"C"C"Computer Networks: A Systems Approach"omputer Networks: A Systems Approach"omputer Networks: A Systems Approach"omputer Networks: A Systems Approach", , , , 4th EditionEditionEditionEdition.... 
• Firewalls 

12.4. Procedure 

12.4.1. Create a New Project 

1. Start OPNET IT Guru Academic EditionOPNET IT Guru Academic EditionOPNET IT Guru Academic EditionOPNET IT Guru Academic Edition ⇒ Choose NewNewNewNew from the FileFileFileFile menu. 

2. Select ProjectProjectProjectProject and Click OKOKOKOK ⇒ Name the project <your initials><your initials><your initials><your initials>_VPN_VPN_VPN_VPN, and the 

scenario NoFirewallNoFirewallNoFirewallNoFirewall ⇒ Click OKOKOKOK. 

3. Click QuitQuitQuitQuit on the Startup Wizard. 

4. To remove the world background map, select the ViewViewViewView menu ⇒ BackgroundBackgroundBackgroundBackground ⇒ 

Set Border MapSet Border MapSet Border MapSet Border Map ⇒ Select NONENONENONENONE from the drop-down menu ⇒ Click OKOKOKOK. 
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12.4.2. Create and Configure the Network 

12.4.2.1. Initialize the Network: 

1. Open the Object PaletteObject PaletteObject PaletteObject Palette    dialog box by clicking . Make sure that the 
internet_toolboxinternet_toolboxinternet_toolboxinternet_toolbox    item is selected from the pull-down menu on the object palette. 

2. Add the following objects, from the palette, to the project workspace (see figure 
below for placement): Application ConfigApplication ConfigApplication ConfigApplication Config, Profile ConfigProfile ConfigProfile ConfigProfile Config, an ip32_cloudip32_cloudip32_cloudip32_cloud, one 
ppp_serverppp_serverppp_serverppp_server, three ethernet4_slip8_gtwyethernet4_slip8_gtwyethernet4_slip8_gtwyethernet4_slip8_gtwy routers, and two ppp_wkstnppp_wkstnppp_wkstnppp_wkstn hosts. 

a. To add an object from a palette, click its icon in the object palette. ⇒ Move 
your mouse to the workspace and click where you want to place the object. 

⇒ Right-click to indicate you are done creating objects of this type. 

3. Rename the objects you added and connect them using PPP_DS1PPP_DS1PPP_DS1PPP_DS1 links, as 
shown below: 

 
Applications 

 
Profiles 

 

4. Save your project. 

The ppp_serverppp_serverppp_serverppp_server and ppp_wkstnppp_wkstnppp_wkstnppp_wkstn support one underlying SLIP (Serial Line Internet Protocol) connection at a 
selectable data rate. 

PPP_DS1PPP_DS1PPP_DS1PPP_DS1 connects two nodes running PPP. Its data rate is 1.344 Mbps. 

12.4.2.2. Configure the Nodes: 

1. Right-click on the ApplicationsApplicationsApplicationsApplications node ⇒ Edit Edit Edit Edit AttributesAttributesAttributesAttributes ⇒ Assign DefaultDefaultDefaultDefault to the 

Application DefinitionsApplication DefinitionsApplication DefinitionsApplication Definitions attribute ⇒ Click OKOKOKOK. 

2. Right-click on the ProfilesProfilesProfilesProfiles node ⇒ Edit Edit Edit Edit AttributesAttributesAttributesAttributes ⇒ Assign Sample ProfilesSample ProfilesSample ProfilesSample Profiles to 

the Profile ConfiguratiProfile ConfiguratiProfile ConfiguratiProfile Configurationononon attribute ⇒ Click OKOKOKOK. 

3. Right-click on the ServerServerServerServer node ⇒ Edit Edit Edit Edit AttributesAttributesAttributesAttributes ⇒ Assign AllAllAllAll to the Application: Application: Application: Application: 

Supported ServicesSupported ServicesSupported ServicesSupported Services attribute ⇒ Click OKOKOKOK. 

4. Right-click on the Sales ASales ASales ASales A node ⇒ Select Similar NodesSelect Similar NodesSelect Similar NodesSelect Similar Nodes (make sure that both 
Sales ASales ASales ASales A and Sales BSales BSales BSales B are selected). 

i. Right-click on the Sales ASales ASales ASales A    node ⇒ Edit Edit Edit Edit AttributesAttributesAttributesAttributes    ⇒ Check the Apply Apply Apply Apply 
Changes to Selected ObjectsChanges to Selected ObjectsChanges to Selected ObjectsChanges to Selected Objects    check-box. 

ii. Expand the Application: Supported ProfilesApplication: Supported ProfilesApplication: Supported ProfilesApplication: Supported Profiles attribute ⇒ Set rowsrowsrowsrows to 1111 ⇒ 

Expand the row 0row 0row 0row 0 hierarchy ⇒ Profile NameProfile NameProfile NameProfile Name = Sales Person = Sales Person = Sales Person = Sales Person (this is one of 
the "sample profiles" we configured in the ProfilesProfilesProfilesProfiles node). 
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iii. Click OKOKOKOK. 

5. Save your project. 

Several examples application configurations are available under the Default setting. For example, “Web Browsing 
(Heavy HTTP1.1)” indicates a Web browsing application performing heavy browsing using HTTP1.1. protocol. 

12.4.3. Choose the Statistics 

1. Right-click anywhere in the project workspace and select Choose Individual Choose Individual Choose Individual Choose Individual 
StatisticsStatisticsStatisticsStatistics from the pop-up menu. 

2. In the Choose Results dialog, check the following statistics: 

i. Global StatistGlobal StatistGlobal StatistGlobal Statistics ics ics ics ⇒ DB Query  DB Query  DB Query  DB Query ⇒ Response Time (sec) Response Time (sec) Response Time (sec) Response Time (sec). 

ii. Global StatisticsGlobal StatisticsGlobal StatisticsGlobal Statistics ⇒⇒⇒⇒ HTTP HTTP HTTP HTTP ⇒    Page Response Time (seconds)Page Response Time (seconds)Page Response Time (seconds)Page Response Time (seconds). 

3. Click OKOKOKOK. 

4. Right-click on the Sales ASales ASales ASales A node and select Choose Individual StatisticsChoose Individual StatisticsChoose Individual StatisticsChoose Individual Statistics from the 
pop-up menu. 

5. In the Choose Results dialog, check the following statistics: 

i. Client DBClient DBClient DBClient DB    ⇒⇒⇒⇒    Traffic ReceivedTraffic ReceivedTraffic ReceivedTraffic Received (bytes/sec) (bytes/sec) (bytes/sec) (bytes/sec). 

ii. Client HttpClient HttpClient HttpClient Http    ⇒⇒⇒⇒    Traffic ReceivedTraffic ReceivedTraffic ReceivedTraffic Received (bytes/sec) (bytes/sec) (bytes/sec) (bytes/sec). 

6. Click OKOKOKOK. 

7. Right-click on the Sales BSales BSales BSales B node and select Choose Individual StatisticsChoose Individual StatisticsChoose Individual StatisticsChoose Individual Statistics from the 
pop-up menu. 

8. In the Choose Results dialog, check the following statistics: 

i. Client DBClient DBClient DBClient DB    ⇒    Traffic ReceivedTraffic ReceivedTraffic ReceivedTraffic Received (bytes/sec) (bytes/sec) (bytes/sec) (bytes/sec). 

ii. Client HttpClient HttpClient HttpClient Http    ⇒    Traffic ReceivedTraffic ReceivedTraffic ReceivedTraffic Received (bytes/sec) (bytes/sec) (bytes/sec) (bytes/sec). 

9. Click OKOKOKOK and then save your project. 

DQ Query Response TimeDQ Query Response TimeDQ Query Response TimeDQ Query Response Time is measured from the time when the database query application sends a request to the 
server to the time it receives a response packet. 

HTTP Page Response TimeHTTP Page Response TimeHTTP Page Response TimeHTTP Page Response Time specifies the time required to retrieve the entire page with all the contained inline 
objects. 

12.4.4. The Firewall Scenario 

In the network we just created, the SalesSalesSalesSales Person  Person  Person  Person profile allows both sales sites to 
access applications such as Database Access, Email, and Web Browsing from the 
server (check the Profile ConfigurationProfile ConfigurationProfile ConfigurationProfile Configuration    of the ProfilesProfilesProfilesProfiles node) Assume that we need to 
protect the database in the server from external access, including the sales people. 
One way to do that is to replace Router CRouter CRouter CRouter C with a firewall as follows: 

1. Select Duplicate ScenarioDuplicate ScenarioDuplicate ScenarioDuplicate Scenario    from the ScenariosScenariosScenariosScenarios menu and name it Firewall Firewall Firewall Firewall ⇒ 
Click OKOKOKOK.... 

2. In the new scenario, right-click on Router CRouter CRouter CRouter C    ⇒    Edit Edit Edit Edit AttributesAttributesAttributesAttributes.... 

3. Assign ethernetethernetethernetethernet2_slip82_slip82_slip82_slip8_firewall _firewall _firewall _firewall to the modelmodelmodelmodel attribute. 

4. Expand the hierarchy of the Proxy Server Information Proxy Server Information Proxy Server Information Proxy Server Information attribute ⇒ Expand the 

row 1row 1row 1row 1, which is for the Database application, hierarchy ⇒ Assign No No No No to the 
Proxy Server Deployed Proxy Server Deployed Proxy Server Deployed Proxy Server Deployed attribute as shown: 



 

 network simulation experiments manual.doc utorak, 28. rujan 2010 140 

 

5. Click OKOKOKOK and then save your project. 

Proxy Server Proxy Server Proxy Server Proxy Server InformationInformationInformationInformation is a table defining the configuration of the firewall. Each roe indicates whether a proxy 
server exists for a certain application and the amount of additional delay that will be introduced to each forwarded 
packet of that application by the proxy server. 

12.4.5. Firewalls and VPN 

Our Firewall Firewall Firewall Firewall configuration does not allow database-related traffic to pass through 
the firewall (it filters such packets out). This way, the databases in the server are 
protected from external access. Your Firewall Firewall Firewall Firewall scenario should look like the following 
figure. 

 
Applications 

 
Profiles 
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12.4.6. The Firewall VPN Scenario 

In the Firewall Firewall Firewall Firewall scenario, we protected the databases in the server from "any" 
external access using a firewall router. Assume that we want to allow the people in 
the Sales ASales ASales ASales A    site to have access to the databases in the server. Since the firewall 
fitters all database-related traffic regardless of the source of the traffic, we need to 
consider the VPN solution. A virtual tunnel can be used by Sales ASales ASales ASales A    to send database 
requests to the server. The firewall will not filter the traffic created by Sales ASales ASales ASales A    
because the IP packets in the tunnel will be encapsulated inside an IP datagram. 

1. While you are in the Firewall Firewall Firewall Firewall scenario, select Duplicate ScenarioDuplicate ScenarioDuplicate ScenarioDuplicate Scenario from the 

ScenariosScenariosScenariosScenarios menu and give it the name FirewallFirewallFirewallFirewall_VPN_VPN_VPN_VPN ⇒ Click OKOKOKOK. 

2. Remove the link between Router CRouter CRouter CRouter C and the Server.Server.Server.Server. 

3. Open the Object Palette    dialog box by clicking . Make sure that the 
internet_toolboxinternet_toolboxinternet_toolboxinternet_toolbox is selected from the pull-down menu on the object palette. 

i. Add to the project workspace one ethernet4_sIip8_gtwyethernet4_sIip8_gtwyethernet4_sIip8_gtwyethernet4_sIip8_gtwy and one IP VPN IP VPN IP VPN IP VPN 
ConfigConfigConfigConfig (see the figure below for placement). 

ii. From the Object Palette, use two PPP_DS1PPP_DS1PPP_DS1PPP_DS1 links to connect the new router 
to Router CRouter CRouter CRouter C (the firewall) and to the ServerServerServerServer, as shown below. 

iii. Close the Object Palette    dialog box. 

4. Rename the lP VPN ConfiglP VPN ConfiglP VPN ConfiglP VPN Config object to VPNVPNVPNVPN. 

5. Rename the new router to Router DRouter DRouter DRouter D as shown: 

 
Applications 

 
Profiles 

 
VPN 

 
The ethernet4_slip8_gtwyethernet4_slip8_gtwyethernet4_slip8_gtwyethernet4_slip8_gtwy node model represents an IP based gateway supporting four Ethernet hub interfaces 
and eight serial line interfaces: IP packets arriving on any interface are routed to the appropriate output interface 
based on their destination IP address. The Routing Interface Protocol (RIP) or the Open Shortest Path First 
(OSPF) protocol may be used to dynamically and automatically create the gateway's routing tables and select 
routers in an adaptive manner. 

12.4.6.1. Configure the VPN: 

1. Right-click on the VPNVPNVPNVPN node ⇒ Edit Edit Edit Edit AttributesAttributesAttributesAttributes. 

i. Expand the VPN Configuration VPN Configuration VPN Configuration VPN Configuration hierarchy ⇒ Set rowsrowsrowsrows to 1111 ⇒ Expand row 0row 0row 0row 0    

hierarchy ⇒ Edit the value of Tunnel Source Name Tunnel Source Name Tunnel Source Name Tunnel Source Name and enter Router A Router A Router A Router A ⇒    
Edit the value of    Tunnel Destination Name Tunnel Destination Name Tunnel Destination Name Tunnel Destination Name and enter Router DRouter DRouter DRouter D. 
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ii. Expand the Remote Client List Remote Client List Remote Client List Remote Client List hierarchy ⇒ Set rowsrowsrowsrows to 1111 ⇒ Expand row 0row 0row 0row 0    

hierarchy ⇒ Edit the value of Client Node Name Client Node Name Client Node Name Client Node Name and enter SaleSaleSaleSales As As As A. 

iii. Click OKOKOKOK and then save your project. 

 

12.4.6.2. Simulating Encryption: 

A virtual tunnel between Sales ASales ASales ASales A and the Server Server Server Server does not guarantee security for the 
contents of the transferred database packets. If the contents of these packets are 
confidential, encryption of these packets will be needed. In OPNET AE, the effect of 
packets encryption can be simulated by the available compression function. Two of 
the available compression schemes are the Per-Interface Compression and the 
Per-Virtual Circuit Compression as shown. Once you edit the Compression 
Information attribute of an interface, OPNET adds the IP Config node to the project. 

Change picture! 
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Per-Interface Compression compresses the entire packet (including the headers). 
This means the packet is decompressed and compressed at each hop on the route 
Per-Virtual Circuit Compression compresses the packet payload only. Therefore, 
compression and decompression take place only at the end nodes. One of the 
exercises by the end of this lab will ask you to create a new scenario to utilize the 
compression function. 

12.4.7. Run the Simulation 

To run the simulation for the three scenarios simultaneously: 

1. Go to the ScenariosScenariosScenariosScenarios menu ⇒ Select Manage ScenariosManage ScenariosManage ScenariosManage Scenarios. 

2. Change the values under the ResultsResultsResultsResults column to <collectcollectcollectcollect> (or <recollectrecollectrecollectrecollect>) for 

the three scenarios. Keep the default value of the Sim DurationSim DurationSim DurationSim Duration (1 hour). 
Compare to the following figure. 

 

3. Click OKOKOKOK to run the three simulations. Depending on the speed of your 
processor, this may take several minutes to complete. 

4. After the three simulation runs complete, one for each scenario, click CloseCloseCloseClose ⇒ 
Save your project. 

12.4.8. View the Results 

To view and analyze the results: 

1. Select Compare ResultsCompare ResultsCompare ResultsCompare Results from the ResultsResultsResultsResults menu. 

2. Expand the Sales ASales ASales ASales A hierarchy ⇒ Expand the Client DBClient DBClient DBClient DB hierarchy ⇒ Select the 
Traffic RTraffic RTraffic RTraffic Receivedeceivedeceivedeceived statistic. 

3. Change the drop-down menu in the middle-lower part of the Compare ResultsCompare ResultsCompare ResultsCompare Results 
dialog box from As_IsAs_IsAs_IsAs_Is to time_averagetime_averagetime_averagetime_average as shown. 
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4. Press ShowShowShowShow and the resulting graph should look similar to the following figure. 
Your graph may not match exactly due to node placement. 

 

5. Create a graph similar to the previous one, but for Sales BSales BSales BSales B: 



 

 network simulation experiments manual.doc utorak, 28. rujan 2010 145 

 

6. Create two graphs similar to the previous ones to depict the Traffic ReceivedTraffic ReceivedTraffic ReceivedTraffic Received by 
the Client HttpClient HttpClient HttpClient Http for Sales ASales ASales ASales A and Sales BSales BSales BSales B. 

 

Note:    Results may vary slightly due to different node placement. 

12.5. Further readings 

• The Impact of Internet Link Capacity on Application Performance: From the 

ProtocolsProtocolsProtocolsProtocols menu, select Methodologies Methodologies Methodologies Methodologies ⇒    Capacity Planning....    

• Virtual Private Networks Management: IETF RFC number 2685 
(www.ietf.org/rfc.html). 

12.6. Exercises 

1) From the obtained graphs, explain the effect of the firewall, as well as the 
configured VPN, on the database traffic requested by SalesSalesSalesSales A A A A and Sales BSales BSales BSales B. 

2) Compare the graphs that show the received HTTP traffic with those that show 
the received database traffic. 
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3) Generate and analyze the graph(s) that show the effect of the firewall, as well as 
the configured VPN, on the response time (delay) of the HTTP pages and 
database queries. 

4) In the FirewallFirewallFirewallFirewall_VPN_VPN_VPN_VPN    scenario we configured the VPNVPNVPNVPN node so that no traffic 
from Sales ASales ASales ASales A    is blocked by the firewall. Create a duplicate of the FirewallFirewallFirewallFirewall_VPN_VPN_VPN_VPN    
scenario and name the new scenario Q4_DB_WebQ4_DB_WebQ4_DB_WebQ4_DB_Web. In the Q4_DB_WebQ4_DB_WebQ4_DB_WebQ4_DB_Web    
scenario we want to configure the network so that:    

a. The databases in the server can be accessed only by the people in the 
Sales ASales ASales ASales A site. 

b. The web sites in the server can be accessed only by the people in the Sales Sales Sales Sales 
BBBB site. 

Include in your report the diagram of the new network configuration including 
any changes you made to the attributes of the existing or added nodes. 
Generate the graphs of the DB traffic received and the HTTP traffic received for 
both Sales ASales ASales ASales A and Sales BSales BSales BSales B to show that the new network meets the above 
requirements. 

5) Create a duplicate of the FirewallFirewallFirewallFirewall_VPN_VPN_VPN_VPN    scenario and name the new scenario 
Q5_CompressionQ5_CompressionQ5_CompressionQ5_Compression.    In the new scenario simulate packet encryption between 
Sales ASales ASales ASales A    and the Server Server Server Server by allowing PerPerPerPer----Virtual Circuit Compression Virtual Circuit Compression Virtual Circuit Compression Virtual Circuit Compression in both 
nodes. As encryption takes more time than compression, edit the attributes of 
the Per-Virtual Circuit Compression row (row 3) in the IP Config IP Config IP Config IP Config node. Assign 
3E-006 and 1E-006 to Compression Delay Compression Delay Compression Delay Compression Delay and Decompression DelayDecompression DelayDecompression DelayDecompression Delay    
respectively. Study the effect of compression on the DB Query response time 
between Sales ASales ASales ASales A    and the Server.Server.Server.Server.    

12.7. Lab Report 

Prepare a report that follows the guidelines explained in Lab 0. The report should 
include the answers to the above exercises as well as the graphs you generated 
from the simulation scenarios. Discuss the results you obtained and compare these 
results with your expectations. Mention any anomalies or unexplained behaviors. 
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13. Laboratory - Applications (Network Application Performance Analysis) 

13.1. Objective 

The objective of this lab is to analyze the performance of an Internet application 
protocol and its relation to the underlying network protocols. In addition, this lab 
reviews some of the topics covered in previous labs. 

13.2. Overview 

Network applications are part network protocol (in the sense that they exchange 
messages with their peers on other machines) and part traditional application 
program (in the sense that they interact with the users). 

OPNET’s Application Characterization Environment (ACE) provides powerful 
visualization and diagnosis capabilities that aid in network application analysis. ACE 
provides specific information about the root cause of application problems. ACE can 
also be used to predict application behavior under different scenarios. ACE takes as 
input a real trace file captured using any protocol analyzer, or using OPNET’s 
capture agents (not included in the Academic Edition). 

In this lab you will analyze the performance of an FTP application. You will analyze 
the probable bottlenecks for the application scenario under investigation. You will 
also study the sensitivity of the application to different network conditions such as 
bandwidth and packet loss. The trace was captured on a real network, which is 
shown in the figure below, and already imported into ACE. The FTP application runs 
on that network; the client connects to the server over a 768 Kbps Frame Relay 
circuit with 36 ms of latency. The FTP application downloads a 1 MB file in 37 
seconds. Normally the download time for a file this size should be about 11 
seconds. 

 

13.3. Prelab Activities 

• Read sections 9.1.1 and 9.1.3 from "Computer Networks: A Systems Approach""Computer Networks: A Systems Approach""Computer Networks: A Systems Approach""Computer Networks: A Systems Approach"    4th 
EditionEditionEditionEdition....    

Go to www.netwww.netwww.netwww.net----seal.net/animations.phpseal.net/animations.phpseal.net/animations.phpseal.net/animations.php    and play the following animations: 
• Internet Access. 

• Email Protocols 
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13.4. Procedure 

13.4.1. Open the Application Characterization Environment 

1. Start OPNET IT Guru Academic EdiOPNET IT Guru Academic EdiOPNET IT Guru Academic EdiOPNET IT Guru Academic Editiontiontiontion ⇒ Choose OpenOpenOpenOpen from the FileFileFileFile menu. 

2. Select Application CharacterizationApplication CharacterizationApplication CharacterizationApplication Characterization from the pull-down menu. 

3. Select FTP_with_lossFTP_with_lossFTP_with_lossFTP_with_loss from the list ⇒ Click OKOKOKOK. 

 

13.4.2. Visualize the Application 

After opening the file, ACE shows the Data Exchange Chart (DEC), depicting the 
flow of application traffic between tiers. The DEC you see on your screen may or 
may not show the FTP ServerFTP ServerFTP ServerFTP Server tier as the top tier. If it does not, drag the tier label 
from the bottom to the top, so your screen matches the one shown in the following 
diagram. 

 

1. Select Network Chart OnlyNetwork Chart OnlyNetwork Chart OnlyNetwork Chart Only from the drop-down menu as shown below. 

2. Differentiate the messages flowing in different directions by selecting ViewViewViewView ⇒ 
Split GroupsSplit GroupsSplit GroupsSplit Groups. 

The Data Exchange ChartData Exchange ChartData Exchange ChartData Exchange Chart can display the following: 

• The Application Chart Application Chart Application Chart Application Chart, which shows the flow of application traffic between nets. 

• The NNNNetwork Chartetwork Chartetwork Chartetwork Chart, which shows the flow of network protocols on application traffic. 

Network protocols split packets into segments, add header, and often include mechanisms to ensure reliable data 
transfer. These network protocol effects can influence application behavior. 
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To get a better understanding of this traffic, you will zoom in on the transaction. To 
understand how the Application Chart and Network Chart views differ, you will view 
both simultaneously. 

3. Select Application and Network ChartsApplication and Network ChartsApplication and Network ChartsApplication and Network Charts from the drop-down menu in the middle 
of the dialog box. 

4. To disable the split groups view, select ViewViewViewView ⇒ Split GroupsSplit GroupsSplit GroupsSplit Groups. 

5. Select ViewViewViewView ⇒ Set Visible Time RangeVisible Time RangeVisible Time RangeVisible Time Range ⇒ Set Start TimeStart TimeStart TimeStart Time to 25.225.225.225.2 and End TimeEnd TimeEnd TimeEnd Time 

to 25.525.525.525.5 ⇒ Click OKOKOKOK. 

6. The Application Message Chart shows a single message flowing from the FTP FTP FTP FTP 
ServerServerServerServer to the Client. To show the size, rest the cursor on the message to show 
the tooltip. Client PayloadClient PayloadClient PayloadClient Payload is shown as 8192. 
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The Network Chart shows that this application message causes many packets to 
flow over the network. These packets are a mix of large (blue and green) packets 
from the FTP Server to the Client and small (red) packets from the Client to the FTP 
Server. As the red color indicates, these packets contain 0 bytes of application data. 
They are the acknowledgments sent by TCP. 

13.4.3. Analyze with AppDoctor 

AppDoctor's Summary of Delays    provides insight into the root cause of the overall 
application delay. 

1. From the AppDoctorAppDoctorAppDoctorAppDoctor menu, select Summary of DelaysSummary of DelaysSummary of DelaysSummary of Delays ⇒ Check the Show Show Show Show 
ValuesValuesValuesValues checkbox. 

Notice that the largest contributing factor to the application response time is 
protocol/congestion. Only about 30 percent of the file download time is caused 
by the limited bandwidth of the Frame Relay circuit (768 Kbps). Notice also that 
application delay (processing inside the node) by both the Client and FTP FTP FTP FTP 
ServerServerServerServer is a very minor contributing factor to the application response time. 
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2. Close the Summary of Delays dialog box. 

The Diagnosis Diagnosis Diagnosis Diagnosis function of AppDoctor should give further insight into the cause 
of the protocol/congestion delay. 

3. From the AppDoctorAppDoctorAppDoctorAppDoctor menu, select DiagnosisDiagnosisDiagnosisDiagnosis. 

The diagnosis shows four bottlenecks: transmission delay, protocol/congestion 
delay, retransmissions, and out of sequence packets. One factor that 
contributes to protocol/congestion delay is retransmissions. So it is no surprise 
that here, in the more detailed diagnosis, you see retransmissions listed as a 
bottleneck. The out of-sequence packets, also listed as a bottleneck, are a side 
effect of the retransmissions. Correcting that issue will probably also cure the 
out of sequence packets problem. 
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4. Close the Diagnosis Window 

AppDoctor also provides summary statistics for the application transaction. 

5. From the AppDoctorAppDoctorAppDoctorAppDoctor menu, select StatisticsStatisticsStatisticsStatistics. 

Notice that 52 retransmissions occurred during a file transfer composed of 1281 
packets, yielding a retransmission rate of 4%. 

6. Close the Statistics window. 
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13.4.4. Examine the Statistics 

To view the actual network throughput, use the Graph Statistics Graph Statistics Graph Statistics Graph Statistics feature. 

1. From the Data Exchange Chart, select Graph Statistics Graph Statistics Graph Statistics Graph Statistics from the Graph Graph Graph Graph menu 

(or click the button: ). 

2. Select the two Network ThroughputNetwork ThroughputNetwork ThroughputNetwork Throughput statistics that measure Kbits/sec. 
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3. Click ShowShowShowShow.... 

 

4. Return to the Graph Statistics window. ⇒ Unselect the throughput statistics and 
select only the two RetraRetraRetraRetransmissionsnsmissionsnsmissionsnsmissions statistics ⇒ Change the Bucket WidthBucket WidthBucket WidthBucket Width to 

100 ms100 ms100 ms100 ms ⇒ Click ShowShowShowShow. 
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ACE divides the entire tasks duration into bucketsbucketsbucketsbuckets of time and calculate a mean of total value for each interval. The 
default bucket width is 1000 msec; you can change this value in the Bucket Width (msec) field of the ACE statistic 
hardware. 

13.4.5. Ideal TCP Window Size 

In TCP, rather having a fixed-size sliding window, the receiver advertises a window 
size to the sender. This is done using the AdvertisedWAdvertisedWAdvertisedWAdvertisedWiiiindow ndow ndow ndow field in the TCP 
header. The sender is then limited to having no more than a value of 
AdvertisedWindow AdvertisedWindow AdvertisedWindow AdvertisedWindow bytes of unacknowledged data at any given time. The receiver 
selects a suitable value for AdvertisedWAdvertisedWAdvertisedWAdvertisedWiiiindow ndow ndow ndow based on the amount of memory 
allocated to the connection for the purpose of buffering data. This procedure is 
called flow control, and its idea is to keep the sender from overrunning the receiver's 
buffer. 

In addition, TCP maintains a new state variable for each connection, called 
CongestionWindowCongestionWindowCongestionWindowCongestionWindow, which is used by the source to limit how much data it is allowed 
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to have in transit at a given time. The congestion window is congestion control's 
counterpart to flow control's advertised window. It is dynamically sized by TCP in 
response to the congestion status of the connection. 

TCP will send data only if the amount of sent-but-not-yet-acknowledged data is less 
than the minimum of the congestion window and the advertised window. ACE 
auto-calculates the optimum window size based on the bandwidth/delay product as 
follows: 

1. Return to the Graph Statistics    window ⇒ Select the TCP InTCP InTCP InTCP In----FFFFlight Data (bytes)light Data (bytes)light Data (bytes)light Data (bytes) 

FTP_Server to ClientFTP_Server to ClientFTP_Server to ClientFTP_Server to Client statistic ⇒ Assign 1010101000000000 to the Bucket Width (msec)Bucket Width (msec)Bucket Width (msec)Bucket Width (msec). 

 

2. Click ShowShowShowShow. From the graph, the ideal window size calculated by ACE is about 7 
KB. 

 

3. You can now close all opened graphs (delete the panel when you are asked to 
do that) and close the Graph Statistics window.... 

The bandwidthbandwidthbandwidthbandwidth----delay productsdelay productsdelay productsdelay products of a connection gives the "volume" of the connection – the number of bits it holds. It 
corresponds to how many bits the sender must retransmit before the first bit arrives at the receiver. 

13.4.6. Impact of Network Bandwidth 

ACE QuickPredictQuickPredictQuickPredictQuickPredict enables you to study the sensitivity of an application to network 
conditions such as bandwidth and latency. 

1. Click on the QuickPredictQuickPredictQuickPredictQuickPredict button: . 
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2. In the QuickPredict Control dialog box assign 512512512512    KbpsKbpsKbpsKbps to the Min BandwidthMin BandwidthMin BandwidthMin Bandwidth 

field and 10101010    MbpsMbpsMbpsMbps to the Max BandwidthMax BandwidthMax BandwidthMax Bandwidth field ⇒ Click the Update GraphUpdate GraphUpdate GraphUpdate Graph button. 

 

3. The resulting graph should resemble the following one: 

 

4. Close the graph and the QuickPredict Control dialog box. 

13.4.7. Deploy an Application 

OPNET IT Guru can be used to perform predictive studies of applications that are 
characterized in ACE. ACE uses the trace files to create application fingerprints that 
characterize the data exchange between tiers. From these fingerprints, a simulation 
can show how the application will behave under different conditions. For example, 
the ACE topology wizard can be used to build a network model from the ACE file of 
this lab, FTP_with_lossFTP_with_lossFTP_with_lossFTP_with_loss to answer the following question: What will the performance 
of the FTP application be when deployed to 100 simultaneous users over an IP 
network? 

Follow the following steps to answer the above question: 

1. From the IT Guru main window, select FileFileFileFile    ⇒ New  New  New  New ⇒ Select ProjectProjectProjectProject from the 

pull-down menu ⇒ Click OKOKOKOK. 

2. Name the project <your initials><your initials><your initials><your initials>_FTP_FTP_FTP_FTP, and the scenario ManyUsersManyUsersManyUsersManyUsers ⇒ Click 
OKOKOKOK. 
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3. In the Startup Wizard, select Import from ACEImport from ACEImport from ACEImport from ACE ⇒ Click NextNextNextNext. 

 

4. The Configure ACE Application dialog box appears. 

i. Set the Name Name Name Name field to FTP ApplicationFTP ApplicationFTP ApplicationFTP Application. 

ii. Set the RepeatRepeatRepeatRepeat application field to 2. 2. 2. 2. This field controls how many times a 
user executes the application per hour. 

iii. Leave the limit at the default value, InfiniteInfiniteInfiniteInfinite. 

iv. Click on Add Task Add Task Add Task Add Task ⇒ In the Contained Tasks Contained Tasks Contained Tasks Contained Tasks table, click on the word 

SpecifySpecifySpecifySpecify …    ⇒ Select FTP_with_lossFTP_with_lossFTP_with_lossFTP_with_loss    from the pull-down menu. 

v. Click NextNextNextNext 

 

5. The Create ACE Topology dialog box appears. Set Number of ClientsNumber of ClientsNumber of ClientsNumber of Clients to 100100100100 
and set Packet LatencyPacket LatencyPacket LatencyPacket Latency to 40404040. Leave all other settings at the default values. 

6. Click CreateCreateCreateCreate. 



 

 network simulation experiments manual.doc utorak, 28. rujan 2010 159 

 

7. Select FileFileFileFile ⇒ SaveSaveSaveSave ⇒ Click OKOKOKOK to save the project. 

The ACE Wizard creates a topology similar to the one shown. The Tasks, Tasks, Tasks, Tasks, 
Applications, Applications, Applications, Applications, and ProfileProfileProfileProfiles s s s objects have all been configured according to the 
trace files and the entries you made in the ACE Wizard. You can customize 
them further. 

 

Tasks 
 

Applications 
 

Profiles 

 

13.4.7.1. Run the Simulation and View the Results: 

Now that the topology is created, you can run the simulation. 

1. Click on the Configure/Run Simulation Configure/Run Simulation Configure/Run Simulation Configure/Run Simulation action button . 

2. Use the default values. Click Run. Run. Run. Run. Depending on the speed of your processor, 
this may take several minutes to complete. 

3. Close the dialog box when the simulation completes. ⇒ Save your project. 

4. Select ViewViewViewView Results  Results  Results  Results from the ResultsResultsResultsResults menu ⇒ Expand the Custom Application Custom Application Custom Application Custom Application 

hierarchy ⇒ Select the Application Response Time (sec) Application Response Time (sec) Application Response Time (sec) Application Response Time (sec) statistic. 
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5. Click ShowShowShowShow. The resulting, graph should resemble the following: 

 

13.5. Further readings 

• File Transfer Protocol (FTP): IETF RFC number 959 (www.ietf.org/rfc.html). 

13.6. Exercises 

1) Explain why the Client to FTP Server messages are mainly 0-byte messages? 

2) Utilizing the AppDoctor’s Summary of Delays, what is the effect of each of the 
following upgrades on the FTP download time? 

a. Server upgrade 

b. Bandwidth upgrade 

c. Protocol(s) upgrade 
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3) How do retransmissions contribute to protocol/congestion delay? Explain why 
"out of sequence" packets are constitute a side effect of retransmissions. 

4) Which protocol is responsible for the retransmission, IP, TCP, or FTP? Explain. 

5) In the Network ThroughputNetwork ThroughputNetwork ThroughputNetwork Throughput graph, the throughput from the FTP ServerFTP ServerFTP ServerFTP Server to the 
Client has an average value of about 300 Kbps and has a spike to about 500 
Kbps. But the Frame Relay circuit has an available bandwidth of 768 Kbps. 
Explain why the throughput is not close to the available bandwidth. 

6) Explain how the TCP in-flight data is used as an indicator of the TCP window 
size and how the bandwidth-delay product of the connection is used as an 
indicator of the ideal window size. 

7) Comment on the graph we received that shows the relation between the 
network bandwidth and the FTP application response time. Why does the 
response time look unaffected by increasing the bandwidth beyond a specific 
point? 

8) In the Deploy an Application section, a network model with multiple users was 
created based on the ACE file, FTPFTPFTPFTP____with_losswith_losswith_losswith_loss. Duplicate the created scenario 
to create a new one with the name Q8_Q8_Q8_Q8_ManyUsersManyUsersManyUsersManyUsers_Exist_Exist_Exist_ExistiiiingTrafficngTrafficngTrafficngTraffic. In this new 
scenario add an "existing" traffic of 80% load in the network. Examine how the 
existing traffic affects the FTP application's response time. Note: A simple way 
to simulate the existing traffic is to apply background utilization traffic of 80% to 
the link between the Remote RouterRemote RouterRemote RouterRemote Router and the IP CloudIP CloudIP CloudIP Cloud. 

13.7. Lab Report 

Prepare a report that follows the guidelines explained in Lab 0. The report should 
include the answers to the above exercises as well as the graphs you generated 
from the simulation scenarios. Discuss the Results you obtained and compare these 
results with your expectations. Mention any anomalies or unexplained behaviors. 
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14. Laboratory - Wireless Local Area Network (Medium Access Control for 
Wirelessly Connected Stations) 

14.1. Objective 

This lab addresses the MAC (Medium Access Control) sublayer of the IEEE 802.11 
standard for WLAN (wireless local area network). Different options of this standard 
are studied in this lab. The performance of these options is analyzed under different 
scenarios. 

14.2. Overview 

The IEEE 802.11 standard provides wireless connectivity to computerized stations 
that require rapid deployment such as portable computers. The Medium Access 
Control (MAC) sublayer in the standard includes two fundamental access methods: 
distributed coordination function (DCF) and the point coordination function (PCF). 
DCF utilizes the carrier sense multiple access with collision avoidance (CSMA/CA) 
approach. DCF is implemented in all stations in the wireless local area network 
(WLAN). PCF is based on polling to determine the station that can transmit next. 
Stations in an infrastructure network optionally implement the PCF access method. 

In addition to the physical CSMA/CA, DCF and PCF utilize virtual carrier-sense 
mechanism to determine the state of the medium. This virtual mechanism is 
implemented by means of the network allocation vector (NAV). The NAV provides 
each station with a prediction of future traffic on the medium. Each station uses NAV 
as an indicator of time periods during which transmission will not be initiated even if 
the station senses that the wireless medium is not busy. NAV gets the information 
about future traffic from management frames and the header of regular frames being 
exchanged in the network. 

With DCF, every station senses the medium before transmitting. The transmitting 
station defers as long as the medium is busy. After deferral and while the medium is 
idle, the transmitting station has to wait for a random backoff interval. After the 
backoff interval and if the medium is still idle, the station initiates data transmission 
or optionally exchanges RTS (request to send) and CTS (clear to send) frames with 
the receiving station. The effect of RTS and CTS frames will be studied in the 
following lab. 

With PCF, the access point (AP) in the network acts as a point coordinator (PC). The 
PC uses polling to determine which station can initiate data transmission. It is 
optional for the stations in the network to participate in PCF and hence respond to 
poll received from the PC. Such stations are called CF-Pollable stations. The PCF 
requires control to be gained of the medium by the PC. To gain such control, the PC 
utilizes the Beacon management frames to set the network allocation vector (NAV) 
in the network stations. As the mechanism used to set NAV is based on the DCF, all 
stations comply with the PC request to set their NAV whether or not they are 
CF-Pollable. This way the PC can control frame transmissions in the network by 
generating contention free periods (CFP). The PC and the CF-Pollable stations do 
not use RTS/CTS in the CFP. 

The standard allows for fragmentation of the MAC data units into smaller frames. 
Fragmentation is favorable in case the wireless channel is not reliable enough to 
transmit longer frames. Only frames with a length greater than a fragmentation 
threshold will be fragmented. Each fragment will be sent independently and will be 
separately acknowledged. During a contention period, all fragments of a single 
frame will be sent as burst with a single invocation of the DCF medium access 
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procedure. In case of PCF and during a contention free period, fragments are sent 
individually following the rules of the point coordinator (PC). 

14.3. Prelab Activities 

• Read section 2.8.2 from "Computer Networks: A Systems Approach""Computer Networks: A Systems Approach""Computer Networks: A Systems Approach""Computer Networks: A Systems Approach", , , , 4th EditionEditionEditionEdition....    

14.4. Procedure 

14.4.1. Create a New Project 

To create a new project for the Ethernet network: 

1. Start OPNET IT Guru Academic EditionOPNET IT Guru Academic EditionOPNET IT Guru Academic EditionOPNET IT Guru Academic Edition ⇒ Choose NewNewNewNew from the FileFileFileFile menu. 

2. Select ProjectProjectProjectProject ⇒ Click OKOKOKOK ⇒ Name the project <your initials><your initials><your initials><your initials>_WirelessLAN_WirelessLAN_WirelessLAN_WirelessLAN, 

and the scenario DCFDCFDCFDCF ⇒ Click OKOKOKOK. 

3. In the Startup Wizard: Initial Topology dialog box, make sure that Create Empty Create Empty Create Empty Create Empty 

ScenarioScenarioScenarioScenario is selected ⇒ Click NextNextNextNext ⇒ Choose OfficeOfficeOfficeOffice from the Network Scale list 
and check Use Metric UnitsUse Metric UnitsUse Metric UnitsUse Metric Units ⇒ Click NextNextNextNext twice ⇒ Click OKOKOKOK. 

14.4.2. Create and Configure the Network 

To create our wireless network: 

1. The Object Palette    dialog box should be now on the top of your project space. If 

it is not there, open it by clicking . Make sure that the wirelwirelwirelwireless_laness_laness_laness_lan is 
selected from the pull-down menu on the object palette. 

2. Add to the project workspace the following objects from the palette: 9 
wlan_station_adv (fixwlan_station_adv (fixwlan_station_adv (fixwlan_station_adv (fix). 

a. To add an object from a palette, click its icon in the object palette. ⇒ Move 

your mouse to the workspace ⇒ Left-click to place the object. Right-click 
when finished. 

3. Close the Object Palette    dialog box ⇒ Arrange the stations in the workspace as 
shown in the following figure ⇒ Save your project. 
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14.4.2.1. Configure the wireless nodes: 

1. Repeat the following for each of the nine nodes: 

Right-click on the node ⇒ Edit Edit Edit Edit AttributesAttributesAttributesAttributes ⇒ Assign to the Wireless LAN MAC Wireless LAN MAC Wireless LAN MAC Wireless LAN MAC 
AddressAddressAddressAddress attribute a value equals to the node number (e.g., address 1 is 

assigned to node_1node_1node_1node_1) ⇒ Assign to the Destination AddressDestination AddressDestination AddressDestination Address attribute the 

corresponding value shown in the following table ⇒ Click OKOKOKOK.... 

• The following figure shows the values assigned to the Destination AddressDestination AddressDestination AddressDestination Address 
and Wireless LAN MAC AddressWireless LAN MAC AddressWireless LAN MAC AddressWireless LAN MAC Address attributes for nodenodenodenode____1111. 

Node name Destination AddressDestination AddressDestination AddressDestination Address 

node_0 Random 

node_1 5 

node_2 8 

node_3 6 

node_4 7 

node_5 1 

node_6 3 

node_7 4 

node_8 2  

14.4.2.2. Traffic Generation Parameters: 

1. Select all the nodes in the network simultaneously except node_0except node_0except node_0except node_0 (click on all of 

them while holding the ShiftShiftShiftShift key) ⇒ Right-click on any of the selected nodes 

(i.e., nonononode_1de_1de_1de_1 to node_8node_8node_8node_8) ⇒ Edit Edit Edit Edit AttributesAttributesAttributesAttributes ⇒ Check the Apply Changes to Apply Changes to Apply Changes to Apply Changes to 
Selected ObjectsSelected ObjectsSelected ObjectsSelected Objects check box. 

2. Expand the hierarchies of the Traffic Generation ParametersTraffic Generation ParametersTraffic Generation ParametersTraffic Generation Parameters and the Packet Packet Packet Packet 

Generation ArgumentsGeneration ArgumentsGeneration ArgumentsGeneration Arguments attributes. ⇒ Edit the attributes to match the values 

shown in the following figure ⇒ Click OKOKOKOK. 

 

3. Select all the nodes in the network simultaneously including node_0including node_0including node_0including node_0 ⇒ 

Right-click on any of the selected nodes ⇒ Edit Edit Edit Edit AttributesAttributesAttributesAttributes ⇒ Check the Apply Apply Apply Apply 
Changes to Selected ObjectsChanges to Selected ObjectsChanges to Selected ObjectsChanges to Selected Objects check box. 
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4. Expand the hierarchy of the Wireless LAN Wireless LAN Wireless LAN Wireless LAN ParametersParametersParametersParameters attribute ⇒ Assign the 

value 4608000 to the Buffer Size (bits)Buffer Size (bits)Buffer Size (bits)Buffer Size (bits) attribute ⇒ Click OKOKOKOK. 

 

5. Right-click on node_0node_0node_0node_0 ⇒ Edit Edit Edit Edit AttributesAttributesAttributesAttributes ⇒ Expand the Wireless LAN Wireless LAN Wireless LAN Wireless LAN 

ParametersParametersParametersParameters hierarchy and set the Access Point FunctionalityAccess Point FunctionalityAccess Point FunctionalityAccess Point Functionality to EnabledEnabledEnabledEnabled. ⇒ 
Click OKOKOKOK. 

BuffBuffBuffBuffer sizeser sizeser sizeser sizes specifies the maximum size of the higher layer data buffer limit is reached, the data packets arrived from higher 
layer will be discarded until some packets are removed from the buffer so that the buffer has some free space to store these 
new packets. 

14.4.3. Choose the Statistics 

To test the performance of the network in our DCF scenario, we will collect some of 
the available statistics as follows: 

1. Right-click anywhere in the project workspace and select Choose Individual Choose Individual Choose Individual Choose Individual 
StatisticsStatisticsStatisticsStatistics from the pop-up menu. 

2. In the Choose Results dialog box, Expand the Global Statistics Global Statistics Global Statistics Global Statistics and Node Node Node Node 

Statistics Statistics Statistics Statistics hierarchies ⇒ choose the following five statistics: 
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3. Click OKOKOKOK and then save your project. 

14.4.4. Configure the Simulation 

Here we will configure the simulation parameters: 

3. Click on  and the Configure Simulation window should appear. 

4. Set the duration to be 10.0 minutes10.0 minutes10.0 minutes10.0 minutes. 

5. Click OKOKOKOK    and then save your project. 

14.4.5. Duplicate the Scenario 

In the network we just created, we did not utilize many of the features explained in 
the overview section. By default the distributed coordination function (DCF) method 
is used for the medium access control (MAC) sublayer. We will create three more 
scenarios to utilize the features available from the IEEE 802.11 standard. In the 
DCF_FraDCF_FraDCF_FraDCF_Fragggg scenario we will allow fragmentation of the MAC data units into smaller 
frames and test its effect on the network performance. The DCF_PCFDCF_PCFDCF_PCFDCF_PCF scenario 
utilizes the point coordination function (PCF) method for the medium access control 
(MAC) sublayer along with the DCF method. Finally, in the DCF_PCFDCF_PCFDCF_PCFDCF_PCF_Frag_Frag_Frag_Frag 
scenario we will allow fragmentation of the MAC data and check its effect along with 
PCF. 

14.4.5.1. The DCF_Frag Scenario: 

1. Select Duplicate ScenarioDuplicate ScenarioDuplicate ScenarioDuplicate Scenario from the ScenariosScenariosScenariosScenarios menu and give it the name 

DCF_FragDCF_FragDCF_FragDCF_Frag ⇒ Click OKOKOKOK. 

2. Select all the nodes in the DCF_FragDCF_FragDCF_FragDCF_Frag scenario simultaneously (click on all of 

them while holding the ShiftShiftShiftShift key) ⇒ Right-click on anyone of them ⇒ Edit Edit Edit Edit 

AttributesAttributesAttributesAttributes ⇒ Check the Apply Changes to Selected ObjectsApply Changes to Selected ObjectsApply Changes to Selected ObjectsApply Changes to Selected Objects check box. 

3. Expand the hierarchy of the Wireless LAWireless LAWireless LAWireless LAN ParametersN ParametersN ParametersN Parameters attribute ⇒ Assign the 

value 256 to the Fragmentation Threshold (bytes)Fragmentation Threshold (bytes)Fragmentation Threshold (bytes)Fragmentation Threshold (bytes) attribute ⇒ Click OKOKOKOK. 

 

4. Right-click on node_0node_0node_0node_0 ⇒ Edit Edit Edit Edit AttributesAttributesAttributesAttributes ⇒ Expand the Wireless LAN Wireless LAN Wireless LAN Wireless LAN 

ParametersParametersParametersParameters hierarchy and set the Access Point FunctionalityAccess Point FunctionalityAccess Point FunctionalityAccess Point Functionality to EnabledEnabledEnabledEnabled. ⇒ 
Click OOOOKKKK. 

Fragmentation ThresholdFragmentation ThresholdFragmentation ThresholdFragmentation Threshold specifies the fragmentation threshold in bytes. Any data packet received from higher 
layer with a size greater than this threshold will be divided into fragments, which will be transmitted separately 
over the radio interface. Regardless of the value of this attribute, if the size of a higher layer packet is larger than 
the maximum MSDU size allowed the IEEE 802.12 WLAN standard, which is 2304 bytes, then such a packet will 
not be transmitted by the MAC, and it will be immediately discarded when received. 
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14.4.5.2. The DCF_PCF Scenario: 

1. Switch to the DCFDCFDCFDCF scenario, select Duplicate ScenarioDuplicate ScenarioDuplicate ScenarioDuplicate Scenario from the ScenariosScenariosScenariosScenarios menu 

and give it the name DCF_PCFDCF_PCFDCF_PCFDCF_PCF ⇒ Click OKOKOKOK ⇒ Save your project. 

2. Select node_0node_0node_0node_0, node_1node_1node_1node_1, node_3node_3node_3node_3, node_5node_5node_5node_5, and nodenodenodenode_7_7_7_7 in the DCF_PCFDCF_PCFDCF_PCFDCF_PCF 

scenario simultaneously (click on these nodes while holding the ShiftShiftShiftShift key) ⇒ 

Right-click on anyone of the selected nodes ⇒ Edit Edit Edit Edit AttributesAttributesAttributesAttributes. 

3. Check Apply Changes to Selected ObjectsApply Changes to Selected ObjectsApply Changes to Selected ObjectsApply Changes to Selected Objects ⇒ Expand the hierarchy of the 

Wireless LAN ParametersWireless LAN ParametersWireless LAN ParametersWireless LAN Parameters attribute ⇒ Expand the hierarchy of the PCF PCF PCF PCF 

ParametersParametersParametersParameters attribute ⇒ Enable the PCF FunctionalityPCF FunctionalityPCF FunctionalityPCF Functionality attribute ⇒ Click OKOKOKOK. 

 

4. Right-click on node_0node_0node_0node_0 ⇒ Edit Edit Edit Edit AttributesAttributesAttributesAttributes ⇒ Expand the Wireless LAN Wireless LAN Wireless LAN Wireless LAN 
ParametersParametersParametersParameters hierarchy and set the Access Point FunctionalityAccess Point FunctionalityAccess Point FunctionalityAccess Point Functionality to EnabledEnabledEnabledEnabled. 

5. Click OKOKOKOK    and save your project. 

To switch to a scenario, choose Switch to ScenarioSwitch to ScenarioSwitch to ScenarioSwitch to Scenario from the ScenariosScenariosScenariosScenarios menu or just press Ctrl+<scenario Ctrl+<scenario Ctrl+<scenario Ctrl+<scenario 
number>number>number>number>. 

14.4.5.3. The DCF_PCF_Frag Scenario: 

1. Switch to the DCF_FragDCF_FragDCF_FragDCF_Frag scenario, select Duplicate ScenarioDuplicate ScenarioDuplicate ScenarioDuplicate Scenario from the ScenariosScenariosScenariosScenarios 

menu and give it the name DCF_PCFDCF_PCFDCF_PCFDCF_PCF_Frag_Frag_Frag_Frag ⇒ Click OKOKOKOK ⇒ Save your project. 

2. Select node_0node_0node_0node_0, node_1node_1node_1node_1, node_3node_3node_3node_3, node_5node_5node_5node_5, and node_7node_7node_7node_7 in the DCF_PCFDCF_PCFDCF_PCFDCF_PCF_Frag_Frag_Frag_Frag 
scenario simultaneously (click on these nodes of them white holding the ShiftShiftShiftShift 

key) ⇒ Right-click on anyone of the selected nodes ⇒ Edit Edit Edit Edit AtAtAtAttributestributestributestributes. 

3. Check Apply Changes to Selected ObjectsApply Changes to Selected ObjectsApply Changes to Selected ObjectsApply Changes to Selected Objects ⇒ Expand the hierarchy of the 

Wireless LAN ParametersWireless LAN ParametersWireless LAN ParametersWireless LAN Parameters attribute ⇒ Expand the hierarchy of the PCF PCF PCF PCF 

ParametersParametersParametersParameters attribute ⇒ Enable the PCF FunctionalityPCF FunctionalityPCF FunctionalityPCF Functionality attribute ⇒ Click OKOKOKOK. 

4. Right-click on node_0node_0node_0node_0. ⇒ Edit Edit Edit Edit AttrAttrAttrAttributesibutesibutesibutes ⇒ Expand the Wireless LAN Wireless LAN Wireless LAN Wireless LAN 
ParametersParametersParametersParameters hierarchy and set the Access Point FunctionalityAccess Point FunctionalityAccess Point FunctionalityAccess Point Functionality to EnEnEnEnableableableabledddd. 
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5. Click OKOKOKOK and save your project. 

14.4.6. Run the Simulation 

To run the simulation for the four scenarios simultaneously: 

1. Go to the ScenariosScenariosScenariosScenarios menu ⇒ Select ManagManagManagManage Scenariose Scenariose Scenariose Scenarios 

2. Click on the row of each scenario and click the CoCoCoCollllllllect ect ect ect ResultsResultsResultsResults    button. This 
should change the values under the ResultsResultsResultsResults column to <collectcollectcollectcollect> as shown. 

 

3. Click OKOKOKOK to run the four simulations. Depending on the speed of your processor, 
this may take several seconds to complete. 

4. After the simulation of the four scenarios complete, click CloseCloseCloseClose and then save 
your project. 

14.4.7. View the Results 

To view and analyze the Results (Note:    Actual results will vary slightly based on the 
actual node positioning in the project): 

1. Select Compare ResultsCompare ResultsCompare ResultsCompare Results from the ResultResultResultResult menu. 

2. Change the drop-down menu in the lower-right part of the Compare Results 
dialog box from As IsAs IsAs IsAs Is to time_averagetime_averagetime_averagetime_average ⇒ Select the Delay (sec)Delay (sec)Delay (sec)Delay (sec) statistic from 
the Wireless LANWireless LANWireless LANWireless LAN hierarchy as shown. 
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time_time_time_time_averageaverageaverageaverage is the average value over time of the values generated during the collection window. This average is 
performed assuming a "sample and hold" behavior of the data set (i.e., each value is weighted by the amount of 
time separating it from the following update and the sum of all the weighted values is divided by the width of the 
collection window), 

3. Click ShowShowShowShow to show the result in a new panel. The resulting graph should 
resemble the shown one. 

 

DelayDelayDelayDelay represents the end-to-end delay of all the packets received by the wireless LAN MACs of all WLAN nodes in 
the network and forwarded to the higher layer. The delay includes medium access delay at the source MAC, 
reception of all the fragments individually, and transfer of the frames via AP, if access point functionality is 
enabled. 

4. Go to the Compare Results dialog box ⇒ Follow the same procedure to show 
the graphs of the following statistics from the Wireless LANWireless LANWireless LANWireless LAN hierarchy: Load Load Load Load 
(bits/sec)(bits/sec)(bits/sec)(bits/sec) and Throughput (bits/sec)Throughput (bits/sec)Throughput (bits/sec)Throughput (bits/sec). The resulting graphs should resemble the 
following ones. 
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LoadLoadLoadLoad represents the total load (in bits/sec) submitted to wireless LAN layers by all other WLAN nodes of the 
network. The statistic does not include the bits of the higher layer packets that are dropped by WLAN MACs upon 
arrival and not considered for transmission due to, for example, insufficient space left on the higher layer packet 
buffer of the MAC. 

 

ThroughputThroughputThroughputThroughput represents the total number of bits (in bits/sec) forwarded from wireless LAN layers to higher layers in 
all WLAN nodes of the network. 

5. Go to the Compare Results dialog box ⇒ Expand the Object StatisticsObject StatisticsObject StatisticsObject Statistics hierarchy 

⇒ Expand the OfficeOfficeOfficeOffice Network Network Network Network hierarchy ⇒ Expand the hierarchy of two nodes. 
One node should have PCF enabled in the DCF_PCFDCF_PCFDCF_PCFDCF_PCF scenario (e.g., node_3) 

and the other node should have PCF disabled (e.g., node_2) ⇒ Show the result 
of the Delay (sec)Delay (sec)Delay (sec)Delay (sec) statistic for the chosen nodes. The resulting graphs should 
resemble the following ones. 

 

6. Repeat step 5 above but for the Retransmission Attempts (packets)Retransmission Attempts (packets)Retransmission Attempts (packets)Retransmission Attempts (packets) statistic. 
The resulting graphs should resemble the following ones. 
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7. Close a graphs and the Compare Results dialog box ⇒ Save your project. 

14.5. Further readings 

• ANSI/IEEE Standard 802.11, 1999 Edition: Wireless LAN Medium Access Control 
(MAC) and Physical Layer (PHY) Specifications. 

14.6. Exercises 

1) Based on the definition of the statistic Load, Load, Load, Load, explain why with PCF enabled the 
load is lower than if DCF is used without PCF. 

2) Analyze the graphs that compare the Delay Delay Delay Delay and Throughput Throughput Throughput Throughput of the four 
scenarios. What are the effect of utilizing PCF and fragmentation on these two 
statistics? 

3) From the last four graphs, explain how the performance of a node without PCF 
is affected by having PCF enabled in other nodes in the network. 

4) Create two new scenarios as duplicates of the DCF_PCFDCF_PCFDCF_PCFDCF_PCF    scenario. Name the 
first new scenario DCF_allPCF DCF_allPCF DCF_allPCF DCF_allPCF and the second new scenario DCF_twoPCFDCF_twoPCFDCF_twoPCFDCF_twoPCF.    In 
DCF_allPCF, DCF_allPCF, DCF_allPCF, DCF_allPCF, enable the PCF attribute in all 8 nodes: node_1node_1node_1node_1 through node_8node_8node_8node_8 
(Note: do not include node_0node_0node_0node_0 in any of your attribute editing). In DCF_twoPCF, DCF_twoPCF, DCF_twoPCF, DCF_twoPCF, 
disable the PCF attribute in node_3node_3node_3node_3 and node_5node_5node_5node_5 (this will leave only node_1node_1node_1node_1 and 
node_7node_7node_7node_7 with PCF enabled). Generate the graphs for the Delay, Load, Delay, Load, Delay, Load, Delay, Load, and 
Throughput Throughput Throughput Throughput statistics and explain how the number of PCF nodes might affect 
the performance of the wireless network.    

5) For all scenarios, select the Media Access Delay Media Access Delay Media Access Delay Media Access Delay statistic from the Global 
Statistics � Wireless LANWireless LANWireless LANWireless LAN hierarchy. Re-run the simulation for all scenarios. 
Generate the graph that compares the Media Access Delay Media Access Delay Media Access Delay Media Access Delay statistic of all 
scenarios. Analyze the graph explaining the effect of PCF, fragmentation, and 
number of PCF nodes on media access delay.    

14.7. Lab Report 

Prepare a report that follows the guidelines explained in Lab 0. The report should 
include the answers to the above exercises as well as the graphs you generated 
from the simulation scenarios. Discuss the results you obtained and compare these 
results with your expectations. Mention any anomalies or unexplained behaviors. 
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15. Laboratory - Mobile Wireless Network (A Wireless Local Area Network 
with Mobile Stations) 

15.1. Objective 

This lab simulates mobility in wireless local area network. The effect of mobility on 
the TCP performance is studied. In addition, the lab studies how the request to send 
(RTS) and clear to send (CTS) frames are utilized in avoiding the hidden node 
problem usually induced by mobility in WLAN. 

15.2. Overview 

One of the requirements of the IEEE 802.11 standard is to handle mobile stations in 
wireless local area networks. Mobile stations are defined as the stations that access 
the LAN while in motion. IEEE 802.11 handles station mobility within the MAC 
sublayer and hence such mobility is hidden from the higher layers in the network. 
However the disconnection and reconnection events induced by mobility in WLAN 
significantly affect the performance of higher layer protocols such as TCP. For 
example TCP interprets disconnection due to mobility as congestion and hence it 
multiplicatively decreases its congestion window size. After reconnection, TCP 
takes unnecessary longer time to recover the congestion window to a size that 
matches the available bandwidth. 

IEEE 802.11 utilizes the request to send (RTS) and clear to send (CTS) frames in 
various circumstances to further minimize collisions. RTS and CTS are especially 
useful in solving the hidden node problem in WLANs that have mobile stations. 
Exchanging the RTS and CTS between the sender and the receiver informs nearby 
stations that a transmission is about to begin. Duration information in RTS/CTS 
frames are used to set the network allocation vector (NAV) in all stations that are 
within the reception range of the RTS/CTS frames. This way the problem of a hidden 
sender can be solved as any station that sees the CTS frame knows that it is close to 
the receiver, and therefore cannot transmit for the period of time indicated in the 
NAV. If transmitted data frames are short, sending RTS/CTS frames is not 
recommended as it adds overhead inefficiency. Therefore, a threshold is defined to 
use RTS/CTS only on frames longer than a specified length. 

In this lab we will simulate a wireless LAN with mobile workstations and server. The 
workstations will run an FTP application to upload files to the server. We will study 
the effect of node mobility on the performance of the TCP connection for the FTP 
session. We will study also the role of the request to send (RTS) and clear to send 
(CTS) frames in avoiding the hidden node problem usually induced by mobility in 
wireless LAN. 

15.3. Prelab Activities 

• Read sections 2.8.2 and 4.2.5 from "Computer Networks: "Computer Networks: "Computer Networks: "Computer Networks: A Systems Approach"A Systems Approach"A Systems Approach"A Systems Approach"    4th 
EditionEditionEditionEdition....    

• Wireless Network and Multiple Access with Collision Avoidance 

15.4. Procedure 

15.4.1. Create a New Project 

1. Start OPNET IT Guru Academic EditionOPNET IT Guru Academic EditionOPNET IT Guru Academic EditionOPNET IT Guru Academic Edition ⇒ Choose NewNewNewNew from the FileFileFileFile menu. 
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2. Select ProjectProjectProjectProject and Click OKOKOKOK    ⇒    Name the project <your initials><your initials><your initials><your initials>_MobileWLAN _MobileWLAN _MobileWLAN _MobileWLAN 

and the scenario Mobile_noRTSCTSMobile_noRTSCTSMobile_noRTSCTSMobile_noRTSCTS    ⇒    Click OKOKOKOK. 

3. In the Startup Wizard: Initial Topology    dialog box, make sure that Create Empty Create Empty Create Empty Create Empty 

ScenarioScenarioScenarioScenario    is selected ⇒ Click NextNextNextNext    ⇒ Select CampusCampusCampusCampus    from the Network Scale list 
⇒ Click NextNextNextNext    ⇒ Make sure that Kilometer is the unit chosen for the Size Size Size Size and 

then assign 2 and 1 to the X SpanX SpanX SpanX Span    and Y SpanY SpanY SpanY Span    respectively ⇒ Click NextNextNextNext    twice 

⇒ Click OKOKOKOK. 

15.4.2. Create and Configure the Network 

15.4.2.1. Initialize the Network: 

1. The Object Palette    dialog box should now be on the top of your project space. If 

it is not there, open it by clicking . Make sure that the wireless_lanwireless_lanwireless_lanwireless_lan is 
selected from the pull-down menu on the object palette. 

2. Add to the project workspace the following objects from the palette: Application Application Application Application 
ConfigConfigConfigConfig, Profile ConfigProfile ConfigProfile ConfigProfile Config, two wlan_wkstn (mob)wlan_wkstn (mob)wlan_wkstn (mob)wlan_wkstn (mob), and one wlan_servwlan_servwlan_servwlan_server (mob)er (mob)er (mob)er (mob). 

a. To add an object from a palette, click its icon in the object palette ⇒ Move 

your mouse to the workspace ⇒ Click to drop the object in the desired 

location ⇒ Right-click to finish creating objects of that type. 

3. Close the palette. 

4. Arrange and rename the objects you added as shown: 

 

5. Position the workstations and the server according to the x and y positions 
shown in the following table: 

a. To position an object: Right-click on the object ⇒ Advanced Advanced Advanced Advanced Edit Edit Edit Edit AttributesAttributesAttributesAttributes    

⇒ Edit the x position x position x position x position and y position y position y position y position attributes. 

NodeNodeNodeNode    x positionx positionx positionx position    y positiony positiony positiony position    

ClientA 1.25 0.5 
FTP_Server 1.5 0.5 
ClientB 1.75 0.5 

 

0% for the "Command Mix (Get/Total)" attribute means all the FTP sessions will be only "Serial" from the clients to 
the server. 
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15.4.2.2. Configure the Applications: 

1. Right-click on the ApplicationsApplicationsApplicationsApplications node ⇒ Edit Edit Edit Edit AttributesAttributesAttributesAttributes    ⇒    Expand the Application Application Application Application 

DefinitionsDefinitionsDefinitionsDefinitions    attribute and set rowsrowsrowsrows to 1111 ⇒ Expand the new row ⇒ Name the row 
FTP_ApplicationFTP_ApplicationFTP_ApplicationFTP_Application. 

i. Expand the DescriptionDescriptionDescriptionDescription hierarchy ⇒ Edit the FTP FTP FTP FTP row as shown (you will 
need to set the Special Value Special Value Special Value Special Value to Not Used Not Used Not Used Not Used while editing the shown 
attributes): 

 

2. Click OKOKOKOK twice and then save your project. 

15.4.2.3. Configure the Profiles: 

1. Right-click on the ProfilesProfilesProfilesProfiles node ⇒ Edit Edit Edit Edit AttributesAttributesAttributesAttributes    ⇒ Expand the Profile Profile Profile Profile 
ConfigurationConfigurationConfigurationConfiguration    attribute and set rowsrowsrowsrows to 1111. 

i. Name and set the attributes of row 0row 0row 0row 0    as shown ⇒ Click OKOKOKOK. 
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15.4.2.4. Configure the Applications in the Server and Clients: 

1. Right-click on the FTP_FTP_FTP_FTP_ServerServerServerServer node ⇒ Edit Edit Edit Edit AttributesAttributesAttributesAttributes:::: 

i. Edit the Server AddressServer AddressServer AddressServer Address attribute ⇒ Assign the value FTP_Server FTP_Server FTP_Server FTP_Server to it. 

ii. Edit Application: Application: Application: Application: SuppSuppSuppSupported Servicesorted Servicesorted Servicesorted Services    ⇒ Set rowsrowsrowsrows to 1111 ⇒ Set NameNameNameName to 

FTP_ApplicatFTP_ApplicatFTP_ApplicatFTP_Applicatiiiion on on on ⇒ Click OKOKOKOK    twice. 

 

2. Select both ClientAClientAClientAClientA and ClientBClientBClientBClientB in the network simultaneously (click on both of 

them while holding the ShiftShiftShiftShift key) ⇒ Right-click on one of them ⇒ Edit Edit Edit Edit AttributesAttributesAttributesAttributes 

⇒ Check the ApApApApply Changes to Selected Objectsply Changes to Selected Objectsply Changes to Selected Objectsply Changes to Selected Objects check box: 

i. Expand the Application: Supported ProfilesApplication: Supported ProfilesApplication: Supported ProfilesApplication: Supported Profiles hierarchy ⇒ Set rowsrowsrowsrows to 1111 ⇒ 

Set Profile NameProfile NameProfile NameProfile Name    to FTP_PFTP_PFTP_PFTP_Profile rofile rofile rofile as shown ⇒ Click OKOKOKOK. 

 

ii. Edit the Application: Destination PreferencesApplication: Destination PreferencesApplication: Destination PreferencesApplication: Destination Preferences    attribute as follows: 

Set rowsrowsrowsrows to 1111 ⇒    Set Symbolic NameSymbolic NameSymbolic NameSymbolic Name to FTP ServerFTP ServerFTP ServerFTP Server    ⇒    Edit Actual Name Actual Name Actual Name Actual Name ⇒    

Set rowsrowsrowsrows to 1111 ⇒ In the new row, assign FTP_Server FTP_Server FTP_Server FTP_Server to the Name Name Name Name column. 

3. Click OKOKOKOK three times and then save your project. 

15.4.2.5. Configure the Trajectory: 

1. Right-click on ClientAClientAClientAClientA    ⇒    Edit Edit Edit Edit AttributesAttributesAttributesAttributes    ⇒ Assign trajectory_trajectory_trajectory_trajectory_1 1 1 1 to the trajectorytrajectorytrajectorytrajectory 

attribute ⇒    Click OKOKOKOK. 

2. A green trajectory will appear on the project workspace. Right-click on that 
trajectory and select Edit Edit Edit Edit Trajectory Trajectory Trajectory Trajectory. 

3. In the Edit TrajectoryEdit TrajectoryEdit TrajectoryEdit Trajectory Information dialog box, name the trajectory <your <your <your <your 

initials>initials>initials>initials>_left_trajectory_left_trajectory_left_trajectory_left_trajectory ⇒ Click OKOKOKOK. 

4. From the EditEditEditEdit menu, choose PreferencesPreferencesPreferencesPreferences. Check the value of the mod_dirsmod_dirsmod_dirsmod_dirs 
attribute. A list of directories will appear. The first directory in the list is where a 
trajectory file with the name <your initials><your initials><your initials><your initials>_left_trajectory_left_trajectory_left_trajectory_left_trajectory.trj.trj.trj.trj is saved. Edit that 
file using any text editor (e.g., Notepad). Replace all the contents of the file with 
the info shown in the following figure then save and close the text editor. 
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5. Right-click on ClientAClientAClientAClientA ⇒ Edit Edit Edit Edit AttributesAttributesAttributesAttributes ⇒ Assign <your initials><your initials><your initials><your initials>_left_trajectory_left_trajectory_left_trajectory_left_trajectory 

to the trajectorytrajectorytrajectorytrajectory attribute ⇒ Click OKOKOKOK. 

6. The new trajectory should look exactly like the following one. Right-click on the 
trajectory and select Edit Edit Edit Edit Trajectory Trajectory Trajectory Trajectory. 

 

7. In the Edit Trajectory Information dialog box, verify that the trajectory info 
matches the values shown in the following figure: 

Note: that the trajectory makes ClientAClientAClientAClientA start moving after 2 minutes from the 
beginning of the simulation. ClientAClientAClientAClientA waits at X Pos 0.5 for 1 minute and at X Pos 
0.25 for 20 seconds. 

 

8. Click OKOKOKOK and then save your project. 

The trajectorytrajectorytrajectorytrajectory attribute specifies the name of an ASCII trajectory file that specifies the time and locations that a 
mobile node will pass through as the simulation progresses.  

15.4.3. Configure the Simulation 

Here we will configure the simulation parameters: 
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1. Click on  and the Configure Simulation window should appear. 

2. Assign 10.0 minutes10.0 minutes10.0 minutes10.0 minutes to the DurationDurationDurationDuration attribute. 

3. Assign 256256256256 to the SeedSeedSeedSeed attribute. 

4. Click OKOKOKOK and then save your project. 

 

The SeedSeedSeedSeed attribute is an integer that is used by the simulation's random number generator. Its default value is 128. 
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15.4.4. Choose the Statistics 

To test the performance of our mobile 
wireless network we will collect some of the 
available statistics as follows: 

1. Right-click anywhere in the project 
workspace and select Choose Individual Choose Individual Choose Individual Choose Individual 
Statistics Statistics Statistics Statistics from the pop-up menu. 

2. In the Choose Results dialog box, 
Expand the Node Statistics hierarchy ⇒ 
choose the shown three statistics. 

3. Right-click on the Congestion Window Congestion Window Congestion Window Congestion Window 

SizeSizeSizeSize (bytes) (bytes) (bytes) (bytes) statistic ⇒ Choose Change Change Change Change 

CoCoCoCollection Modellection Modellection Modellection Mode ⇒ In the dialog box 

check AdvancedAdvancedAdvancedAdvanced ⇒ From the drop-down 
menu, assign all valuesall valuesall valuesall values to Capture modeCapture modeCapture modeCapture mode 

as shown ⇒ Click OKOKOKOK. 

 
 

4. Right-click on the Traffic ReceivedTraffic ReceivedTraffic ReceivedTraffic Received (bytes) statistic. ⇒ Choose Change Change Change Change 

Collection ModeCollection ModeCollection ModeCollection Mode. ⇒ In the dialog box check AdvancAdvancAdvancAdvancedededed. ⇒ From the drop-down 
menu, assign all valuesall valuesall valuesall values to Capture modeCapture modeCapture modeCapture mode. 

5. Click OKOKOKOK twice and then save your project. 

15.4.5. Duplicate the Scenario 

We will create one more scenarios to utilize the request to send (RTS) and clear to 
send (CTS) frames to study their effect on minimizing collisions. 

1. Select Duplicate ScenarioDuplicate ScenarioDuplicate ScenarioDuplicate Scenario    from the ScenariosScenariosScenariosScenarios menu and give it the name 

Mobile_RTSCTS Mobile_RTSCTS Mobile_RTSCTS Mobile_RTSCTS ⇒ Click OKOKOKOK. 

2. Select ClientAClientAClientAClientA, FTP_serverFTP_serverFTP_serverFTP_server, and ClientBClientBClientBClientB simultaneously (click on all of them 

while holding the ShiftShiftShiftShift key). ⇒ Right-click on anyone of them. ⇒ Edit Edit Edit Edit AttributesAttributesAttributesAttributes 

⇒ Check the Apply Changes to Selected ObjectsApply Changes to Selected ObjectsApply Changes to Selected ObjectsApply Changes to Selected Objects check box. 

3. Expand the hierarchy of the Wireless LAN ParametersWireless LAN ParametersWireless LAN ParametersWireless LAN Parameters attribute. ⇒ Assign the 
value 256 to the Rts Threshold (bytes)Rts Threshold (bytes)Rts Threshold (bytes)Rts Threshold (bytes) attribute. 
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4. Click OKOKOKOK    and then save your project. 

15.4.6. Run the Simulation 

To run the simulation for both scenarios simultaneously: 

1. Go to the ScenariosScenariosScenariosScenarios menu. ⇒ Select Manage ScenariosManage ScenariosManage ScenariosManage Scenarios. 

2. Click on the row of each scenario and click the Collect Results Collect Results Collect Results Collect Results button. This 
should change the values under the ResultsResultsResultsResults column to <collecollecollecollectctctct>    as shown. 

 

3. Click OKOKOKOK to run both simulations. Depending on the speed of your processor, 
this may take several seconds to complete. 

4. After the simulation of both scenarios complete, click CloseCloseCloseClose    and then save your 
project. 

15.4.7. View the Results 

To view and analyze the results (Note::::    Actual results will vary slightly based on the 
actual node positioning in the project): 

1. Select Compare ResultsCompare ResultsCompare ResultsCompare Results    from the ResultResultResultResult menu. 

2. Select the Congestion Window SizeCongestion Window SizeCongestion Window SizeCongestion Window Size (bytes) (bytes) (bytes) (bytes)    statistic for ClientAClientAClientAClientA    from the TCP TCP TCP TCP 
ConnectionConnectionConnectionConnection    hierarchy as shown. 
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3. Click ShowShowShowShow    to show the result in a new panel. 

4. Repeat the above steps for the following statistics: 

a. Congestion WindowsCongestion WindowsCongestion WindowsCongestion Windows of ClientBClientBClientBClientB; 

b. Load Load Load Load for ClientAClientAClientAClientA    and 

c. Load Load Load Load for    ClientBClientBClientBClientB. 

The resulting graphs should resemble the following graphs. 

 



 

 network simulation experiments manual.doc utorak, 28. rujan 2010 181 

  

5. Go back to the Compare Results dialog box ⇒ Expand the TCP ConnectionTCP ConnectionTCP ConnectionTCP Connection 

hierarchy for the FTP serverFTP serverFTP serverFTP server ⇒ Select the Traffic ReceivedTraffic ReceivedTraffic ReceivedTraffic Received (bytes) - Conn Conn Conn Conn 1111    

statistic ⇒ Select sample_sumsample_sumsample_sumsample_sum to replace As IsAs IsAs IsAs Is as shown in the following figure 

⇒ Click ShowShowShowShow. 

6. Repeat the above step for the Traffic ReceivedTraffic ReceivedTraffic ReceivedTraffic Received (bytes) (bytes) (bytes) (bytes)----ConnConnConnConn 2 2 2 2 statistic. 

7. The resulting graphs should resemble the following graphs. 
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15.5. Further readings 

• ANSI/IEEE Standard 802.11, 1999 Edition: Wireless LAN Medium Access Control 
(MAC) and Physical Layer (PHY) Specifications. 

• Transmission Control Protocol: IETF RFC number 793 (www.ietf.org/rfc.html). 

15.6. Exercises 

1) Explain how LoadLoadLoadLoad and Congestion Window SizeCongestion Window SizeCongestion Window SizeCongestion Window Size are affected by the mobility of 
ClientAClientAClientAClientA. 

2) Explain how enabling RTS/CTS helps in avoiding the hidden node problem and 
hence explain the effect of RTS/CTS frames on the network performance. 

3) The graphs show that the server terminates the FTP session with ClientAClientAClientAClientA earlier 
if RTS/CTS is enabled. On the other hand, the server terminates the FTP 
session with ClientBClientBClientBClientB later if RTS/CTS is enabled. Explain why. 

4) Create a new scenario as a duplicate of the MobiMobiMobiMobilllle_noRTSCTSe_noRTSCTSe_noRTSCTSe_noRTSCTS scenario. Name 
the new scenario twoMobitwoMobitwoMobitwoMobilllles_noRTSCTSes_noRTSCTSes_noRTSCTSes_noRTSCTS. Create a second new scenario as a 
duplicate of the Mobile_RTSCTSMobile_RTSCTSMobile_RTSCTSMobile_RTSCTS scenario. Name the second new scenario 
twoMobiles_RTSCTStwoMobiles_RTSCTStwoMobiles_RTSCTStwoMobiles_RTSCTS. In both new scenarios, edit the attribute of the 
FTP_ServerFTP_ServerFTP_ServerFTP_Server and assign <your initials><your initials><your initials><your initials>_left_trajectory_left_trajectory_left_trajectory_left_trajectory to its trajectorytrajectorytrajectorytrajectory attribute. 
Run the simulation for all scenarios and create the graphs for the Load Load Load Load 
(bits/sec)(bits/sec)(bits/sec)(bits/sec), Congestion Window SizeCongestion Window SizeCongestion Window SizeCongestion Window Size (bytes) (bytes) (bytes) (bytes), and Traffic ReceivedTraffic ReceivedTraffic ReceivedTraffic Received (bytes) (bytes) (bytes) (bytes) 
statistic results as we did in this lab. Analyze the graphs explaining the effect of 
the server mobility on the network performance. 

15.7. Lab Report 

Prepare a report that follows the guidelines explained in Lab 0. The report should 
include the answers to the above exercises as well as the graphs you generated 
from the simulation scenarios. Discuss the results you obtained and compare these 
results with your expectations. Mention any anomalies or unexplained behaviors. 
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Networking technologies and concepts are often difficult to explain, even through careful 
description and well thought out examples. One method for making this information "stick" 
is to create an environment where networking professionals and students can visualize 
how networks work by utilizing a software tool that simulates the functions within a network. 
The tool itself is highly useful in that it provides a virtual environment for an assortment of 
desirable features such as modeling a network based on specified criteria and predicting its 
performance. 

The Network Simulat ion Experiments ManualNetwork Simulat ion Experiments ManualNetwork Simulat ion Experiments ManualNetwork Simulat ion Experiments Manual     takes takes takes takes this instructional tool a step 
further and provides detailed experiments on core networking topologies for use in this 
simulation environment. Various scenarios are presented within each topology: Review 
questions, a lab report, and exercises accompany each assignment as well. The manual 
also comes with directions for downloading the free and easy-to-install OPNET ITOPNET ITOPNET ITOPNET IT Guru  Guru  Guru  Guru 
Academic EditionAcademic EditionAcademic EditionAcademic Edition software. This software provides a virtual environment for modeling, 
analyzing, and predicting the performance of IT infrastructures, including applications, 
servers, and networking technologies. 

Prepared by Professor Emad Aboelela of the University of Massachusetts Dartmouth, the 
experiments in the manual are closely tied to the organization of CompCompCompCompututututerererer N N N Netwoetwoetwoetworkrkrkrk::::  A A A A  
SystemsSystemsSystemsSystems    Approach, 4Approach, 4Approach, 4Approach, 4eeee, , , ,  and when used together, serve as a complete tool for 
understanding how and why computer networks function as they do. 

KEY FEATURES 

• Written by an instructor who has used OPNET simulation tools in his classroom for 
numerous demonstrations and real-world scenarios. 

• Software download based on an award-winning product made by OPNET 
Technologies, Inc., whose software is used by thousands of commercial and 
government organizations worldwide, and by over 500 universities. 

• Useful experimentation for professionals in the workplace who are interested in 
learning and demonstrating the capability of evaluating different commercial 
networking products, i.e., Cisco routers. 

• Covers the core networking topologies and includes assignments on the ethernet, 
token rings, ATM, Switched LANs, Network Design, RIP, TCP, Queuing Disciplines, 
QoS, wireless, etc. 
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